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Introduction 
 

• Mouse and Keyboard Conventions (p13) 
• About This Guide (p14) 

About ScanWin LITE 
ScanWin LITE is a software application that allows Scanner users to perform all functions necessary for 
measurement applications including flowrun data downloads. Its effective “wizards” guide operators through the 
setup of hardware, flowruns, and primary devices, as well as the collection of hardware, system, and flowrun data. 
ScanWin LITE also facilitates the upload and download of configuration settings. 
 
ScanWin PRO, a companion product to ScanWin LITE, combines all of the functionality of ScanWin LITE with 
advanced features such as a flowrun catalog and relational database that stores historical information for offline 
review. Other features allow configuration of the Scanners advanced control and data capture functions. See your 
nearest NuFlo representative for more information. 

Versions 
The following graphic explains the sequence and significance of elements in the ScanWin LITE version 
number.   
 

 
 

After starting ScanWin LITE, you can determine its version 
number, as well as view registration information by accessing 
Help>About… from the Main Menu.  A screen like this will be 
displayed. 
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Press the License button to view NuFlo Measurement Systems 
software End User License Agreement for this product.  

 
 
 
 
 
 

 
 
 
 
 
 

Components Supported in ScanWin LITE 

Firmware Version ScanWin 
Version New Features 

4.0.0 (NGas) 2.0.x Initial release of Windows user interface software. 
4.1.0 (NFlo, IGas & 
NGas) 

2.2.0 Support for:  
• Peripheral devices (MVX and MVX-II/3095FB multivariable transmitters) 
• Peripheral devices (Daniel® Gas Chromatograph and Ultrasonic) 
• Ability to map Modbus (Standard and ENRON Modbus) 
• Monitor flowruns 
• NFlo and IGas firmware 

4.1.1 (NFlo, IGas & 
NGas) 

2.2.2 • Status output: Increased limit of width and delay 
• Flow rate Qb can now be assigned to an alarm 
• Network power save can now be configured for Modbus networks 

4.1.3 (NFlo, IGas & 
NGas) 

2.2.2 Modbus Enhancements: 
• Add individual data types for date and time 
• Ability to write to status outputs 
Peripheral Device Enhancements: 
• Uses the square root of differential pressure in history log averages 

4.1.4 (NFlo, IGas & 
NGas) 

2.2.3 • Enhance GC peripheral device: Stale data check and status alarm. 
• Add selection to log gravity and Hv to history log when calculated or 

entered 
• DPlast, SPlast & Tlast added to flowrun calculation page. 
• DP calibration, static pressure offset now in millivolts. 
• ScanMod Modbus network now handles more than 120 registers. 
• Add successful poll counter that is displayed in the event log for two 

types: Errors Cleared and Communication Reestablished. 
4.2.0 (NFlo, IGas & 
NGas) 

2.2.4 • Support for multiple protocols on a single serial port 
• Ability to output combiners to other accessories 
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Firmware Version ScanWin 
Version New Features 

4.3.0 (NFlo, IGas & 
NGas) 

2.2.5 • Add ScanPLC (programmable module) support. 
• Support for new V-Cone® Y (expansion factor) calculation, as well as 

support for V-Cone® wafer meter added. 
• Changed RAM memory allocation for Scanners 1140 and 1131. 
• Functionality added for ENRON Modbus station GC hourly history. 
• Reconfigured and enhanced Peripheral Devices handling.  MVX DP 

cutoff and out of range flags work properly. 
• New MVX calibration interface and modified RTD Shift calibration. 
• BSAP protocol added new lists, enhanced history log access for event, 

user change and gas components. 
• ScanWin has added interface to assign a status input to Reset Totals. 

4.3.1 (NFlo, IGas & 
NGas) 

2.2.6 • Status output configuration window changed to match changes in 
firmware. 

• Changes to the Scanner Configuration Reports to allow for easier 
duplication of a configuration. 

• Base temperature selection of 20°C added to all liquid flowruns.  (BFlo). 
• Support added for "P" version of IGas. 

4.3.4 (NFlo, IGas & 
NGas) 

3.0.0 • Add support for Scanner 1141. 
• Peripheral Device NuFlo MVX-II (a modified 3095FB). 
• NVRAM Lock parameter configuration modified on Scanners 1140/1141. 
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Firmware Version Unsupported Warning Screen 
Upon user logon, ScanWin LITE will determine 
whether the firmware version installed in the 
Scanner is supported. If the firmware version 
installed is not supported by ScanWin LITE, an 
“unsupported warning” screen will be displayed, 
by default.   
As a result, the functionality of ScanWin LITE 
will be limited to those features that are 
supported by the firmware to which it defaults. 
If this message becomes an annoyance, it can be turned off by editing the scanwin.ini file. The scanwin.ini 
file is located in the directory in which ScanWin LITE is installed.  Open the file and, under the [Firmware 
Settings] heading, change the value of DefaultDebugDialog from 1 to 0. 
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Mouse and Keyboard Conventions 
Although you must use the keyboard to enter text, you can use either the mouse or the keyboard for all other 
operations. 

Using the Mouse 
Except for entering text, you can do all your work with the mouse: 
To… Do this… 
Move the mouse pointer. Slide the mouse on a smooth surface. 
Point to an object on the screen. Move the mouse to position the mouse pointer on top of the object you want to 

select. 
Click an object on the screen. Point to an object and click (press and release the left mouse button once). 
Double-click an object. Point to an object and, in rapid succession, click the left mouse button twice. 
Select an object from a pull-down 
menu. 

Click on the arrow beside a text box and then on the object you want to select 
from the list. 

The mouse pointer changes shape as you work.  The most common forms are: 
• An arrow for pointing to objects. 
• A flashing cursor. 
• An I-beam for editing text. 
• A magnifying glass in the Flowrun History Graph. 
• An hourglass when you need to wait. 

Using the Keyboard 
You can also use the keyboard to perform any task: 
To… Do this… 
Open any main menu. Press Alt and then the underlined letter that appears in the menu.  
Move from field to field. Press Tab. 
Move backward from field to field. Press Shift and then Tab. 
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About This Guide 
The ScanWin LITE User Guide provides you with the information and procedures you need to use ScanWin 
LITE.  Although we describe a common path through the ScanWin LITE system, we do not attempt to educate 
you about pipeline monitoring concepts.   

Audience 
This user guide is intended for field technicians and off-site technical staff who are familiar with gathering 
and monitoring data. Users should have a basic to intermediate knowledge of Microsoft Windows® 
applications.   

Document Conventions 
The following table describes the conventions used in this guide: 

 
This… Indicates… 
OFF  The default setting of a parameter.  For example,  

ON (green check mark) indicates that the setting of this parameter is ON by 
default;   OFF (red X) indicates that the setting of this parameter is OFF by 
default. 

OK or Next All button names appear in italics. 
 
 

Additional information about the subject or special notes that call attention to a 
particularly important subject; these notes appear in the margin. 

For information on flowrun 
configuration rules in NGas 4.x.x, 
see Chapter 10 (Flowrun 
Configuration Rules, p156). 

Where you can get more information about a topic. 
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Chapter Overviews 

Chapter Description 
Introduction Provides an overview of ScanWin LITE and this documentation. 
Chapter 1: Installing ScanWin 
LITE  

Information about system requirements and how to install ScanWin LITE. 

Chapter 2: ScanWin LITE Basics Contains instructions about starting ScanWin LITE, configuring connections, 
unit categories and exiting from ScanWin LITE. 

Chapters 3 through 7 correspond with the tabs shown when the Scanner is connected in a DIRECT mode. 
Chapter 3: Performing ROUTINE 
Processes 

Contains details about performing routine processes including changing 
plates and flowrun gas composition, downloading history and events, 
calibrating devices, setting up flow snapshots and collecting data to a Data 
Logger or to a file. 

Chapter 4: FLOWRUN Data Contains information about opening, defining and viewing of flowrun 
history and live data. 

Chapter 5: SYSTEM Contains details of how to view and change some system settings. 
Chapter 6: HARDWARE Contains information about hardware Inputs, Outputs, Serial Ports and 

Multifunctional Resources. 
Chapter 7: ALARMS Tells how to reset alarms. 
Chapter 8: Communications Setup Tells how to set up communications for connecting to a local or remote 

Scanner including devices, ports, families and Scanners as well as creating port 
groups. 

Chapter 9: Scanner Theory Information about how the Scanner operates. 
Chapter 10: NGAS 4.X.X 
Configuration & Calculations 

Details about how flowruns are configured and how calculations are performed 
when using NGas 4.X.X. 

Chapter 11: IGAS 4.X.X 
Configuration & Calculations 

Details about how flowruns are configured and how calculations are performed 
when using IGas 4.X.X 

Chapter 12: NFLO 4.X.X 
Configuration & Calculations 

Details about how flowruns are configured and how calculations are performed 
when using NFlo 4.X.X.   

Chapter 13: MONITOR Flowrun 
Configuration 

Details about configuring a Monitor Flowrun 
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Chapter 1: Installing ScanWin LITE 
 

• Default Units (p27) 

System Requirements 
Barton Scanner RTUs rely on the ScanWin LITE or Pro software to configure, monitor, collect data, and create 
reports for natural gas production.  To run ScanWin LITE, ensure that your PC meets the minimum system 
requirements: 
 
 
 Minimum Recommended… 
Operating System Windows 2000 
CPU 1-GHz or faster Pentium-compatible 
Memory 128 MB of RAM (256 MB recommended) 
Hard Disk Space 160 MB for installation files plus adequate space for data files 
Drive CD-ROM for install 
Display 1024 x 768 (XVGA), 16-bit color display or greater 
Browser Internet Explorer 4 or later 
Communication Port Serial port 

ScanWin LITE Installation 
1. Insert the ScanWin LITE CD or the installation floppy disk into the 

appropriate drive of your computer. 
2. Select Start > Settings > Control Panel to display the Control Panel.  

Double-click the Add/Remove Programs icon. 
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3. The Add/Remove Programs Properties dialog box is 
displayed.  Click Install. 
 
 
 
 
 
 
 
 
 
 
 
 

4. The Install Program From Floppy Disk or CD-ROM dialog 
box is shown. 
Insert the floppy disk or the CD-ROM into the correct 
opening.  Click the Next button. 
 
 
 
 
 
 
 

5. If Windows is unable to detect your disk, the Run Installation 
Program dialog box appears. 
If you know the location and name of the installation program, 
(e.g. a:\setup.exe), enter it in the space provided.   
Otherwise, click on the Browse button to display the window 
below. 
 
 
 
 
 
Select the drive where your floppy or CD-ROM disk is located.  
Double-click on the folder where the setup file is located. 
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When the folder opens, double-click on the installation program  
icon (OR single-click on the installation program icon and click 
again on the Open button). The ScanWin LITE installation 
program will have “setup” as part of the name and an .exe 
extension. An example would be 
ScanWin_B300W_Full_Setup_R0.exe. 
 
 
 
 
 
 
 

The Run Installation Program window is displayed. 
Click Finish. 
 
 
 
 
 
 
 
 

6. The first window of the ScanWin LITE Installation wizard 
appears.  Click Next.  
 
 
 
 
 
 
 

 
7. A License Agreement window appears.  Use the slider bar on 

the right to scroll through the text.  Click the Yes box to 
continue. 
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Tip: Other Barton products, such as ScanBase, will also install 
program files in subdirectories of the 
Barton\BDMS\Program directory.  Data files will be placed 
in subdirectories of the Barton\BDMS\Data directory. 

8. ScanWin LITE provides you with three installation options: 
• Full Install results in a new installation of ScanWin LITE 

and its components to default locations on the C:\ drive. 
• Custom Install allows you to upgrade from a previous 

version or to modify an existing installation. 
• Minimum Install allows you to update just the program 

files if you already have a previous version of ScanWin 
LITE installed. 

Choosing Full Install places the ScanWin LITE program files 
on Drive C:\ in the Barton\BDMS\Program\SWLITE 
directory. These installations also skip a number of installation 
steps while taking you to the dialogs showing  
 
• Units Preference (Step 11),  
• Database Components (Step 12),  
• Summary (Step 19), and  
• Ready to Install (Step 20) etc.   
 
Choosing Custom Install gives you more control of the installation process and allows you to make 
decisions about where to install the program and what components to install.  If you have chosen to do a 
custom installation, continue with Step 9. 

9. If the database engine has NOT been installed, this window will 
be displayed. 
Note that the database is not used for long-term historical data 
storage in ScanWin LITE but is required for the communication 
settings. 
 
 
 
 
 
 
 

 
If the database engine has ALREADY been installed, the 
Select Components window is shown. 
Click Next to continue.  Go to Step 12 if Database Install 
alone was chosen.  
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10. If you selected ScanWin, the ScanWin LITE Application 
window appears. 
Click Next to accept the default drive and go to Step 11.  
 
 
 
 
 
 
 

Otherwise, to change the destination directory, either enter the 
name of the new directory or click the Browse button to display 
the Program Files Destination dialog box. 
Enter the destination drive and folder for ScanWin LITE and 
click OK.  This will take you back to the previous window.  Click 
Next. 
 
 
 
 
 
 
 
If the program already exists in the directory, this warning will 
be displayed. 
 
 
 
 
 
 
 
 
 
 

11. If this is a first-time installation, you can choose the default 
units (Imperial or Metric) in which you will be working.  If you 
are installing over a previous version, you may select the Skip 
setting of units preference box to retain your previous settings.   
Make your choice and click Next. 
See Table 1 – Default Units (page 27) for details about the 
default units. 
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12. If you selected Database Install, the Database Components 
window appears. 
Select the database components you want to install and click 
Next.  
Go to Step 14 if only Install a Database was selected, 
otherwise continue. 
 
 
 

 
13. If you selected Install Borland Database Engine, the Database 

Engine Destination window is displayed.   
Click Next.  
 
 
 
 
 
 

 
You will be warned if there is already an installed Borland 
Database engine with the following display: 
Select either No or Yes and then click the Next button. Note that 
selecting No will take you back to the previous wizard. 
 
 
 
 
 

 
WARNING! 

 
If you already have have the Borland Database Engine (BDE), 
the following window appears warning you that your existing 
installation will be overwritten.   
Select Yes or No and then click the Next button.   
Note that choosing No will take you back to the previous 
wizard. 
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14. The Database Tables window appears. 
Select the type of database you want to install, either Starting 
Database or Sample Database.  The sample database contains 
18 sample Scanners and data that help you learn the functions in 
ScanWin.  Select Sample Database if you do not have any real 
data.  Select Starting Database if you have Scanners collecting 
data.  Click Next. 
 
 
 
 

15. The Database Destination window appears. 
Enter the destination drive and folder for the Database Engine. 
Or,  
Click the Browse button to display the Program Files 
Destination dialog box.  
Or, 
Click Next to accept the default location  
 
 

16. The following window is displayed if you have existing 
database files at the chosen location: 
You are prompted to choose No if you do not wish to overwrite 
the existing data. 
 
 
 
 
 
 
 

17. The Initialization Prompting window appears.  If you don't 
want to see the next dialogs boxes that contain prompts for 
answering Yes or No questions for creating or updating tables, 
click the Automatic “Yes” to all prompts  check box. 
Click Next.   
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18. The Initialization Warning window appears warning you to 
close all applications using BDMS database tables. 
After taking the appropriate action, click Next to continue. 
 
 
 
 
 
 

 
19. The Summary window is displayed.  Click Next.  

 
 
 
 
 
 
 
 

 
20. A dialog box appears indicating that ScanWin LITE is ready to 

be installed.   
Click Next to install the files.  
 
 
 
 
 
 

 
21. The progress of the installation is indicated by the following dialog box: 
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22. If you left the Automatic “Yes” to all prompts check box blank, a series of dialog 
boxes appear: 
Click Yes to update or create the database.  
 
 
A dialog box appears indicating that the initialization was successful: 
Click OK to continue.  
 
 
 
Another Table Initialization dialog box appears: 
Click Yes to update or create the database.  
 
 
 
A dialog box appears indicating that the initialization was successful: 
Click OK to continue.  
 
 
 

23. The Installation Completed! window appears, informing you 
of a successful installation.  You are also given instructions on 
how to install an electronic version of this manual. 
Click Finish. A document will then be opened listing new 
features to be found in ScanWin LITE. 
  
 
 
 
 

 

NOTE for Windows NT, 2000  and XP users:   
Step 1 of the Installation Completed! dialog, is critical if your operating system is Windows NT, 
2000 or XP.   
 
To perform this step, right-click on the ScanWin icon that was created on the desktop and choose 
Properties.  Select the Shortcut tab.  When located, click the box next to the “Run in separate memory 
space” message so that it is check marked.
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The Windows NT and 2000 dialog looks like this: 
 
 
 
 
 
 
 
 
 
 
 
 
 

If you are using Windows XP, you will first have to click on the 
Advanced… button. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The Advanced Properties dialog look like this: 
When you are finished, click the OK button. 
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Table 1 - Default Units 
The following table lists the default units that will be used when Imperial or Metric Units are selected during 
installation install (Step 11). These units can be changed after the installation by using the Unit Category 
Configuration interface. 
.  

 
Default Imperial Units Default Metric Units  

Category Abbreviation Abbreviation 
Temperature F C 
Volume MCF E3M3 
Uncorrected Volume MCF E3M3 
Distance In mm 
Static Pressure (absolute) Psia kPaa 
Static Pressure (gauge) Psig kPag 
Differential Pressure IWC kPa 
Energy MMBTU GJ 
Mass Lbm kg 
Density (absolute) Lbm / CF kg / M3 
Relative Density (Specific Gravity) RDg RDg 
Absolute Viscosity Lbm / FtSec cP 
%Nitrogen Percent Percent 
%Carbon Dioxide Percent Percent 
%Methane Percent Percent 
Volume rate MCF / d E3M3 / d 
Uncorrected Volume rate MCF / d E3M3 / d 
Mass rate Lbm / d kg / d 
Energy rate MMBTU / d GJ / d 
Mass heating value BTU / Lbm MJ / kg 
Volume heating value BTU / CF MJ / M3 
% per Static Pressure %/Psig %/MPag 
Frequency Hz Hz 
Percent — — 
Volume K-factor Pulses/CF Pulses/M3 
Mass K-factor Pulses/Lbm Pulses/kg 
Molar Heating Value BTU/mol MJ/mol 
Monitor — — 
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Chapter 2: ScanWin LITE Basics 
 

• Connection Configuration (p31) 
• Starting ScanWin LITE (p32) 
• Options Menu (p37) 
• Leaving ScanWin LITE (p40) 

Overview of the Startup Procedure 
The following chart presents a suggested sequence for the startup of the Flow Computer: 
Task Step Description Reference Section 

1 Set desired units, if different from install 
default 

Chapter 1: Installing ScanWin 
LITE 
Chapter 2 (Unit Category 
Configuration, p37) 

SCANWIN 
CONFIGURATION 

2 Check communication settings Chapter 2 (Connection 
Configuration, p31) 

SUPERBOOT 
3 If the Scanner has been FLASHED, superboot 

it if required by firmware upgrade.  
(Superbooting is generally recommended.) 

Chapter 2 (Starting After a 
Superboot, p33) 

LOGIN 

4 Set Clock 
Note: If Scanner was superbooted, the clock is 
set as part of the superboot procedure (see 
Chapter 2 – Getting Started (Starting ScanWin 
LITE) 

Chapter 5 (Clock, p112) 

5 Restore configuration  
(or manually configure the Scanner as 
described below) 

Chapter 6 (Restore Scanner 
Configuration, p83) 

6 Set Node Name Chapter 7 (Node Information, p105) 
7 Configure System Settings (Gas Day Hour, 

Power Save, etc.) 
Ensure that the desired firmware version is 
installed.  If not, FLASH the Measurement 
RTU with the correct firmware version.  
Superboot if required by firmware upgrade.  
(Superbooting is generally recommended.) 

Chapter 6 (Scanner Setup, p79)  
Chapter 7 (Node Information, p105) 

SYSTEM SETUP 

8 Configure Hardware 
• enter zero, full-scale, default, 

calibration/verification options 

Chapter 6: HARDWARE 
Chapter 3 (Calibrate/Verify 
Devices, p58) 
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Task Step Description Reference Section 
10 Build Flowrun “framework” (e.g. 

Add/Remove or Modify a Flowrun) 
11 Enter Flowrun Name 
12 Change Flowrun status to “setup” and ensure 

other flowrun settings are correct (e.g., 
Timing, Limits, Estimation)  

13 Configure all user entered flowrun parameters 
(e.g., orifice size, gas quality information, 
etc.) 

14 Link all live input parameters to desired 
hardware resources 

FLOWRUN SETUP 

16 Output flowrun parameters to desired 
Accessories 

Chapter 6 (Flowrun Setup, p45) 

CHECK SETUP 
17 Ensure that the flowrun is “running” and that 

the rates are being calculated and the totals are 
accumulating. 

Chapter 11 (Rates and Totals, p86) 

SAVE 
CONFIGURATION 

18 This allows you to apply your present 
configuration to other Scanners or to 
reconfigure your Scanner if it is superbooted. 

Chapter 6 (Save Scanner 
Configuration, p81) 

 

Startup Problems Checklist 
1. If a Connection Failed message is displayed, check the following: 

• Is the Scanner turned on? 
• Is the battery producing enough voltage to power the Scanner? 
• Are the communication settings correct?  Is the baud rate correct? 
• Are your cable connections secured? 
 

2. If using Windows NT, 2000 or XP, ensure that you are running ScanWin LITE in a separate memory 
space.  To do this, carry out the following steps (see Step 23 of the ScanWin LITE installation 
procedure): 
• Right-click on the ScanWin LITE icon. 
• Select Properties. 
• Select the Shortcut tab and then click the “Advanced…” button. 
• On the Advanced Properties page, check the box that says “Run in separate memory space”. 
• Click OK. Then click OK on the ScanWin LITE Properties page. 
 

3. If ScanWin LITE will not close or does not restart when running in Windows NT, 2000 or XP, perform 
the following steps: 
• Access the task list using the Ctrl-Alt-Del keys. 
• Select the NTVDM.exe process 
• Click the End Process button. 

NOTE  Other applications may use a NTVDM.exe so use caution when performing this step. 
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Connection Configuration 
To properly communicate with the Scanner in a direct, 
remote or offline mode, ScanWin LITE’s communication 
settings may have to be configured. The settings are 
accessible through the Main Menu under Tools > 
Communications Setup or through the Setup button of the 
Scanner Connection window. Either action displays the 
following window: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

It is important that the following settings are addressed: 
 Port Group Name   Device Setup Name 
 Port    Work Station ID  
 Baud Rate (9600 for NGas 4.0.X after Superboot) 
Note that Direct connection method requires that “_DIRECT_” is present in both the Family Name and the Scanner 
Name in the Scanner List. To edit the Family Name or Scanner Name, follow the instructions in Chapter 8: 
Communications Setup. 
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Starting ScanWin LITE 

1. Locate the ScanWin LITE icon  on your 
desktop. Double-clicking it displays the Opening 
Menu window (background) and the Scanner 
Connection window (foreground). 
 
 
 
 
 
 
 
 
 
 

2. Details of the Scanner Connection window include the 
following: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
See Chapter 7 (Login Management, page 113) for more information. 

3. Select your user ID from the User Name drop-down list. 
4. Select your security level ID from the Level Name drop-down list. 
5. Enter your user password in the Password field. 
6. In Connection Method, select the method you want to use to work with the data.  Select Direct to connect 

directly to the Scanner; select Remote to use a communication device to communicate remotely.   
Click the Setup button to access the Communication Setup dialog.  Refer to the Defining a Family 
section (page 138).  Note that the Family _DIRECT_ is used for Direct Connection Method.   

 
 

Note:  
The default security Level Name is MANAGER, USER1, USER2, USER3 and GUEST. 
Initially, USER1 and GUEST have READ ONLY access, while the MANAGER, USER2 and USER3 have 
READ/WRITE access. 
Also, the default password is the same as the Level Name.   

Communication link is active when the arrows  are moving.   

You need to enter your User Name and Scanner Security Level 
that you want to login at, and the Password for that level the first 
time you use ScanWin. They will be stored so the next time you 
access ScanWin, you can select them from the drop-down list. 

See Step 7 about the “Specify” box. 

Status of the communication link appears here. 
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7. Click the Connect button to connect directly to the Scanner. (See note on next page about connecting 

after a superboot of the Scanner.) 
Alternatively, when the Scanner Connection window is closed, but the program is running (with the 
Opening Menu window showing, press the Open Scanner button    on the toolbar  
OR press the F2 key   
OR select Open in the File menu to display the Scanner Connection window.  
 

Starting After a Superboot 
If the Scanner has been superbooted, this window will first be displayed 
before the normal Routine tab (see Chapter 3, page 41). 
You have the option of synchronizing the Scanner with your PC’s clock 
by clicking on the OK button while Computer Clock is selected.  
Alternatively, you may choose Entered Value, enter a different time 
and/or date and then click the OK button.  Refer to Chapter 7 (Clock, 
page 112) for additional details. 
 
 

  NOTE: You MUST select the Specify box if your firmware is NGas 3.1 or lower and the Connection 
Method is Direct.  The Network Device default is 1100, and the DLC Drop default is 1. These settings 
must match the settings in the Scanner. 
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Moving Through ScanWin LITE 
You can move through ScanWin LITE using the Main Menu bar. 
The Main Menu can be accessed by clicking on the word (e.g. File) and then moving the mouse to the 
desired command and clicking on it (e.g. Close). 
The commands can also be generated by using keyboard commands.  The Alt key in combination with the 
underlined letters (F for File, R for Routine, T for Tools, etc.) opens the menu for that set.  Then, press the 
underlined letter for the command you wish. 
As an example, clicking the Alt, R and D keys will initiate the Calibrate Devices wizards (refer to page 58). 
Note:  The Routine menu is not visible when you are in an offline mode. 
 
 
 
 

 

Online Manual 

About… 

Cascade  Shift+F5 
Tile  Shift+F4 
Arrange Icons 

ToolBar 
StatusBar  

(list of open windows) 

Open   F2 
Close 
 

Exit 

Change Plate 
Change Gas Composition 
Calibrate / Verify Devices 
Download from Scanner 
Scanner Setup 
Flowrun Setup 

Communications Setup 
Reports 
SCM Viewer 

 
Unit Category Settings 
Quick Start Settings 
 

Show Communications Window 
Save Communications Window 
Log Communications Window 
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Symbols Used by ScanWin LITE 
The following symbols are used in ScanWin LITE to select or deselect operations. 
 This symbol… Indicates… 

 The operation or item has been selected. 

 The operation or item has NOT been selected. 

 The user will have READ ONLY access. 

Field Conventions  
ScanWin LITE allows a variety of changes to be made in many of the fields in its windows.  Symbols are 
used in some fields to indicate where changes may be made. 
 
A field like this... Indicates that... 

 (yellow arrow 
pointing down) 

The value is out of range.  In this case, it is below the zero (low) value. 

 (yellow arrow 
pointing up) 

The value is out of range.  In this case, it is above the full-scale (High) value. 

 (two yellow arrows 
pointing down) 

The Differential Pressure value is in cutoff. 

 (yellow circle) A default value is being displayed. 

 (yellow question 
mark) 

The live value is assigned to a peripheral device which is not communicating or 
the live value is not known or available. 
Note:  For Firmware versions 4.3.1 and earlier, message is displayed for live 
values assigned to a peripheral device that is not communicating. 

 (green triangle in 
upper left hand corner) 

Clicking on box allows you to change the value or presents you with a drop-down 
window with options from which to choose.   
Note:  Clicking on any Units field (the triangle is not shown in these fields) 
presents you with a drop-down window containing the available units of 
measurement for that value. 

 (blue-green triangle in 
lower right hand corner) 

Double-clicking on box presents you with a window dialog through which you are 
allowed to make changes. 

 (triangles in both the 
upper left and lower right hand 
corners) 

Double-clicking on this field will present you with a window dialog through 
which you can assign and/or edit other types.   
Note:  See below for explanation about the Hardware page. 

 (“+” sign after 
resource name - found only on 
the Hardware page) 

Double-clicking on the type field gives you a window dialog through which you 
can make changes for that type. 
A single click and a pause for about 1 second produce a down arrow on the right 
side of the type field.  Clicking on this arrow presents you with a drop-down 
window with the type options available for that resource. 

 (green triangle in lower 
right hand corner pointing 
downwards - found on Network 
Settings tab under Systems) 

Clicking on this field containing the downward pointing triangle displays the 
settings that are available.  The field then changes to  (arrow now points to 
the right) and additional items become available.   

 (green triangle in lower 
right hand corner pointing to the 
right - see previous line) 

Clicking on this field causes the expanded settings to revert to the original single 
line. 
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Colors Used in ScanWin LITE 
ScanWin LITE makes use of colors to add meanings to values.  The following table tells about these colors: 
 

This color… Indicates values that are… 
Green Dummy placeholders generated by ScanWin LITE before any connection is made to a Scanner or 

database.  Green text appears when an offline connection could not find the value in the database 
or momentarily with a direct or remote connection.  

Blue From the database.  Blue text appears with an offline connection.  
Teal Currently being retrieved from the Scanner.  Teal text appears briefly with a direct or remote 

connection. 
Black Retrieved from the Scanner.  Black text appears with a direct or remote connection. 
Purple  Not retrieved from the Scanner.  Purple text appears with a direct or remote connection when you 

try to get a value but it could not be retrieved from the Scanner. 
Red Red is also used to alert you to invalid conditions that exist while the program is running.  For 

example, active alarms and exceptions are shown respectively in the Alarms and the Diagnostics 
pages in red text.  Hardware  inputs or outputs with Invalid Live values will also be displayed in 
Red (this is usually caused by the upper and/or lower ranges not being defined) 
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Options Menu Items 

Unit Category Configuration 
During installation, ScanWin LITE allows the selection of metric or imperial units.  Refer to Table 1 - 
Default Units (page 27) for details about these units. 
After logging in, the measurement units for a flowrun may be changed by the user.   
In addition, default units can also be configured.  The new default units will appear only after ScanWin LITE 
is closed and restarted. 

Setting the Units 
1. On the Main Menu, select Options > Unit Category 

Settings.  This window is displayed. 
2. Click on the field displaying a unit to display the 

dropdown menu. Click on the unit of your choice. 
3. When all your changes have been made, click OK to end.  

(Choose Default if you wish to apply these choices to all 
of your flowruns.) 
 
 
 
 
 
 
 

 
Note: These unit selects do NOT apply to the History Graph view nor the Table view found in the Flowrun > 

History tabs.  To set History units, use Options > History Data Settings found in the Main Menu. 
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Quick Start Settings 
ScanWin LITE provides a Quick Start Settings configuration 
dialog (accessed through Options > Quick Start Settings). The 
scanwin.ini file can be edited using this dialog.   
 
 
 
 

 
 
 
 
 

Using the Communications Window Option 
ScanWin LITE has a built-in 
communications window that is useful in 
tracing problems.  This window is turned 
on and off from the Main Menu by 
selecting Options > Show 
Communications Window.  When turned 
on, it looks like. 
 
 
There are two methods of saving the information that this tool can produce.   
1. Choosing Options > Save Communications Window from the Main Menu saves all the information in 

memory from the time the Scanner was started (or from the last time this command was issued) until the 
time the request was made.  The information is saved, by default, to a file named 
swlcomwindow_yyyymmddhhmmss.txt (where yyyy is the year, mm is the month, dd is the day, hh is 
the hour, mm is the minute and ss is the second when the file is saved).  This file is found in the 
c:\Barton\BDMS\Data\Reports\Comlogs\Scanwin directory. Each time this command is given, a new file 
is created. 

2. Choosing Options > Log Communications Window from the Main Menu causes data to be written to a 
text file named swlcom.log.  This file is also found in the 
c:\Barton\BDMS\Data\Reports\Comlogs\Scanwin directory. The recording of data to this file can be 
started and stopped over a particular testing period.  While the check mark is visible as shown below, data 
is being appended to the file. 
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(Data is being written to swlcom.log) 
 
 
 
 
  

 
 

(No data is being written to swlcom.log) 
 
 
 
 
 
Each time logging is initiated, the new data will be appended to this file.  If you need separate files, 
swlcom.log should be renamed before starting a new log session. 
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Leaving ScanWin LITE 
You can leave ScanWin LITE at any time. 

To leave ScanWin LITE 
• From the Main Menu, choose File > Close to close the current connection(s).  Then select File > Exit to 

leave ScanWin LITE. 
Or 

• Close the connection(s) using the Exit button (lower one), and then use the main window’s Exit button 
(topmost one) to close the program. 

 
 
 

Tip:   It is recommended that all connections be closed before exiting the main program window. 
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Chapter 3: Performing ROUTINE Processes 
 

• Data Collection (p42) 
• Flowrun Setup (p45) 
• Changing Plate (p52) 
• Changing Gas Composition (p54) 
• Calibrating/Verify Devices (p58) 
• Scanner Setup Options (p79) 
 

When you connect to a Scanner using ScanWin 
LITE and select the Routine tab, you will be  
presented with a page of routine options as shown 
here. 
Click on the button of the routine you wish to 
access. 
 
 
 
 
 
 
 
 
 
Note that these functions may also be 
accessed from either the Main Menu (by 
clicking on Routine to display the submenu, and then clicking on the desired function) or through the toolbar by 
clicking on the icon of the intended routine. 
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Data Collection 
ScanWin LITE version B3.0.0W allows you to download hourly history, daily history, events and user changes 
for the flowruns you have selected. This information can then be viewed with the SCM Viewer, a Windows-based 
application included on the ScanWin installation CD. For instructions on using this utility, see the SCM Viewer 
user manual. 
 
• The Hourly and Daily History log contains flow data that is used to audit measurements in hourly and daily 

increments repectively, reproduce volume/mass/energy flow information and recalculate flow data, if 
necessary. 

 

 
 
• The Events log provides a record of process alarms, system alarms and other external alarms.  
• The User Changes log records changes to the Scanner configuration. A “user change” is defined as any 

action performed by the user, which, directly or indirectly, causes the flow computer to calculate or operate 
differently from the way it was operating prior to the change; i.e., anything that affects any of the numbers in 
the flowrun(s). When the User Change Log is getting full (status can be checked via the Diagnostics > 
Memory Status tabs), ScanWin will issue a warning. If the log is full, user changes will not be permitted until 
the data has been collected from the log. This ensures that the audit trail is continuous. 

 

Note: With ScanWin LITE, all Scanner History data (Hourly, Daily Flowrun History, Events and User changes) is 
saved only to the SCM download file and is viewed using the SCM Viewer. The filename and extension of the SCM 
history download binary file is nnnnnnxx.scm where nnnnnn are the first six characters of the Scanner’s node name 
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Download From Scanner 
1. Access Download from Scanner as explained on page 41. 

 
 
 
 
 
 

2. The first Data Collection of History Logs window is shown. 
Click on the line containing the history logs to show a green check 
mark (for the history logs that you wish to download).  By default, all 
the lines will begin with a red X. 
Clicking on the All button in the upper right hand corner of the window 
inserts a green check mark for each of the logs. 
Click Next when you are done. 
 
 
 

3. This dialog box is displayed. 
Click the check mark beside the flowruns that you do not want to 
download (a red X appears). 
Or 
Click All to select all the flowruns.  Green check marks appear beside 
the selected flowruns.   
Click Next to continue. 
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4. The Setup dialog box is displayed. 
Select one of the following download types (Note that some 
options may not be available.  Refer to the Downloads option on 
page 38):  
• From This EFM/RTU.  This results in a complete download of 

all the history in the unit. 
• For The Last -- Days.  If you select this option, enter the 

number of days worth of data you want to download. 
Click the Next button when you have made your choice. 
 

 
5. ScanWin LITE downloads the data to your computer for the period 

specified and informs you when the process is complete.  
Click Next when you are prompted to do so. 
 
 
 
 
 
 
 

 
6. You are then presented with a choice of where to send your data.   

If you accept the suggested filename and location of the file, click on 
the Next button; otherwise select Setup and insert your own filename 
and/or file location. 

7. Click Finish when the process is complete. 
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Flowrun Setup 
ScanWin LITE provides a wizard that helps you to set up the flowruns for the Scanner.  

To configure a flowrun: 
1. Access Flowrun Setup as described on page 41.  
2. The menu to select Add, Modify, or Delete flowruns appears. Click on 

the line containing the flowrun to select a green check mark or a red X.. 
A green check mark indicates that the flowrun can be modified or 
deleted. A red X indicates that the flowrun cannot be changed or 
deleted. Also, select the operation to perform on the selected flowrun(s). 
Click Next after making your choices. 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Enter the flowrun number of the flowrun you are adding. 
Click Next. 
 
 
 
 
 
 
 

• Add New Flowrun (click Next, go to Step 3) 
• Modify Selected Flowrun (click Next, go to Step 4) 
• Delete Selected Flowrun (Resulting dialog is: Are you sure you want to delete the flowrun #x?  Select  

yes or no.  If yes is selected, dialog appears informing you of the deletion of flowrun #x). 
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Flowrun configuration information will be stored in the 
Barton\BDMS\Data\Config\Flowrun directory (default is Drive C). 
A flowrun configuration file can be recognized by its .FRN extension.  The file 
name is determined by the user. 

Click on the Load button to choose a new configuration file. 

4. ScanWin LITE will normally display a screen like this. 
Click on the Next button to accept this configuration and go to Step 5. 
 
 
 
 
 
 
 
If a configuration file does not already exist, you will be warned with an 
error message display like this. 
 
 
  

When you click the OK button, you are shown this screen. 
Click on Next (and go to Step 5) to load ScanWin LITE’s default 
configuration or click on the Load button to load a previously saved 
configuration.   
 
 
 
 
 
 
 

You will be shown a screen similar to the following: 
Find the directory containing your configuration file 
(extension .frn), and click on it.  Then click on the OK 
button. 

Note: Default flowrun configuration files begin with “C” (Canadian) or “U” (U.S.) and differ in their Base Pressure 
and Base Temperature. 
“C” files have Pbase and Tbase values of 101.325 kPaa and 15°C respectively. 
“U” files have Pbase and Tbase values of 14.73 psia and 60°F respectively. 
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The following dialog gives you the option of loading a new file (by 
clicking Load) or using this file to continue (by clicking Next).  Note that 
you are also given the choice of using the displayed file as a template for 
future flowrun setups (first click on the line with the box and a check 
mark will appear, then click the Next button). 
 
 
 
 
 

5. Enter flowrun configuration values. 
When finished, click Next. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Refer to  
- Chapter 10: NGas 4.X.X Configuration & 
Calculations 
- Chapter 11: IGas 4.X.X Configuration & 
Calculations 
- Chapter 12: NFlo 4.X.X Configuration & 
Calculations 
- Chapter 13: Monitor Flowrun Configuration 
for rules affecting the flowrun. 
 

WARNING!! 
Modifying the following flowrun components will result in the LOSS of current history data.  Before 
modifying your flowrun, you should download and save your current history data using the Data 
Collection wizard (see Chapter 3: Performing ROUTINE Processes). 
• Volume, Mass, Energy Calculations   
• Orifice or Pulse 
• Z Method in Use 
• Flowrun Type 
• Hourly History Log Size 
• Daily History Log Size 
• Qb/Press Peak Logging 
• Density Source 
• Gas Component Mode 
• Gravity Mode 
• Hourly History Log Interval 
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6. A window allowing you to set the Flowrun Parameters is 
then shown. 
Enter your values and click Next when you are done. 
 
 
 
 
 
 
 
 
 
 
 
 

7. The next display is for gas composition values. A new 
flowrun will have a default value of zero for each gas. 
If a flowrun is being modified, this window will 
contain the present values for the gases. 
 
 
 
 
 
 
 
 
 
Enter information in the fields using the following for a guide: 
 In this field… Enter… 
Gas component 
reference string 

An identifying reference to the gas composition that you will use for this flowrun. 

Real Gas Relative 
density 

The value of the relative density of the gas at base conditions.  Note that this field appears 
if the Gravity Mode was selected as entered in Step 4 (Configuration). 

Volumetric Heating 
value 

The heating value of the gas.  Note that this field appears if the Heating Value mode was 
selected as entered in Step 4 (Configuration). 

Mole Fraction (gas) The percentage of the gas.  As you enter the value, a total appears in the box in the lower 
left-hand corner of the window.  If your total does not add up to 100 or 1.0, a window 
appears warning you of this fact.  You are given the choice of using the values entered or 
editing them. 

Note:  ScanWin LITE will also notify you of this potential loss with 
this warning when you click the Next button. 

See Chapter 10: NGas 4.X.X Configuration & 
Calculations  
and Chapter 11: IGas 4.X.X Configuration & 
Calculations 
and Chapter 12: NFlo 4.X.X Configuration & 
Calculations 
 for Flowrun data values. 
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8. You are then prompted to set the Live Inputs in the 
following window.  Under the Type heading, click on 
a field to show a drop-down box. Click on your choice 
and press the Enter key (or click on another field). 
The appropriate fields will appear in the lower half of 
the window. 
See note below. Click Next when you are finished. 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
Also, note that in Step 5, if you had selected From 
GC in the Gas Component Mode field when using a 
Gas Chromatograph, you can assign the live input to 
that peripheral device by using its Mole Fraction Sum.  
At Step 5, it is also possible to specify that the Gravity 
and Heating Value modes be given live inputs.  In a 
similar manner, the inputs can be from the Gas 
Chromatograph. 
 

The input Type and Resource for the flowrun are displayed, by double-clicking on the desired row of the table.  The 
availability of this function is indicated by the green triangles in the top left corner of the table cells.  The hardware 
information appears and you select the following for each input listed in the Name column.  Select from: 
• Analog input 
• RTD input (temperature only) 
• Pulse input (pulse input only) 
• Fixed input 
• Barton DPE (Differential and Static Pressure) 
• Peripheral Device (Barton MVX Multivariable Transmitter, Transmitter, Daniel Ultrasonic, Daniel Gas 

Chromatograph and MVX-II/3095FB Multivariable Transmitter) 
Check that the input hardware resource type exists before displaying options. 
• The Resource – Slot and resource number 
• Fill in the Hardware details, zero, full-scale etc. 
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9. ScanWin LITE then gives you the option of saving the configuration 
to a file or to the Scanner.   
To save the file to the Scanner, click the Next button and go to Step 
11. 
 
 
 
 
 

 
To save this configuration to a file, click on the Save button. You will then be asked to name your 
configuration file. 
Type in your filename and click the OK button. 

 

10. Before you continue, ScanWin LITE gives you the opportunity to use 
this configuration as a template for future flowruns. 
 
 
 
 
 
 
 
 
To select this option, click on the line “Use this file as a template…” 
to place a check mark in the box. Click the Next button to continue. 
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11. You are prompted to set the flowrun state after the upload to the 
Scanner has been completed. Click Next when you are ready.   
 
 
 
 
 
 

 
12. Wait until the configuration is complete. Message is not shown for 

Flowrun setup in Offline mode. 
 
 
 
 
 
 
 
 

13. When the setup information is uploaded to the Scanner, this window is 
displayed. 
 Click Finish to return to the Setup page. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Note: After the flowrun has been set up, VERIFY that your Live Inputs and Rates and Totals are 
being updated on the Flowrun page (refer to Chapter 11).  This is especially important after you 
have created or modified flowruns to include peripheral devices such as the MVX. 
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Change Plate 
ScanWin LITE provides a wizard that helps you change the orifice plate of an orifice meter.  This procedure shuts 
down the flowruns that are being serviced and restarts them on the completion of the task.  If the Estimate 
During Plate Change setting (via the Flowrun Setup, page 45) has been turned on (green check mark), then 
flow estimation will take place while the flowruns are offline.  If this option is set to off (red X), no volume will 
be estimated during a plate change while the flowruns are offline. 
The flowrun status is always changed to running upon completion of the orifice plate change routine regardless 
of its previous state. 

To change the orifice plate: 
1. Select Change Plate as described on page 41. 

 
 
 
 
 

 

2. At the Select Flowruns for Plate Change dialog box, select the 
flowruns for which you want to change the orifice plate.  By default, 
all the lines will initially contain a red X.  Clicking on the lines of the 
flowruns you will change causes a green check mark to appear.  
Click the check mark or X to toggle from one to the other.  Click Next 
when you are done. 
 
 
 
 
 

3. At the prompt, enter the new orifice plate size. 
In the New Value field,  
either  
enter the new orifice plate size   
or, 
select the size of the new orifice plate from the drop-down list. 
The serial number of the new plate may be entered in the space 
provided. 
Click Next to continue. 
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4. The flowrun is then stopped and you are prompted to install the new 
plate. 
After the plate has been changed, click Next to continue. 
 
 
 
 
 
 
 

5. After the new plate size is uploaded to the Scanner, you are prompted 
to wait until the flowrun is restarted. 
 
 
 
 
 
 
 
 

6. If you are changing plates in more than one flowrun, the following 
window is displayed prompting you to click on the Next button to 
select the next flowrun.  
You will then repeat Steps 3 to 5 for the new flowrun. 
 
 
 
 
 
 

7. After the last plate has been changed, the following window is 
displayed. 
Click Finish to return to ScanWin LITE. 
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Change Gas Composition 
ScanWin LITE provides a wizard that allows you to easily change the gas composition for any flowrun. 
The runs affected are switched offline during the gas composition change. Provided the estimation feature has 
been enabled (via the Flowrun Setup wizard (page 45)), flow will be estimated for the period the flowruns are 
offline.  The flowrun status is always changed to Running upon completion of the Gas Data Change routine 
regardless of its previous status. 

To change the gas composition: 
1. Choose the Change Gas Composition icon (or Change Gas Composition in 

the Main Menu) as described on page 54.  
 
 
 
 
 
 

2. The first Gas Composition Change window is shown. 
Select the flowruns you want to change.  By default, all the flowruns 
will start with a red X.  Click on the lines containing the flowruns you 
want to change.  A green check mark will appear to indicate that the 
gas composition of those flowruns will be changed.  
 
 
 
 
 
 
 

3. Select the method for changing the gas composition for Scanners with multiple flowruns and the same gas 
data type, specifically: 
Click this… To… 
Individually Set a different gas composition for each flowrun.  
Grouped by Gas Type Set the same gas composition in all flowruns with the same gas data type. 

 Click Next to continue.  
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4. The following dialog box is displayed. 
 To edit the present gas composition, click Next and go to Step 6.  To 
get the gas composition values from a file, click Load.   
 
 
 
 
 
 

 
This dialog box is shown. 
Locate the gas composition file you want and select the file.  
Click OK. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. ScanWin LITE informs you that the values from the file have been 
loaded. 
Click Next to continue. 
 
 
 
 
 
 
 

Note:  Gas Composition files have a .g_# extension where “#” depends on the Gas Data Type chosen in the 
Flowrun Setup.  These gas data types will produce the following extensions (g_#): 

  Manual    (.g_0)  Mole Fractions   (.g_1) 
  GCN    (.g_2)  GHC   (.g_4) 
  GHN   (.g_6)  Pc, Tc   (.g_7) 
  Extended Mole Fractions (.g_8) 
Gas Composition files are stored in the Barton\BDMS\Data\Config\Gascomps directory on the drive on which 
ScanWin is installed (drive C is the default). 
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Enter the new values in the New Column 

6. The following dialog box is displayed. 
In the New column, enter the new values.  The total value must 
be 100.  The Scanner calculation internally rationalizes any 
compositions that do not equal 100.   
Click Next to continue.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
7. Go to Step 8 unless Gr and Hvb were assigned as ENTERED in the 

Configuration page of the Flowrun Setup, page 45.  The following 
display will prompt you to enter the new values for Specific Gravity 
(Gr) and Heating Value (Hvb). 
Enter the new values.  Click the Next button when you are done. 
 
 
 
 

 
8. The following dialog box is then displayed. 

In the New Reference field, enter a reference number for the new gas 
composition.  You can also leave this field blank.   
Click Next to continue.  
 
 
 
 
 
 
 

Note: If the total does not add up to 100 or 1.0, ScanWin LITE 
displays an error message. You must confirm that the 
desired total does not equal 100 or 1.0. 

This dialog is ONLY displayed if Gr and Hvb were assigned as 
ENTERED in the Flowrun Setup. 
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The following dialog box is shown. 
Click Next to send the new gas composition to the Scanner.   
Go to Step 12 if you are changing only one gas composition.   
Go to Step 11 if you are changing the gas compositions of multiple 
flowruns (Step 2).  
 
 
 
 
 
If you want to save the new gas composition to a file click the 
Save button.   
This dialog box is displayed: 
In Folders, select the folder to which you want to save the gas 
composition. 
In File name, enter a name for the new gas composition.  
From the Save file as type drop down list, select the gas data 
type. 
Click OK and you will be informed that the file has been 
saved. 

9. This dialog confirms the saving of your new gas composition file. 
You will be taken to Step 12 if this is the only flowrun you are editing 
or it is the last one in a series of flowrun changes. 
 
 
 
 
 
 
 

10. If you are performing multiple gas composition changes, the following 
message prompting you to select a new flowrun is shown. 
Click Next to change the gas composition of another flowrun. 

11. Repeat Steps 4 - 10 to change the gas composition for each of the 
flowruns you selected. 

12. Click Finish after the last change has been made. 
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Calibrate/Verify Devices 
ScanWin LITE provides wizards that lead you through the steps to calibrate or verify transmitter and transducer 
inputs.  The calibration options allow you to set the number of calibration points and the sequence in which you 
execute this function.   
 
Note: Calibration report files are stored in the barton\bdms\data\reports\calibr directory on the drive where 

ScanWin LITE was installed (Drive C, by default).   

             These files are denoted with a “.cbr” extension.  When opened with a text editor, such as Notepad, they 
look like the example in the Sample Calibration Report (page 78) section. 

Note: The flowrun history, during a calibration, can be configured to default to a set value or be stopped.  
Setting this up can be done by accessing ScanWin Settings (Options > ScanWin Settings > General > 
Wizards).  Refer to Quick Start Settings (page 38). 

The types of input devices that can be calibrated are: 
Analog Input Calibration, page 59 (1-5V or 4-20 mA with optional load resistors) 
• Static Pressure 
• Temperature 
• Specific Gravity 
• Heating Value 
Analog Differential Pressure Input Calibration, page 65 (zero and span compensation based on static 
pressure) 
• Differential Pressure 
RTD Temperature Input Calibration, page 69 (100 ohm 0.00385 or 0.003902 Ω/Ω°C curve probe) 
• Temperature 
Barton DPE Cell Calibration, page 71 
• Static and differential pressure 
Linear Pulse Input Calibration, page 76 (segmented multiple K factors)  
• Flow rate 

To calibrate an input device, select the Calibrate Devices icon or Calibration (Main Menu) as described on page 
41. 

 
 
 

 
 

For an Analog Output Calibration, see page 102. 
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Analog Input Calibration 
An analog calibration can be applied to any measured variable that can be assigned to an analog input (e.g. 
Static Pressure, Temperature, Specific Gravity, %CO2, etc.). 
1. Access the calibration wizard as explained on page 41. 
2. When the Select End Device for Calibration 

window is displayed, click on the line 
containing your analog input device.  Then 
click on Next. 
 
 
 
 
 
 
 
 
 

3. ScanWin LITE will inform you of the existing current and default 
values for the resource.  The default value will be used to estimate the 
flowrun while the calibration is being performed. 
 
 
 
 
 
 

 
4. A page summarizing the resource chosen, the affected flowrun(s) and 

their state(s) is displayed. 
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Undo allows you redo your current line and Reset 
clears all the new values and replaces them with 
your original ones.  

If you have configured the ScanWin settings to stop the flowruns 
during a calibration, this summary page will be displayed. 
 
 
 
 
 
 
Click Next when you are ready to continue. 

 
5. A dialog asking you to choose the calibration method is displayed.  

After making your choice, click on the Next button. 
For an Offset calibration, refer to Offset Method, page 64. 
 
 
 
 
 
 
 

6. Choose the kind of calibration you wish to perform, the number of 
points you want to include, and how many readings you want to 
average for each point. 
Click the Next button when you are ready to continue. 
 
 
 
 
 
 
 

This window allows you to enter your calibration 
values. 
Enter the Expected value for the first calibration 
point. Then press the Enter or Return key on 
your keyboard.  
 

The cursor will go to the check column (4th 
column). Press the Enter or Return key on your 
keyboard to accept the point. A check mark will appear for that point and the cursor will go to the next 
point. 
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Calibration and Verification Notes 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
When all the points have check marks, click Next. 
7. You are then prompted to send these calibration values to the Scanner.  

Alternatively, you may choose to obtain a Verification Report, in 
which case, you will be taken to Step 1 of the Common Calibration 
Procedures – page 62. 
Click Next. 
 
 
 
 
 
 

8. If you have chosen to save these values “As New Calibration,” 
ScanWin LITE prompts you to accept your calibration values. 
Click Next to accept the calibration values displayed. If they are 
not acceptable, click the Cancel button to start a new calibration. 
 
 
 
 
 
 
 
 
 
 

a. Enter the value of the point to be calibrated / verified in the Expected column, the units of measurement are 
shown in brackets, e.g. kPa.  If a calibration has been performed in the past, the values from the previous 
calibration are displayed. 

b. The Live Value is the live value of the transmitter, in the same units as expected value, will be displayed in the 
column to the right of Expected.  This value is updated every 1 to 2 seconds. 

c. Live (avg) shows the average of the last user selected number of readings 
d. After the Expected Value is input and the Enter key is pressed, the cursor will go to the check column (4th 

column).  When the Average value is satisfactory, you press Enter to accept the point.  A check mark will appear 
for that point and the cursor will go to the next point.  

e. The raw value is averaged value in raw units read by the measurement RTU, volts for analog inputs or ohms for 
RTD inputs. 

f. The Previous Raw value is the Raw value from the previous calibration. 
g. % Change is the percent difference between the Raw and Previous Raw values. 
h. % Error is the percent difference between Expected and Averaged Value. 
i. If the expected values are different from the previous calibration or this is the first calibration, the % change cannot 

be calculated. 
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Common Calibration Procedures 
1. You are then prompted to enter notes about the calibration.  This 

includes information such as general observations, model and serial 
number of the calibration equipment.  Up to 127 characters may be 
entered.  These notes become part of the Calibration Report. 
Click Next when you are done. 
 
 
 
 
 
 

2. You are then prompted to select a destination for the calibration file.  
By default, ScanWin will send the report to Drive A with the name 
XXXXXXyy.cbr where XXXXXX is the first 6 letters of the Node 
name and yy is a generated incremental number.  If you agree with the 
name of the file and its destination, click Next and go to Step 4. 
Click the Setup button if you do not wish to have the file saved in the 
target directory, or wish to change the filename. 
 
 
 
 
A dialog like the following appears allowing you to 
change either the filename or the destination. 
Click OK when you are done, or Cancel if you do not 
want to change anything.  You will then be taken back to 
the previous dialog. 
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If more than one flowrun was selected in Step 2 of the 
Analog Input Calibration section, then clicking on Next takes you back 
to Step 3 of that section. 

3. You are then prompted to either  
Press Next to select another device for calibration 
 
 
 
 
 
 
 
 
OR  
Press Next to restart the flowrun(s). 
 
 
 
 
 
 
 
 

 
4. After the flowruns have been restarted, you are prompted to complete 

the process. 
Click Finish. 
 
 
 
 
 
 

 
5. If Cancel is selected at any time during the Calibration process, the 

Abort Calibration dialog is displayed. 
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Offset Method 
When you choose the Offset calibration method for an analog input, the following dialogs will be displayed: 
 
1. You are shown the existing calibration settings. 

Enter your new calibration point in the box. 
Click the Next button. 

 
 
 
 
 
 
 
2. You are asked to confirm this value as a new calibration. 

Click the Next button. 
 
 
 
 
 
 
 
 

3. ScanWin LITE asks you to confirm you value as the new 
calibration. 
If you agree with the calibration, click Next and you will be taken 
back to the Calibration and Verification Notes, (page 61) section 
to finish the procedure. 
If you disagree with the calibration, click Cancel to start a new 
calibration. 
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Analog Differential Pressure Input Calibration 
1. Select Calibration as described on page 41. 
2. When the Select End Device for Calibration window 

appears, select Differential Pressure to calibrate the 
differential pressure. A green check mark will appear 
in the Select column.  Click Next.  
 
 
 
 
 
 
 
 

3. If you have selected to keep the flowrun running during the 
calibration, ScanWin LITE will display this dialog summarizing the 
default settings of the flowrun.   
  
 
 
 
 
 

 
4. A dialog summarizing your settings will then be displayed. 

This one shows that you are will be using your default settings. 
 
 
 
 
 
 
 
 
Or
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If you chose to stop the flowruns while calibrating the device, 
ScanWin LITE will display this dialog informing you that the flowruns 
have been stopped.  The dialog also advises if an estimation will be 
done while the flowrun is stopped. 
Click Next. 
Note:  Estimating will occur only if the previous state was set to 
Running. 
 
 
 
 

5. The transmitter must now be zeroed at atmospheric pressure.  
ScanWin LITE displays a schematic indicating the valve configuration 
required to equalize the pressure on the differential pressure 
transmitter and vent it to atmosphere. 
When this instruction has been carried out, click Next. 
 
 
 
 
 
 

6. You are then asked whether to perform an End to End Calibration. 
If you choose not to perform an End to End Calibration, proceed to 
Step 9.  Click the Next button to continue. 
 
 
 
 
 
 

 
7. A dialog prompts you to prepare for the End to End Calibration by 

closing the high-pressure equalizer valve as shown. 
When instructions have been performed, click Next. 
 
 
 
 
 
 
 
 

End to End Calibration is possible only on released versions of IGas, 
NGas and NFlo 4.0.1 and above. 
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Undo allows you redo your current line and Reset 
clears all the new values and replaces them with  
your original ones.  

8. ScanWin LITE displays a dialog to Set Calibration Options. 
Choose a calibration mode and click Next. 
 
 
 
 
 
 
 

 
9. ScanWin LITE displays the Enter Calibration 

Points for Analog Input dialog: 
 
 
 
 
 
 
Enter the Expected value for each calibration 
point, then press the Enter or Return key on 
your keyboard. The cursor will go to the check 
column (4th column). Press Enter to accept the point. A checkmark will appear for that point and the 
cursor will go to the next point. Refer to the Calibration and Verification Notes (page 61). 

 
Click on the Next button when you are done. 
 
 
 
 
 
 
 
 
 

 
10. ScanWin LITE displays schematics prompting you to close the vent 

valve and equalize pressure between the high side and the low side of 
the transmitter. 
You are also directed to zero the differential pressure transmitter 
/transducer at operating pressure. (Note that a block valve is the same 
as an isolation valve).  When these instructions have been carried out, 
click Next. 
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11. You are then asked to zero the transmitter. 

When you are ready, click Next. 
 
 
 
 
 
 
 
 

12. ScanWin LITE then instructs you to return the meter (transmitter) to 
service: 
Click Next when you have performed these steps. 
 
 
 
 
 
 
 
 

13. ScanWin LITE displays a window asking you to enter the static 
pressure span correction (SPC) factor. 
Click Next. 
 
 
 
 
 
 

 
14. ScanWin LITE displays a window asking whether you want to update 

the Scanner with the new calibration values or save the verification 
report. 
Click Next. 
 
 
 
 
 
 

Use a value of 0 for no correction. 
A typical value would be ~ 0.03 %/Mpag.
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15. If New Calibration is selected the As Left values will be 
displayed.  Current method is to send the calibration to the Scanner 
Measurement RTU to calculate the As Left values.  ScanWin LITE 
then retrieves the As Left values for display. 
Click Next. 

16. ScanWin LITE then takes you through a set of Common 
Calibration Procedures (page 62) that enable you to enter 
Calibration Notes or to save a Calibration Report and give you the 
option of calibrating another device or ending the process.  
 
 
 
 
 

RTD Temperature Input Calibration 
1. Select Calibration as described on page 41.  Click Calibrate Devices to select the device to calibrate. 
2. Select RTD Input Type for the desired flowrun 

to calibrate the temperature.  Click Next.  
 
 
 
 
 
 
 

 
 

 
3. If you have chosen to keep the flowruns running and use default 

values for live inputs in the flowrun history (see note on page 58), this 
dialog will be displayed 
Click Next to go on. 
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4. Depending on how your flowrun configurations are set up for  
estimation, ScanWin LITE will shut down the calculations for the 
flowruns and display a dialog informing you that estimation is ON or 
OFF.  If estimation is ON (see Flowrun Setup), the Scanner will 
estimate the inputs and totals during the calibration/verification. 
If you are using live default values, it will inform you that the state is 
defaulted. 
Click Next. 
 
 
 

5. You are given a choice of calibration methods.   
 
Choosing to do a Multipoint calibration will take you through steps 
similar to that of an Analog Input Calibration, page 59. 
 
Click Next. 
 
 
 

 
6. If Shift Offset is chosen as the Calibration method, you are then 

prompted to enter a reference temperature.  Note that a typical Shift 
calibration would use an ice bath at 0°C (32°F). 
Click Next. 
 
 
 
 
 

 
7. ScanWin LITE then prompts you to accept the calibration values. 

Click Next 
8. ScanWin LITE then takes you through a set of Common 

Calibration Procedures (page 62) that enable you to enter 
Calibration Notes, save a Calibration Report, calibrate another 
device, or end the process. 
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Barton DPE Cell Calibration 

DPE Static Pressure 
1. Start the ScanWin LITE Calibration wizard as described on page 41. 
2. At the Select End Device for Calibration 

window, click on the DPE SP Input line so that a 
green check mark is displayed. 
Click Next. 
 
 
 
 
 
 
 

 
3. ScanWin LITE informs you that it is stopping the flowrun(s) and tells 

you when it is done. 
Click Next. 
 
 
 
 
 
 
 

4. Then you are instructed to position the valves as shown in the 
following diagram. 
Click Next. 
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If you choose to do a Shift Calibration, go to Step 11. 

Undo allows you redo your current line and Reset 
clears all the new values and replaces them with 
your original ones.  

5. You are given the option of doing a Multipoint calibration, which is 
like an analog calibration or a Shift calibration, which allows you to 
calibrate at a single point and offset the static pressure curves. 
Click Next to continue. 
 
 
 
 
 

 
6. A window allowing you to set the type of calibration is shown. Click 

the Next button after you have made your choices. 
 
 
 
 
 
 
 

 
7. ScanWin LITE displays a window that enables you 

to enter the calibration points.  A 5-point random 
calibration is shown as an example: 
See the Calibration and Verification Notes section 
(page 61). 
When all your points have been entered and have 
check marks, click the Next button. 
 
 
 
 
 

8. You are instructed to return the valves to the positions as shown in the 
diagram. 
Click Next. 
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9. You are then prompted to accept the new calibration values. 
Click Next. 
 
 
 
 
 
 
 

 
10. The new calibration values are then displayed for your acceptance. 

Click Next to accept these and go to Step 14 or Cancel to end the 
calibration wizard. 
 
 
 
 
 
 
 
 
 
 

11. If you have chosen to do a Shift calibration, the following dialog is 
presented. 
When you have carried out the instruction, click on the Next button. 

12. You will then be prompted to Return Meter to Service (see Step 8 
dialog). 
 
 
 
 
 
 

13. Next, you are asked to accept the calibration. 
Click the Next button. 

14. ScanWin LITE then takes you through a set of Common Calibration 
Procedures (page 62) that enable you to enter Calibration Notes, save 
a Calibration Report, calibrate another device, or end the process. 
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DPE Differential Pressure 
1. Begin the calibration process as explained on page 41. 
2. At the Select End Devices for Calibration 

window, select the DPE DP input line.  When the 
green check mark appears, click on the Next 
button. 
 
 
 
 
 
 
 
 
 

3. In preparation for the calibration, ScanWin LITE stops the flowrun 
and turns on estimation (if this was chosen in the setup).   
Click Next. 
 
 
 
 
 
 

 
4. You are prompted to set the valves in the indicated positions. 

Click the Next button when you are ready. 
 
 
 
 
 
 
 

5. The next window prompts you to set the options relating to  
the calibration you are about to perform: 
Click the Next button when you are finished. 
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Undo allows you redo your current line and 
Reset clears all the new values and replaces 
them with your original ones.  

If you are doing a Verification Report, go to Step 10 below.  Note that 
you will be asked to make Verification notes instead of Calibration notes.

6. Enter your calibration points and press the 
Eenter key. 
For an explanation of the table, see the 
Calibration and Verification Notes section  
(page 61). 
When all your points have been entered and 
have check marks, click the Next button. 
 

 
 

7. You are then prompted to set the valves in the indicated position to 
return the meter to a functional state. 
Click the Next button when you have done so. 
 
 
 
 
 
 

 
8. You are then asked to specify whether the new values are to be used 

as a new calibration or for a verification report. 
Select the appropriate radio button and click Next. 
 
 
 
 
 
 

 
9. If you choose to accept the values as a new calibration, a 

summary of the calibration is then presented. 
If the values are acceptable, click the Next button. To reject them, 
clickCancel. 

10. ScanWin LITE then takes you through a set of Common 
Calibration Procedures (page 62) that enable you to enter 
Calibration Notes, save a Calibration Report, calibrate another 
device, or end the process. 
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Linear Pulse Input Calibration 
1. Begin the calibration function as explained on page 41. 
2. At the Select End Devices to Calibrate, select the 

line containing your Pulse Input device. 
When the green check mark appears, click  Next.  
 
 
 
 
 
 
 

3. ScanWin LITE shuts down the calculations for the flowrun and 
displays a dialog box informing you of the shutdown. 
Click Next.  
 
 
 
 
 
 
 

4. You are then asked to enter the number of calibration points: 
Click Next. 
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The Reset button restores all the settings to their previous values. 

5. Enter a K-factor for each calibration point. 
Click Next when you are finished. 
 
 
 
 
 
 
 
 
 

 
6. You are then presented with a summary of the calibration. 

Click Next to accept these values. 
 

7. ScanWin LITE then guides you through a set of Common 
Calibration Procedures (page 62) that enable you to enter 
Calibration Notes, save a Calibration Report, calibrate another 
device, or end the process. 
 
 
 
 

 
 
 

Calibrating an Analog Output Device 
See Chapter 4 for an Analog Output calibration (page 102). 
 
 

Note:  Press Enter after each KFactor.  A check appears in the 
cell. 
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Sample Calibration Report 
Scanner 1100 Analog Input Multi-point Calibration Report 
 
This input has been assigned to: 
Node : 40DEMO, Flowrun #01 (RUN001) 
Channel location : Node 40DEMO, Slot A, Resource #09 
Channel category : Static Pressure (gauge) 
User Text        : Calibration was done in Moose Country on April 1, 2002 by Mark Teknshan 
User Change Number    : 442 - 443 
Transmitter zero      :      0.000 psig 
Transmitter fullscale :   1000.000 psig 
Number of calibration points : 5 (Down) 
 
 
   Calibration Point      As Found            As Left            Raw Reading 
      psig                psig                psig                  Volts 
 --------------------------------------------------------------------------------------- 
 
     1000.000            1000.019            1000.000               3.001 
      750.000             749.986             750.000               2.501 
      500.000             500.038             500.000               2.001 
      250.000             250.024             250.000               1.501 
        0.000               0.003               0.000               1.001 
 
 
 
Effective Date        : 2002-07-19 14:10:15 
User Identification   : Manager (via network) 
 

 
 
 



 Chapter 3: Performing ROUTINE Processes 

February 2006 79 

Because the Configuration file and Reports use the first 6 
characters of the Node Name, users should use the 7th 
character and up to identify the company, site, project, etc. 

Scanner Setup Options 
After the user is connected to the Scanner, the Scanner can be configured. ScanWin LITE provides a wizard that 
helps you to either set up a Scanner, save a Scanner configuration (page 81), or restore (page 83) a Scanner 
configuration.  If you are connected to a Scanner that has been previously configured, current information is 
automatically shown. 
To access the setup options, choose Scanner Setup from the Setup tab as described on 
page 41 or select Tools > Scanner Setup from the menu bar. 

 
 
 
 
 

Scanner Setup 
To set up a Scanner: 
1. Select Scanner Setup and press OK. You are prompted to fill 

in the Scanner or system information.  See Chapter 5 for 
additional information about Node Information (page 105). 
 
 
 
 
 
 
 
 
 
 
Use the following table to guide you in the setup of the Scanner: 
This field… Refers to the… 
Unit Node Name Name of the Scanner (up to 14 characters). 
Gas Day Hour Gas day for reporting volumes; for example, a Gas Day Hour of 8 goes from 8:00 

a.m. April 1 to 7:59 a.m. April 2.  A value of 0 - 23 may be used.  The default is 8. 
Vtx output settling time Settling time used in the Power Save Mode to establish how long a transmitter takes 

to send a stable reading after it is turned on.  Default is 100 ms. 
HW Range Alarm 
Configuration 

Selection of the handling of hardware range alarms.  Options are Off, Show in 
Event Log, Show in Alarms Page and Events and Alarms.  

Flowrun Check Alarm 
Configuration 

Selection of the handling of flowrun check alarms.  Options are Off, Show in Event 
Log, Show in Alarms Page and Events and Alarms.  

Power Save Mode Use of FULL or LOW battery power (low power save mode used when there is 
limited power available, e.g. solar power).  

  
  



ScanWin LITE   

80 February 2006  

This field… Refers to the… 
Power Supply Type1 Type of power supply installed.  Options are  

• 12V 30-55 Ahr 
• 12V 60+ Ahr 
• 6V 10-20 Ahr 
• 6V 21+ Ahr 
• No Battery 
• Custom 

Analog In / RTD Select 
[A15 – A17]1 

Hardware assignment for resources A15 to A17.  Options are RTD or 2 Analogs. 

Analog In / RTD Select 
[A18 – A20]1 

Hardware assignment for resources A18 to A20.  Options are RTD or 2 Analogs. 

Vtx output override Vtx (Power to transmitters) is always ON, even in Low power. 
Local RTC display mode Real-time Clock displaying the time as AM/PM or ML (24-hour Military Time) 
CFG Lockout Switch 
assignment  

Resource that is handling the lock switch.  

Low Battery Level Voltage at which a Low Battery Alarm is triggered.  The default on an 1140 flow 
measurement RTU is 6.1V and 11.5V for an 1130/1131unit.  Value is configurable. 

Low Battery Deadband Voltage difference above the Low Battery Level that must be achieved for a Low 
Battery Alarm to disappear. 

Low Battery Alarm Output Resource to which a Low Battery Alarm is assigned. 
Measurement Status Input 
#1 Assignment 

Resource to which a Status Warning input #1 is assigned. 

Measurement Status Input 
#2 Assignment 

Resource to which a Status Warning input #2 is assigned 

System Alarm Output Resource to which the System Alarm output is assigned. 

 
2. Click Next.  A dialog prompts you to click Next to upload a new 

setup. 
 
 
 
 
 
 
 
 
 

3. Click Finish when prompted to do so. 
 
 
 
 
 
 
 

                                                      
1 Shaded rows are applicable to the Scanner 1141 only. 
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Save Scanner Configuration 
ScanWin LITE allows you to save the configuration of the entire Scanner. Note that you have to be logged in 
at the Manager level to perform this procedure (see page 82). 
1. Access Save Scanner Configuration as described on page 79.  
2. You can save the configuration of the entire unit or save your 

calibration only. In addition, you may send your configuration 
to a file or to a report. 
Click Next. 
 
 
 
 
 
 
 

3. ScanWin LITE tells you the name of the new file and where it 
will be located. 
If this is acceptable, click Next and go to Step 5; if it is not, 
click Setup. 
 
 
 
 
 

 
A window will appear, allowing you to change the location and 
name of the file (it is recommended that you use the directory 
x:\barton\bdms\data\config\scanner where x is your drive 
letter). 
Click OK when you are finished and then Next at the window 
with your new filename and its location. 
 

 
4. You are then shown the progress of the save operation.  Green 

check marks will appear as each segment of the unit’s 
configuration is saved. 
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If you chose to save the configuration of your calibration(s), a 
screen like the following will appear. 
When all is done, click Finish to end this procedure. 
 
 
 
 
 
 

Non-Manager Login Warning 
If you are not logged in as a Manager, this message is displayed 
during the Save or Restore Configuration procedure. 
Clicking Next allows everything to be saved or restored EXCEPT 
the Scanner Security Parameters (User Level and Password). 
 
 
 

Files Created When Saving Scanner Configuration 
Files created by saving the Scanner configuration are, by default, placed in the 
\Barton|BDMS\Data\Config\Scanner directory on Drive C.  The files are named nnnnnnnn.ext where 
nnnnnnnn are the first eight characters in the Node Name and .ext is the file extension.  The file extensions 
depend on which options were chosen in Step 2 of the previous Save Scanner Configuration (page 81) 
section. 
 
The following table explains the file extensions: 
Options Chosen 
(Scope/Type) 

Extension2 Description 

.SE# Binary file used during restoration  
Entire Unit/Configuration File 

.TE# Text version of the binary file; used to verify binary 

.TC# Binary file used during restoration 
Calibration/Configuration File 

.TC# Text version of the calibration binary 

.ST# Formatted text Entire Unit/Configuration Report 
--------and-------- 
Calibration/Configuration Report .TT# Unformatted text 

 
 

                                                      
2 “#” denotes an incremental number from 0 to 9 
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Double click on item to access it. 

Restore Scanner Configuration 
ScanWin LITE allows you to copy a configuration back to a Scanner.  Alternatively, you can copy the same 
configuration to more than one Scanner.  Note that you have to be logged in at the Manager level to perform 
this procedure (see page 82). 

 
 

  
To restore the Scanner’s configuration: 
1. Begin the Restore Scanner Configuration process as described on page 79.  
2. You are then shown this screen: 

Click Next. 
 
 
 
 
 
 
 
 
 

3. If you have superbooted the Scanner, go to the next step; 
otherwise, the following warning is displayed: 
 
 
 
 
 
 
 
 
 

4. You will then be presented with a screen from which you can 
choose the available configurations. 
Click on the filename of your choice and then click on the 
Next button. 
 
 
 
 

 It is STRONGLY recommended that you superboot your Scanner before restoring a Scanner’s configuration. 
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5. A window informing you of where the User Change Log will 
be stored is shown. 
Click Next to continue, or use the Setup button to choose 
another location. 
 
 
 
 

 
 

6. ScanWin LITE warns you that once started, the restoration 
process CANNOT be undone. 
Click Next to continue. 
 
 
 
 
 
 

 
7. A progress screen is shown as the configuration data is sent to 

the Scanner. A green check mark will appear as each segment 
is completed. 
Click Finish when the upload of data to the Scanner is done. 
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Chapter 4: FLOWRUN Data 
 

• Flowrun History Data (p86) 
• Assigning Inputs and Outputs (p90) 

Opening a Flowrun 
Before you can view flowrun data, you need to connect to a Scanner, either directly or remotely.   

To open a flowrun: 
1. Select File > Open (or press the F2 key) to display the 

Scanner Connection dialog box.  Or, click on the  
icon in the toolbar (see page 32). 

2. Locate the Scanner for which you want to display the 
history data. 

3. Double-click the Scanner name. 
4. Click the Flowrun tab to display the Flowrun 

History Data window. 
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Refer to the next section - 
Total Reset Assignment. 

Flowrun History Data 
ScanWin LITE allows you to access these flowrun data and settings from a Scanner in the field: 
• Rates and Totals 
• Live Inputs 
• Parameters 
• Gas Composition 
• Calculated Values and 
• Configuration    
 

Rates and Totals 
To view rates and totals: 
1. Open a flowrun.  For information about opening a flowrun, see Opening a Flowrun, page 85. 
2. Click the Rates and Totals tab to display the Rates/Totals page. 

Values from the database appear in blue italics; values from the Scanner appear as black text.  See 
Chapter 2: Colors Used in ScanWin LITE (page 36) for an explanation of the colors. 

3. If required, select a unit from the drop-down list associated with a value. This new unit overrides the 
display units in the Scanner for this viewing only.  As soon as you leave this session, the values default 
back to the units set in the Scanner.  
 
 
 
 
 
 

To view these values, you must be connected remotely or directly to the Scanner.  
These values are continually updated as new data are received. 
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Total Reset Assignment 
Resetting of some accumulating totals via a Status Input is possible with this feature. Acceptable totals are 
indicated by a green triangle in the lower right corner (see above) of the cell.  DAILY HISTORY totals are 
not impacted by the use of this reset. 
Double-clicking on an eligible cell displays this dialog. 
To disable this feature, choose the None tab and click OK. 
To reenable this rest feature, fill out the values (refer to 
the Status Input Setup section (page 122) and click OK. 
It is recommended that the Logic be set to Inverted and 
the Width be Enabled (~100 ms). 
 
 
 

Live Inputs 
To view live inputs: 
1. Open a flowrun.  For information about opening a flowrun, see Opening a Flowrun (page 85). 
2. Click the Live Inputs tab to display the 

Live Inputs page.  
3. If required, select a unit from the drop-

down list associated with a value. This new 
unit overrides the display units in the 
Scanner for this viewing only. As soon as 
you leave this session, the values default 
back to the units set in the Scanner.  
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Parameters 
To view flowrun parameters: 
1. Open a flowrun.  For information about opening a flowrun, see Opening a Flowrun (page 85). 
2. Click the Parameters tab to display the 

Parameters page.  
See Chapter 2: Colors Used in ScanWin 
LITE (page 36) for an explanation of the 
colors. 

3. If required, select a unit from the drop-
down list associated with a value. This new 
unit overrides the display units in the 
Scanner for this viewing only. As soon as 
you leave this session, the values default 
back to the units set in the Scanner.  
 
 
 

Gas Composition 
To view gas composition: 
1. Open a flowrun.  For information about opening a flowrun, see Opening a Flowrun (page 85). 
2. Click the Gas Composition tab to display 

the Gas Composition page.  
For information about changing the gas 
composition, refer to the Change Gas 
Composition section (page 54). 
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Calculated Values 
To view flowrun calculated values: 
1. Open a flowrun.  For information about opening a flowrun, see Opening a Flowrun (page 85). 
2. Click the Calculated tab to display the 

Calculated Values page.  
3. If required, select a unit from the drop-

down list associated with a value. This new 
unit overrides the display units in the 
Scanner for this viewing only. As soon as 
you leave this session, the values default 
back to the units set in the Scanner.  
 
 
 
 
 
 

Configuration 
To view flowrun configuration data: 
1. Open a flowrun.  For information about opening a flowrun, see Opening a Flowrun (page 85). 
2. Click the Configuration tab to display the 

Configuration page. 
 
 
 
 
 
 
 
 
 
 
  

See Chapter 10: NGas 4.X.X 
Configuration & Calculations or 
Chapter 11: IGas 4.X.X Configuration 
& Calculations or Chapter 12: NFLO 
4.X.X Configuration & Calculations 
 for details. 
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Double-clicking on a cell in this 
column (Source) allows you to edit 
the source window. 

Assigning Inputs, Outputs and Alarms 
From the Flowrun tab, flowrun inputs, flowrun outputs (page 95) and alarm outputs (page 99) can be assigned. 
It is possible to assign outputs from the following flowrun tabs: 
• Rates and Totals 
• Live Inputs 
• Parameters 
• Gas Composition 
• Calculated Values 
 
Refer to Chapter 6 for Assigning Multifunctional Resources (page 121). 

Assigning Flowrun Inputs 
1. Click the Flowrun tab. 
2. Click the Live Inputs tab to display 

the Live Inputs page. 
3. Select the input that you want to 

assign.  
 
 
 
 
 
 
 

4. The following information is displayed for the Live Inputs tab: 
This column… Displays the… 
Name The long and short name or description used by the application. 
Value Numeric value for the input.  This can be a maximum of 15 digits.  * or similar symbol 

indicates a value is not live (fixed or default) 
Units Units of measurement for the input.  Units can be selected for viewing, but are not saved 
User Text User entered text you want  for the input. 
Source The resource or terminals that the input is connected to. 
Destination  The outputs assigned to a variable. 
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Clicking the icon shows the current calibration values for 
this device.  See Step 5. 

Assigning Analog Inputs 
1. Click the Live Inputs tab. 
2. Double-click the Source to edit the input source.  

ScanWin LITE displays the Edit Source window. 
3. Click the tab for the type of input (analog). 

 
 
 
 
 
 
 

4. Edit the following information as required: 
In this field… Enter the… 
Resource Slot in the Scanner.  For single-board Scanners like the Scanner 1130, the main board is 

always Slot A with expansion cards in Slot B and Slot C. 
User Text Text to be associated with this resource (maximum of 8 characters). 
Category Type of  input 

• Analog input type can be:  
• differential pressure  
• static pressure 
• temperature 
• density 
• mass heating value 
• volume heating value  
• percent  nitrogen, carbon dioxide or methane 
• volume rate 
• mass rate 
• fixed input 

Units Measurement units for display. 
Zero Transmitter (transducer) zero value that corresponds to a 4 mA or 1 Vdc input. 
Full Scale Transmitter (transducer) full-scale value that corresponds to a 20 mA or 5 Vdc input. 
Cutoff (Differential 
Pressure) 

Cutoff value for differential pressure inputs.  When the live input falls below the cutoff 
point, zero is sent to the flowrun calculations for flow extension and flow rate instead of 
the live value.  This is usually set to 0.5 to 2 percent of full scale to prevent false 
calculations. 

InPut Mode Input Mode is defaulted to standard until a calibration is performed then it is changed to 
“calibrated”. 
• Standard 
• Calibrated (No SP) 
• Calibrated 

Default Value Value that is sent to the flowrun in place of a live value when the live input goes out of 
range (auto default mode) or default mode is on. 
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In this field… Enter the… 
Default Mode Default mode.  This can be:  

• Disabled 
• Auto 
• On 

5. Click the Calibration icon    in the upper right corner of the 
window to get general information about the device. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

6. Clicking on the Calibration tab gives more information about the 
device, including calibration point information. 

7. Click Ok to return to the Live Inputs page. 
8. In a similar manner, calibration data on this resource may be checked 

by clicking on the Verification tab. 
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Clicking the icon shows the current calibration values for 
this device. 

Assigning Pulse inputs 
1. Click the Live Inputs tab 
2. Double-click the Source to edit the input source.  

ScanWin LITE displays the Edit Source window:   
 
 
 
 
 
 
 
 

3. Edit the following fields as required: 
In this field… Enter the… 
Resource Slot in the Scanner.  For single-board Scanners like the Scanner 1130, the main board is 

always Slot A with expansion cards in Slot B and Slot C. 
User Text Text you want associated with this input (maximum 8 characters). 
Category Type of  input 

• Volume rate 
• Mass rate  

Units Measurement units for display. 
K-factor Current K-factor in use, in pulses/unit volume.  If number of calibration points is greater than 

one, the K-factor is based on the multipoint calibration.  If a calibration point is one, the K-
factor is an entered value.  

M-factor Meter factor or Scaling factor (usually 1) that adjusts the input device calibration without 
changing the K-factor (pulses/unit factor).  E.g. M-factor of 0.5 would cut the uncorrected 
flow rate in half. 

Frequency Raw input frequency in Hertz (Hz).  The hardware sets a limit on the minimum frequency that 
can be displayed.  Note the flowrun calculations are based on the pulse count, not the 
frequency. 

4. Click Ok to return to the Live Inputs page. 
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Assigning RTD Inputs 
1. Click the Live Inputs tab. 
2. Double-click the Source or Temperature to edit the 

input source.  ScanWin LITE displays the Edit Source 
window.  
Clicking icon in the upper right corner of window 
shows the current calibration values for this device.  
See Steps 5 and 6 of Assigning Analog Inputs, page 
91. 
 
 
 
 

3. Edit the following fields as required: 
In this field… Enter the… 
Resource Slot in the Scanner.  For single-board Scanners like the Scanner 1130, the main board is 

always Slot A with expansion cards in Slot B and Slot C. 
User Text Text you want to be associated with this resource (maximum of 8 characters). 
Category Type of  input 

• RTD input type is for temperature 
Units Measurement units for display. 
Zero Zero temperature (default is –50°F or -45.556°C) 
Full Scale Full Scale temperature, default and user entered values maximum depend on Model of Scanner 
InPut Mode Input Mode is defaulted to 0.00385 (DIN) until a calibration is performed then it is changed to 

calibrated. 
• DIN 0.00385  
• SAMA 0.003902  
• Calibrated 
• DIN+Shift 0.00385 
• SAMA+Shift 0.003902 

Default Value Value to be sent to flowrun if the live input goes out of range or if the Default Mode is set to 
ON.  Out-of-range limits for the 4-20 mA signal are 2% below zero (3.68 mA or 0.92 volts) 
and 3% above full scale (20.48 mA or 5.12 volts.) 

Default Mode Default Mode of DISABLED, AUTO or ON.  When ON, the default value is sent to the 
flowrun regardless of the live input value (useful for forcing an input to a known state, testing 
calculations, etc.).  In the AUTO mode, the live value input is sent to the flowrun unless it goes 
out of range (-2.0% and +3.0%), in which case the default value is substituted.  When 
DISABLED, the default value is never used and the flowrun will receive invalid readings if 
the transmitter goes out of range. 

4. Click OK to return to Live Inputs page. 
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see Step 3 see Step 4 

Assigning Fixed Inputs 
1. Click the Live Inputs tab. 
2. Double-click the Source to edit the input source.  

ScanWin LITE displays the Edit Source window: 
3. Select the Fixed  tab.  

 
 
 
 
 
 
 

4. Enter the desired value for the fixed input and click 
Ok. 

 
 
 
 
 
 
 
 

Assigning Flowrun Outputs 
1. Click the Flowrun tab. 
2. Click the Live Input tab to display 

the Live Input page. 
See Assigning Multifunctional 
Resources, page 121 for details. 

3. Select the flowrun variable to be 
assigned to an output. 

4. Click on the  button in the 
Destination section to display the 
Edit Destination dialog.  Depending 
on the installed devices in your 
Scanner, the following selections may 
be available to you: a) Output to 
Local Display; b) Analog output; c) 
Pulse output; d) Alarm output;  
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Clicking the icon allows you to calibrate an analog 
output device. 

Assigning Local Display Outputs 
1. In the Add Destination or Edit Details window, click the Display tab to add an output or edit an existing 

output. 
 
 
 
 
 
 
 
 

2. Edit the following information as required: 
In this field… Enter the… 
Item Text Text you want associated with this alarm (maximum of 8 characters). 
Units Measurement units for display. 

3. Click Ok to return to the Flowrun page. 
 

Assigning Analog Outputs 
1. In the Add Destination or Edit Details window, click the Analog Output tab to add an output or edit an 

existing output. 
 
 
 
 
 
 
 
 

After the Analog Output is assigned and configured, 
the flowrun must be changed to Stopped, then to 
Running OR reset the Scanner in order for it to begin 
working. 
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2. Edit the following information as required: 
In this field… Enter the… 
Resource Slot in the Scanner.  For single-board Scanners like the Scanner 1130, the main board is 

always in Slot A with expansion cards in Slot B and Slot C. 
User Text Name of alarm output, 12 characters maximum 
Category Analog output type:  

• None 
• Differential Pressure  
• Static Pressure (gauge) 
• Temperature 
• Density 
• Mass Heating Value 
• Volume Heating Value 
• % Nitrogen,  
• % Carbon Dioxide 
• % Methane 
• Percent 
• Volume rate 
• Mass Rate 

Units Measurement units for display. 
Zero Zero value that produces a 4 mA or 1 Vdc output. 
Full Scale Full scale value that produces a 20 mA or 5 Vdc output. 
Output Mode Select 4-20 mA current or 1-5 Vdc voltage mode. 
Default Value Default value for the output when the default mode is ON. 
Default Mode DISABLED or ENABLED choice from the drop-down window. 

3. Click Ok to return to the Flowrun page. 
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Clear Buffer button clears the pulse output buffer.  This 
may be necessary if circumstances create a very large 
number of counts. e.g.  Setting Div Factor to zero puts 
an infinite number of counts into the buffer. 

Assigning Pulse Outputs 
1. In the Add Destination or Edit Details window, click 

the Pulse Output tab to add an output or edit an 
existing output. 
 
 
 
 
 
 
 
 
See Assigning Multifunctional Resources, page 121 for details about assigning a Pulse Output. 

2. Edit the following information as required: 
In this field… Enter the… 
Resource Slot in the Scanner.  For single-board Scanners like the Scanner 1130, the main board is 

always in Slot A with expansion cards in Slot B and Slot C. 
User Text Name assigned to this output (8 characters maximum). 
Category Pulse output type.  This can be: 

• Mass 
• Volume 
• Energy 
• Controller (if available) 
• No Type 

Div Factor Division factor used to adjust the pulse rate of the output.  A Div. Factor of 10 results in 1 
pulse transmitted for every 10 counts received from the flowrun.  A fractional Div. Factor will 
speed up the count rate. 

Logic Logical action of the pulse output (either Normal or Inverted). 
Status Status of the pulse output (DISABLED or ENABLED).  When Disabled, pulses are not 

transmitted, but are saved in the buffer until the pulse output is again enabled.  This allows an 
output device to be removed and later replaced without any loss of output data. 

Pulse Width3 Value of the minimum pulse width to be detected.  This may be set to 8, 16, 32, 64, 100, 200, 
400, 800, 1000, 2000, 5000 or 10000 msec.  (Note: 8 and 16 msec settings are available only 
on the Scanner 1140 .) 

Pulse Number The number of pulses to be outputted. 

3. Click Ok to return to the Flowrun page. 

                                                      
3 Scanner 1140 pulse outputs are performed either automatically by the FPGA or manually by the CPU.  If the pulse width is 
less than or equal to 64 msec, then the automatic mode is used.  If it is higher than 64 msec, then the CPU must manually 
toggle the pulse output, which can use up power if you have a lot of pulsing to do.  It is recommended lowering this value to 
64 msec. 
Note that Scanner 1131 supports automatic pulsing for pulse widths up to 1600 msec. 
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Assigning Alarm Outputs 
1. In the Add Destination or Edit Details window, click the Alarm Output tab to add an output or edit an 

existing output. 
 
 
 
 
 
 
 
 

2. Edit the following information as required: 
In this field… Enter the… 
Alarm Number of the alarm (a maximum of 16 alarms may be assigned by the user). 
User Text Text you want associated with this alarm (maximum of 8 characters). 
State Alarm output type.  This can be 

• Off 
• On (Too Low) 
• On (Too High) 
• Undefined 

Units Measurement units for display. 
Low Limit Value for the lower limit of the normal range.  If the value drops below this limit, an alarm is 

triggered.  
High Limit Value for the upper limit of the normal range.  If this value is exceeded, an alarm is triggered. 
Deadband Deadband value for the alarm range. 
Activation Delay Time before alarm is triggered after the limits have been exceeded. 
Latching Click box if you want alarm to be latched (alarm will require acknowledgment before it can 

be removed). 
Callout Click box if you want the alarm to trigger a callout via the communication port. 
Assign to Status 
Output 

Click this check box if you want to send the output to a status output. 

3. Click Ok to return to the Flowrun page. 

Assigning Outputs to Accessories 
 
In the Edit Details table, click the desired accessory tab to assign a flowrun variable to an Accessory (Data 
Log, Combiner or Controller). 
Viewing, editing, or deleting accessories is not possible from the destination table. 
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Checking this box is only used to control the display 
of pulse parameters.  Removing the check mark does 
not turn the pulses OFF. 

Assigning Status Outputs 
1. In the Add Destination or Edit Details window, click the Status Output tab to add an output or edit an 

existing output. 
See Assigning Multifunctional Resources, page 121 
for details about assigning a Status Output resource. 
 
 
 
 
 
 

2. Edit the following information as required: 
In this field… Enter the… 
Resource Slot in the Scanner.  For single-board Scanners like the Scanner 1130, the main board is 

always in Slot A with expansion cards in Slot B and Slot C. 
User Text Text you want to associate with this resource (a maximum of 8 characters). 
Logic4 Logical action of the output (NORMAL =1 or INVERTED =0).  Note that if the logic is 

changed while in a MANUAL mode and an OFF state, the modification will be saved but 
the result will not be displayed immediately. 

Output Mode4 Status of the output.  In LIVE =1 mode, the state of the output is controlled by alarm 
conditions in the variable(s) assigned to the output.  In MANUAL =0 mode, the state of the 
output can be set by the user. 

Output State4 ON =nonzero value or OFF =0 state of the output.  See note below for changing the 
following shaded settings: 

Width Pulse width in 100-millisecond increments.  Maximum value is 2147483647 milliseconds. 
Delay Time, in 100-millisecond increments, between pulses.  Maximum value is 2147483647 

milliseconds.  A value of 0 disables the delay function. 
# of Pulses Number of pulses that are output when status is turned on  (1 to 65535).  Or, check the 

Continuous box to turn on continuous pulsing.  

Note:  Manual Output must be set to OFF to change these values.   
• Set Manual Output to OFF and click Ok.   
• Reopen dialog and change values.  Click Ok. 
• Reopen dialog and set Manual Output to ON.  Click Ok.   

3. Click Ok to return to the Flowrun page. 

                                                      
4 number in =n represents value used by EFM/RTU for communication protocols (e.g. ScanCom and Modbus) 
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Procedures to Change Status Output Parameters 
 
 
 
 
These procedures should be followed to change the status output configurations for: 
• Status Output parameters of “Width”, “Delay” and “# of Pulses”. 
• Output Status from “Live” to “Manual”  

With Status Output in Live Mode 
As a general rule, when the Status Output is Live and assigned to a User Alarm, parameter changes are 
effective at the next alarm.   
1. When the User Alarm is in the OFF state, the Status Output will also be OFF.   

• Click the Hardware tab and double-click the Status Output to be changed. 
• When the Edit Details for Status Output dialog appears, change the parameters and then click OK. 
Note: The changes made to the Status Output parameters will take effect the next time the alarm is 

turned ON. 
2. When the User Alarm is in the ON state, with pulsing enabled (value of "Width" is greater zero), and a 

change to the Status Output parameters is required: 
• Change the User Alarm to the OFF state and follow the steps in No. 1 above. 

3. When the User Alarm is in the ON state, and immediate changes to the Status Output are required: 
• Click the Hardware tab and double-click the Status Output to be changed. 
• When the Edit Details for Status Output dialog appears, change the parameters and then click OK. 
• Select the Alarms tab and then click the Clear Alarms button. 
Note: The alarm state will be reset and restarted.  The changes will be implemented upon restart. 

4. When the User Alarm is in the ON state and a change from LIVE mode to MANUAL mode is desired: 
• Click the Hardware tab and double-click the Status Output to be changed. 
• From the drop-down list in the Output Mode box, select Manual.  The Output State box will 

appear with an On or Off value.  Click the OK button for ScanWin LITE to set the manual mode. 
• Double-click the same Status Output on the Hardware page again.  When the Edit Details for Status 

Output dialog appears, the value of the Manual Output State may not be the same as that of the 
Scanner EFM/RTU.  Toggle the selection and click OK to close the dialog box. 

• Again, double-click the Status Output.  Then, once again, toggle the Manual Output State and click 
the OK button.  Now the Status Output of the Scanner EFM/RTU will be the same as ScanWin LITE. 

• IF the Output State was in the ON state (from the previous step), reopen the Edit Details for Status 
Output dialog and set the Output State to OFF.  If the Output State was already OFF in the previous 
step, skip this step.. 

• Finally, double-click on the same Status Output, and make the desired changes to the Width, Delay 
and # of Pulses.  Click OK to send the new parameters to the Scanner. 

 These procedures apply ONLY to versions of ScanWin older than version B2.2.6W and to firmware 
versions 4.0.0 through 4.3.0. 
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To change from Manual to Live mode: 
• Open the Edit Details for Status Output dialog and change the Output Mode to LIVE.  If the User 

Alarm is in the ON state, the new pulse operation will be effective immediately.  Otherwise, the 
change will occur the next time the alarm is turned ON. 

With Status Output in Manual Mode 
Generally, the Manual Output must be OFF before changing the Status Output parameters.   
Thus, the following steps are required:  
1. Click the Hardware tab and double-click the Status Output to be changed. 
2. When the Edit Details for Status Output dialog opens, check the Output State when in Manual mode. 

• If it is OFF, go immediately to Step 3.  If the Output State is ON, set it to OFF and click the Ok 
button. 

3. Open the Edit Details for Status Output dialog again as explained in Step 1. 
• Change the Width, Delay and # of Pulses parameters as required and click the Ok button. 

4. Open the Edit Details for Status Output dialog and change the Output State to ON.  Click the Ok 
button. 

Analog Output Calibration 
An analog output calibration (and verification) is possible only from the page on which analog outputs are 
assigned or edited (see preceding section).   

Preparation 
1. Connect a current measuring device (e.g. Promac or DVM) in the output loop by connecting it in series 

with the wired loop or, if not wired, by connecting Vtx, on ASO1 pins 1, 2 or 3 to ASO1 pins 10, 12 or 
14. 

2. Connect the meter (+) from ASO1 pins 11, 13 or 15.  
3. Return the meter (–) to an available ground (GND) on the 1130 motherboard. 

Calibration 

1. To calibrate an analog output device, click on the  icon.  The 
Select End Device screen is displayed: 
Click on the line containing the device to be calibrated. Selected 
outputs will show a green arrow.  Then click on the Next button. 
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2. When prompted to select the operation to be performed, make sure 
Calibration is indicated and click the Next button. 
 
 
 
 
 
 
 

3. A window like the one on the right is displayed for High Point 
Calibration. 
The current for the channel should go to ~20 mA. Set the slider for an 
appropriate jump size. Use the UP or DOWN arrows to make the 
current meter read 20.0 mA. When you have done so, press Next. 
 
 
 
 
 
 

4. A window like the one on the right is displayed for Low Point 
Calibration. 
 
Use the UP and DOWN arrow keys to make the current meter read 4.0 
mA.  Repeat the High and Low Point calibrations until both are giving 
the correct readings.  When you have done so, press Next.  
 
 
 
 
 

5. The screen to end the process is then shown. Click Finish to end the 
calibration. 
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Verification 
1. Repeat Steps 1 and 2 of the Calibration (page 102) process in the last 

section.   
In Step 2 (previous section), indicate that you wish to do Verification 
and click Next. 
 
 
 
 
 
 
 

2. The screen on the right is displayed: 
Make certain that Verify Current is selected and click the Next button. 
 
 
 
 
 
 
 

 
3. You are then asked to input a current to send to the meter. 

Click Send and this amount should register on the meter. If it is not 
the same, your calibration process should be repeated. Otherwise, 
click Next to end the verification process. 
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Chapter 5: SYSTEM 
 

• Node Information (p105) 
• Local Display (p110) 
• Setting the Clock (p112) 
• Login Management (p113) 
• Exceptions (115p) 
• Memory Status (p118) 
 
From the System tab (top) you are able to view and make changes to the Node Information, Local Display, 
Clock, Login Management, Exceptions and Memory Status.  These are accessed by clicking on the respective 
tabs on the right side of the System Node Information screen. 

Node Information 
Node information is used to identify the Scanner in history logs, reports, etc.  Information about the software, 
such as the version, and serial numbers should be recorded. 

To view and/or change the Node information: 
1. Click on the System tab first. 
2. Then click the Node Information tab 

on the right side to display this page. 
 
 
 
 
 
 
 
 
 
 
 
 
Note:  Most changes to the information in this window must be made through the Scanner Setup (page 

79) wizard found in the Setup tab. 
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3. Examine the following information. If a green triangle appears in the corner of the Value field, the value 
in that field can be changed from that screen. Values in other fields may be changed through the Scanner 
Setup tab (see Chapter 3). 
 
 
 
This field… Refers to the… 
Unit Node Name Name assigned to the Scanner. 
Scanner Model Number Series number from the Scanner Family of measurement RTUs. 
Software Version Software version the Scanner is currently using. 
Unit Serial Number Manufacturing number found on the ID tag on the outer case of the Scanner.  Non-

Barton products may or may not have an equivalent number.  
Board ID Number Manufacturing number assigned to the motherboard of the Scanner.  First 4 digits 

refer to the date of manufacture. 
Station Number (TCPL) First 4 digits of a numerical node name. 
Gas Day Hour Gas day for reporting volumes.  E.g. a typical gas day hour of 8:00 for April 1 goes 

from 8:00 a.m. April 1 to 7:59 a.m. April 2.  A value of 0:00 – 23:00 may be used. 
Number of Flowruns Number of flowruns associated with the Scanner. 
Power Supply Type5 Type of power supply used.  This is selectable as 6v, 12v or No Battery by the user 

during the Scanner Setup (page 79). 
Input Battery Voltage Battery voltage of the Scanner, for RTUs with charge controller and an integral 

battery).  For Scanner 1130 or 1131 RTUs using a dc power supply option (with no 
charge controller /integral battery) this is the external supply voltage to the RTU. 

Battery Charging 
Voltage 

External supply voltage to the Charge Control board (including Scanner 1140G).  
Typically the external supply voltage is from a solar panel.  For Scanners that do not 
have an integral battery this value will be 0 (except for the 1140G, which has a 
capacitor in place of the battery) 

Battery Charging 
Current5 

Amount of amperes at which the battery is being charged.  Note that this is not 
available on all 1141 hardware. 

Power Supply Charger 
Status5 

State of the charging system that is installed.  May be reported as Disabled, Trickle, 
Bulk, Overcharge or Float.  Refer to the Scanner 1141 manual for more information. 

Low Battery Level Voltage at which a Low Battery Alarm is triggered.  The default on an 1140 flow 
measurement RTU is 6.1V and 11.5 for an 1130 unit.  Value is configurable. 

Low Battery Deadband Voltage difference above the Low Battery Level that must be achieved for a Low 
Battery Alarm to disappear. 

Low Battery Alarm 
Status 

Setting of the Low Battery Alarm - ON (green check mark) or OFF (red X). 

Low Battery Alarm 
Output 

Resource to which a Low Battery Alarm is assigned. 

ATOD System Voltage 
Reference 

Value of the internal voltage reference source for each flow computer. 

NVRAM Backup 
Battery Voltage 

Voltage of the NVRAM backup battery.  See  
NVRAM Lithium Battery Voltage below. 

Analog In / RTD Select 
[A15 – A17]5 

Hardware assignment for resources A15 to A17.  Selectable as RTD (A15) or 2 
Analogs (A16 and A17) during the Scanner Setup (page 79). 

Analog In / RTD Select 
[A18 – A20]5 

Hardware assignment for resources A18 to A20.  Selectable as RTD (A18) or 2 
Analogs (A19 and A20) during the Scanner Setup (page 79). 

  
  

                                                      
5 Shaded rows are applicable to the Scanner 1141 only. 

Note:   Node Name and Board ID are keys used by the database to append data to existing files. 
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This field… Refers to the… 
CFG Lockout Status Setting of the configuration lock switch: ON (green check mark) or OFF (red X).  

When ON, the RTU cannot be superbooted and the flowrun configuration cannot be 
changed. 

CFG Lockout Switch 
assignment  

Resource that is handling the lock switch.   

User Change Log Lock 
Status 

Setting of the user change log lock.  When ON (green check mark), the amount of 
user changes is limited (see page 118); when OFF (red X), the user change log wraps 
as it becomes filled, and causes the loss of data.  
Note:  This is writable only when the CFG Lockout Switch is unlocked in firmware 

version 4.1.3 and above. 
Last User Change 
Number 

Number of the last User Change record that is stored in the Scanner.  

Vtx Output Settling 
Time 

Settling time used in the Power Save Mode to establish how long a transmitter takes 
to send a stable reading after it is turned on.  Default is 100 ms. 

Ambient Temperature Temperature at which the unit is operating. 
Measurement Status 
Input #1 Assignment 

Resource to which a Status Warning input #1 is assigned. 

Measurement Status 
Input #2 Assignment 

Resource to which a Status Warning input #2 is assigned 

HW Range Alarm 
Configuration 

Options for these are Off, Show in Event Log, Show in Alarms Page and Events 
and Alarms. 

Flowrun Check Alarm 
Configuration 
System Alarm Status 

 
Setting of the System Alarm - ON (green check mark) or OFF (red X). 
Note:  This is ON when any alarm is active in the Alarms tab. 

System Alarm Output Resource to which the System Alarm output is assigned. 
Measurement Change 
Counter (TCPL) 

Number of changes made to any hardware resource user text (does not include other 
HW parameters - just text), a system node name, a flowrun name and to flowrun 
configurations made via PUTS (does not include changing data values, only the 
creation structure). 

Power Save Mode Use of FULL or LOW (power save mode) usage of battery power.  
Vtx output override All Banks on or None.  Scanners 1130 and 1131 also have Bank 1 and Bank 2. 

Note:  The Vtx terminal of the RTU provides power to end devices.  Scanners with 
these should have the Vtx output override set to ON so that it is always on.  
The Power Save Mode is set to LOW. 

Local RTC display mode The local real-time clock.  It displays the time in 12 (AM/PM) or 24-hour (ML) 
format. 

Local RTC day of week Day of the week. 
Certification Time/Date Certified Time/Date stamp. 
Power Supply Firmware 
Version6 

Version number of the firmware installed in the Scanner 1141 integral power supply 
module. 

 

                                                      
6 Shaded rows are applicable to the Scanner 1141 only. 
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Available in Firmware 4.1.4 and above. 

NVRAM Lithium Battery Voltage 
When measuring the NVRAM battery voltage 
with a voltmeter (this measurement can be 
performed with the battery in the holder while 
the Scanner is operating), the voltage will be 
0.3 to 0.7 volts higher than when it is measured 
by the firmware.  The value read by the 
Scanner firmware is the actual (backup) 
voltage applied to the NVRAM and PIC (for 
operation as an RTC) and includes the voltage 
drops from the Schottky diodes that are part of 
the intrinsic safe circuit. 
Note that with lithium batteries, the voltage 
drops off dramatically so there is never much 
“low voltage” warning.  The NVRAM battery 
voltage above 2.0 Vdc indicates the 
configuration is still backed up; a voltage of 
zero means that the battery is dead, not 
installed, or the jumper is missing. 
This warning will be given during the login operation if the battery 
voltage falls below the specified level (2.0 Vdc recommended).  
Refer to the Quick Start Settings dialog (page 38).   
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Applicable to firmware version 4.1.0 
and above 

Certification Time/Date 
The Certification Time/Date feature is used to insert a time/date signature on the Systems Node Information 
page.   
To do this procedure: 
1. Locate the row that contains the 

Certification Time/Date field. 
 
 
 
 
 
 
 
 
 
 
 

2. Double-click on the cell in the Value column.  This will result in the 
following window being displayed. 
In the Set Scanner Clock to area, click on Entered Value if you do not 
want to used the Computer Clock’s time and date.  If you do so, click on 
the value to be changed and use the up or down arrow keys to change to 
your new value.  When done, click on the OK button. 
 
 
 

3. If the Configuration Lock Switch is enabled, the 
following message will be displayed. 
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Refer to Step 3 (+) or Step 8 (-) for information about the 
use of these buttons. 

Note:  These pertain to the 
display on the SCANNER and not 
to what is shown in ScanWin. 

Local Display 
From the Local Display tab, you are able to view those items, including non-flowrun items, which have been set 
up to be displayed at the Scanner, add or remove items from this list, as well as configure the display output.  
Local Display items can also be added or removed from the Flowrun tab (see Assigning Local Display Outputs, 
page 96). 
Note:   By default, the Scanner display will show (a) the Node Name; (b) the Battery Voltage; (c) the 

Time/Date, and (d) the configuration for the serial ports. 

Changing the Local Display Settings 
1. Open the Local Display page as 

described on page 105. 
 
 
 
 
 
 
 
 
 
 
 
 

2. At the bottom of the window, enter the following information as required: 

In this field… Refers to the… 
Screen Timeout Length of time in seconds before the display goes blank when the keypad is unused.  Enter 0 

to disable the time-out feature. 
Auto Scroll Delay Time each parameter is displayed before scrolling to the next parameter (seconds). 
Display Type Type of display that is installed on the Scanner.  Types may be either Graphics, 4x20, 2x16 

or No Display. 
 

3. Click on the  button to add new items to the 
local display.  The window like the one on the 
right is displayed. 

4. From the left portion of the window, click on 
the item you wish to display.  Then click on the 

 button.  This results in the item being added 
to the right portion of the window.  To remove 
an item from the right window, click on it, and 
then click on the  button. 
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The number of decimal places for 
the Local Display on the Scanner 
Hardware can be assigned globally 
by entering the value in the box and 
clicking the Apply button to the right 
of it. 

5. After you have made your choices, 
click on the OK button.   
 
 
 
 
 
 
 
 
 

6. Double-clicking on a Name field (green triangle in 
lower right corner) opens the following Edit 
Destination for Item dataID window: 
You may now edit the Item Text or Units.  Click the 
OK button when done. 
 
 
 
 
 

7. The result is then displayed: 
 
 
 
 
 
 
 
 
 
 

8. To remove an item from the Local Display list, first click on the item; 
then click on the  button.  This window is displayed: 
Click on the Yes or No buttons. 
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Clock 
You can view the system clock to see what time (and date) the Scanner is using and change it if necessary. 

1. Click the right Clock tab of the 
System page to display the System 
Clock page. 
The Current Date and Time column 
shows the date and time that is 
currently stored in the Scanner. 
 
 
 
 
 
 
 

 
2. In the New Date and Time area, clicking on Computer Clock shows the date and time that is present in 

the computer’s memory.  Pressing the Update button will transfer this time and date to the Scanner. 
3. If you wish to enter a different time and/or date into the Scanner, select the Entered Value radio button.  

Then, click on Calendar to choose a different date or select the year, month or date.  Or, click on the 
value to be changed; then use the up or down arrows to change that value.  In a similar manner, the hours, 
minutes or seconds may be changed.  Press the Update button to send this new date or time to the 
Scanner. 
 
 
 

Note: The time is in a 24-hour format. 
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Login Management 
The Login Management display window is 
accessible only by the MANAGER.  Initially, 
the Level names and passwords are the same 
(MANAGER – MANAGER, USER1 – 
USER1, etc.).   
By clicking on the fields (shown with the 
green triangle in the upper right corner), the 
MANAGER can change level names and 
passwords.  Level names and passwords may 
each have a maximum of eight characters.  
 
 
 
 
 
 
 
 
 
 
 
If a user’s Access Level is set at No Access, the user will receive this message 
after logging in. 
 
 
 
If assigned as User2 with Read/Write access, the following message will appear at the time of connection to the 
Scanner: 
 
 
 

 
If a user is assigned Read Only access, the following message will appear at 
the time of connection to the Scanner: 
 

By default, User2 and User3 both have read/write access.  However, User2 is logged in at the Tech level (Technician has 
write access to the Routines and read access to everything else).  User3 has read/write access to everything except the 
Login ID’s and Passwords.  User1 and the Guest have read only access.   
The access level for each of these can be changed by the MANAGER to No Access, Read/Write or Read. 



ScanWin LITE   

114 February 2006  

 

When logged in at a level other than 
MANAGER, the System page will not 
display the Login Management tab: 
 
 
 
 
 
 
 
 
 

 
 

With the Configuration Lock Switch ON, both the following messages are displayed: 
(a)  when an attempt is made to make any flowrun modification  
 
 
 
and 
(b) if any effort is made to modify the User Change Log Lock Status from 

the Node Information tab of the System page. 
 
 
 
 
 
 
 
 

Note:  When the Configuration Lock Switch is ON, the MANAGER will have the same access as USER3. 
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Clicking this button creates an .htm file in the 
C:\barton\bdms\DATA\REPORTS\EXCEPT directory.  
See No. 4 of this section for a sample report. 

Exceptions 
If you are connected directly or remotely to a Scanner, the Exceptions tab provides you with information about 
the Scanner.    

1. Clicking on the Exceptions tab gives 
this display. 
Shown is the status of the flowruns 
plus a list of diagnostic exceptions or 
errors that have occurred.  Note that 
all active exceptions are shown in 
red.   
 
 
 

 
2. Clicking on the box in the upper left 

corner shows only the active 
exceptions. 
To clear all active exceptions, click 
the Clear Exceptions button.   
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3. The following is a list of the exceptions that may be displayed: 
Exception  Description 
Power Restart  Occurs when a power fail event is detected 
Watchdog Restart  A program failure or reset has occurred* 
Bad A/D Calibration A bad A/D zero or fullscale conversion was detected* 
Low Battery Alarm A low input voltage was detected by the system 
ROM Checksum A bad ROM checksum has been calculated* 
RAM Checksum A bad RAM checksum has been calculated* 
NVRAM Block Error A bad NVRAM block checksum has been found* 
EEPROM Checksum A Scanner or DPE EEPROM checksum was bad on startup* 
Out of Range A hardware input has gone out of range 
SW Fault A software fault was detected* 
DP Check A Differential Pressure check alarm has occurred 
Volume Check A Volume check alarm has occurred 
Mass Check A Mass check alarm has occurred 
Energy Check A Energy check alarm has occurred 
User Alarm 1 to 16 User defined flowrun/combiner alarm 

 
4. This is a sample of the report generated when you press the Print Report button: 

 
Scanner Exceptions Report 
===============================================
ScanWin  
 

Node Name : 1131DEM3 
Firmware : NFlo M4.3.4RaAb
Board ID Number : 00080866 
 
Created on: 11/08/2005 23:17  
===============================================

Exception  Count  
=========================================================== =======
Occurs when a power fail event is detected 0  
A program failure or reset has occurred 0  
A bad A/D zero or fullscale conversion was detected 0  
A low input voltage was detected by the system 0  
A bad ROM checksum has been calculated 0  
A bad RAM checksum has been calculated 0  
A bad NVRAM block checksum has been found 0  
A bad EEPROM checksum (Scanner/DPE/MVT) was found on startup 0  

                                                      
* These exceptions should not normally occur.  If they do, a hardware or software problem may exist.  Checking the event log 
will provide more detailed information. 



 Chapter 5: SYSTEM 

February 2006 117 

A hardware input has gone out of range 10  
A firmware fault was detected 0  
A Differential Pressure check alarm has occurred 0  
A Volume check alarm has occurred 1  
A Mass check alarm has occurred 0  
A Energy check alarm has occurred 1  
User defined flowrun alarm #1 4  
User defined flowrun alarm #2 0  
User defined flowrun alarm #3 0  
User defined flowrun alarm #4 0  
User defined flowrun alarm #5 0  
User defined flowrun alarm #6 0  
User defined flowrun alarm #7 0  
User defined flowrun alarm #8 0  
User defined flowrun alarm #9 0  
User defined flowrun alarm #10 0  
User defined flowrun alarm #11 0  
User defined flowrun alarm #12 0  
User defined flowrun alarm #13 0  
User defined flowrun alarm #14 0  
User defined flowrun alarm #15 0  
User defined flowrun alarm #16 0 
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When the user change log is full, Data Collection using Get Everything… 
From This EFM / RTU must be performed before parameter changes can 
be made. See the Setup dialog box on page 50. 

Memory Status 
If you are connected directly or remotely to a Scanner, the Memory Status tab provides you with information 
about the Scanner.   
Click on the Memory Status tab to determine how much memory (RAM and NVRAM) is both available and free 
in the Scanner.   
In addition, ScanWin LITE shows how much memory is available for the User Change Log.  Thus, you are able 
to gauge when it is necessary to perform a download.   
 
 
 
 
 
 
 
 
 

 
 
 

Memory Usage in Scanners 
The amount of RAM and NVRAM available depends upon the software and the hardware options installed in 
each Scanner.  This can be checked for each Scanner by looking at the Memory Status screen.   
A Scanner 1130 can have either 32K, 64K, 96K or 128K of NVRAM and either 32K or 64K of RAM.  
Depending on the firmware, the Scanner 1131 and the Scanner 1140 may have the following amounts of 
RAM. 

 
Firmware 1140 RAM 1131 RAM 
Versions 4.2.0 and below 32K / 64K 64K / 96K 
Versions 4.3.0 and above 64K / 96K 128K / 160K 

 
Below is the amount of memory available for Scanners 1130, 1131 and 1140 with the maximum amount of 
NVRAM and RAM stuffed.  (Note that NVRAM = Total Memory - RAM) 

 
1130 (64K RAM/128K NVRAM) 1131 (96K RAM/416K NVRAM) 1140 (64K RAM/192K NVRAM) 
TYPE FREE/TOTAL TYPE FREE/TOTAL TYPE FREE/TOTAL 
RAM16: XXXX/2423 RAM16: XXXX/3036 RAM16: XXXX/2420 
RAM128: XXXX/127 RAM128: XXXX/255 RAM128: XXXX/127 
NVRAM16: XXXX/1758 NVRAM16: XXXX/6983 NVRAM16: XXXX/1758 
NVRAM128: XXXX/746 NVRAM128: XXXX/2255 NVRAM128: XXXX/1249 
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Approximate memory usage for various accessories: Memory usage available for accessories is  
independent of the Scanner model  (1130, 1131 or 1140).  All numbers are in terms of memory blocks (which 
are either 16 or 128 bytes each and are displayed in the Memory Status screen).  To convert blocks to bytes, 
multiply the number of blocks by 16 or 128. All numbers are estimates, which are accurate to within about ± 
10%. 
 
 RAM 16 RAM 128 NVRAM 16 NVRAM 128 
Basic System Overhead7 ~810 ~80 ~280 ~150 
Creating Event Log 
Creating User Change Log 

Included in the basic system overhead 

Creating Flowrun Hourly History8 0 0 20 ((items * 4 + 15) * days * 
logsperday) / 120 

Creating Flowrun Daily History8 0 0 20 ((items * 4 + 15) * days) / 120 
Running AGA8(92) Detailed 
Flowrun 

65 18 0  0 

Running Manually Entered Flowrun 49 18 0 0 
Creating Data Logger 0 10 19 (items * days * logsperday) / 31 
Running Data Logger 0 10 0 0 
Adding Local Display Item 0 0 2 0 
Creating Combiner 0 0 8 0 
Running Combiner 0 0 0 0 
Creating Controller 4 0 18 0 
Running Controller 0 0 0 0 
Creating ScanCom Network 0 0 7 0 
Running ScanCom Network 341 28 0 0 
Creating Modbus Network 0 0 7 0 
Running Modbus Network 80 18 0 0 
Creating Enron Modbus Network 0 0 42 0 
Running Enron Modbus Network 80 0 0 0 
Running Modbus Gas 
Chromatograph 

195 12 45 0 

Running Alarm Callout 4 0 6 0 

 
 
 
 

                                                      
7 This depends upon the version of software installed and what accessories are in that software.  This is the amount of memory allocated to 
static accessories (i.e., those that don’t have to be created by the user such as the Gas Chromatograph, Local Display, etc.).  This can be 
accurately estimated by superbooting the Scanner and deleting all the default flowruns.  These numbers are more like a maximum. 
8 The '15' includes date-time, measurement status and flowtime. 



ScanWin LITE   

120 February 2006  

 
 



 

February 2006 121 

Chapter 6: HARDWARE 
 
ScanWin LITE gives users the ability to view all inputs and outputs, including resources on expansion boards. 
Assigning a hardware resource to a flowrun must be performed from the Flowrun tab.  For more details, 
refer to Chapter 4 – Assigning Inputs, Outputs and Alarms (page 90). 
 
Note: The Slot and Resource have been combined into one list box. 

Assignments Tab 
When the Hardware tab is opened, the 
resources being used in each flowrun are 
displayed. Check marks are used to indicate the 
assignments. 
 
 
 
 
 
 

Multifunctional Resource Types 
Multifunctional resources are resources that can be assigned 
as pulse outputs or status inputs/outputs. For example, the 
1130 Scanner has two multifunctional resources located at 
the A15 and the A16 slots.  In this case, they can be assigned 
as Pulse or Status Outputs. 

 
 
 
 
 

Assigning Multifunctional Resources 
1. Click on the Hardware tab.  Then select 

the Assignment tab (if necessary). 
On the 1131 Scanner, Resources A07 
through A12’s short tags are marked with 
a plus (+) sign to denote that they are 
multifunctional resources. 
In this example, the A07 through A12 
boxes in the Type column have green 
triangles in the upper left corners.  
These triangles indicate that each of these 

 Multifunctional resources can be assigned ONLY from the 
Hardware - Assignments page. 
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resources are unused and may be selected as either Pulse outputs or as Status inputs/outputs.  The triangle 
disappears when a resource is assigned. 
 
 

2. To assign a resource, click on the 
Type field of the resource you wish to 
assign. A pull-down arrow will appear 
to the right of the resource. 
 
 
 
 
 
  
 
 

3. Click on the resource type field a 
second time or click on the down 
arrow) to view the assignment options 
available.  
Click on the resource type of your 
choice. 
 
 
 
 
 
 
 
 

4. Double-clicking in the box allows you to configure the resource as an input.  Refer to Step 3 of the Status 
Input Setup section below. 

 

 

Status Input Setup 
Status inputs have the ability to count slow-going input pulses based on a minimum pulse width.  Note that 
Status Input is used for the following: 
• the CFG lockout switch assignment (on the Scanner 1130) 
• the Measurement Status input assignment (#1 and #2) 
• bi-directional flowrun (for flow direction indicator) 

 

Note:  See Assigning Inputs, Outputs and Alarms – (page 90) for details about assigning the 
resources.  
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1. Connect to a Scanner.  Click on the Hardware tab. 
2. To configure a status input, open the desired Status Input resource by double-clicking on the Status 

Input box.   
3. You will be presented with the following: 

 
 
 
 
 
 
 
 
 
 
 
 

Use the following as a guide for changing the settings: 
User Text User entered text  
Logic9 Logical action of the input (either Normal =1 or Inverted =0). 
State9 Displays the current state of the input (ON =1 or OFF =0). 
Threshold Threshold voltage (0, 2.0, 7.0, or 10.0 volts) or Contact 
Width The minimum pulse width to be detected from 400 msec up to 60000 (60 seconds). 
Count The number of pulses detected since the count was last cleared.  To clear the count, simply 

press the Zero count button. 

 
Click Ok when you are finished. 
 
 
 
 
 
 
The count and width parameters are accessible over ScanCom.  Please refer to ScanCom 3.42 ADEPT 
Implementation manual, Appendix D - Status Input (Resource Type 1) Parameters for further details. 
If the user text of a status input has text entered and there are no other users assigned to the status input, 
the event log will record when the status input changes state. Note that the status input is sampled once 
every 1/2 second or so. 
 

 
 

                                                      
9  number in =n represents value used by EFM/RTU for communication protocols (e.g. ScanCom and Modbus) 

Note: The pulse counting feature is active whenever the width parameter is set to a number other than zero.  
When it is active, it is a drain on the power/CPU of the Scanner (especially at low pulse widths).  It is 
recommended that the width be set to zero unless the pulse counting or switch detection of the pulse input 
is required. The user may have to reset the width after uploading an old configuration. 
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See the Unassigning Alarms section on 
the next page. 

Chapter 7: ALARMS 
 

System and Flowrun Alarms  
The Alarms tab allows you to view, clear, and define the output of system and flowrun alarms.  Hardware alarms 
become Active when a device goes out of range. Flowrun alarms can be configured to be user-acknowledging 
(latched) or self-acknowledging. Flowrun alarms can be set as latched in the Alarm Configuration accessed from 
the Flowrun > Add Destinations dialog.  

Viewing Alarms 
Click the Alarms tab to display this 
dialog. 
Note:  Alarms are indicated by the word 
“Active” in the second column. 
The alarms may be sorted on one of three 
criteria: 
• Active alarms first or 
• Flowrun alarms first or 
• System alarms first. 
 
 
 
 
 

 
There are up to 16 user-configured alarms and nine pre-configured alarms.   
The following table describes the pre-configured alarms that exist in ScanWin LITE. 
Alarm Description Notes 
Alarm Callout Status Set to latched+on if active alarms in alarm callout. 
Watchdog Alarm Set to latched+on if watchdog alarm in Alarm queue. 
Memory Alarm Set to latched+on if RAM/ROM/NVRAM alarm in Alarm queue. 
Low Battery Alarm Set to latched+on if low battery alarm in Alarm queue. 
Power On Alarm Set to latched+on if power on restart occurred. 
Check Alarm Set to latched+on if any flowrun check alarm in Alarm queue. 
Hardware Range Alarm Set if any hardware range alarm in Alarm queue. 
Measurement Status 1 Set to latched+on if measurement status in 1 is on. 
Measurement Status 2 Set to latched+on if measurement status in 2 is on. 
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Clearing Alarms 
Pressing the Clear Alarms button removes the Active indicator of an alarm.  If the Active status remains on, 
this is an indication that the setting causing the alarm remains in effect, or that the alarm is set for latching.  
Latched alarms require acknowledgment by the user before they can be removed. 

Unassigning Alarms 
A user alarm may be cleared from this page by first selecting the alarm in 
any of the fields in that line (refer to picture on page 125).  Then click the 
Unassign button on the right side of the window.  This warning is given. 
  
 
 
Click  Yes to remove the assignment. 
 
 
 
 
 
 
 
 
 
 
 
 
 

Output of Alarms 
The Setup button allows the user to specify whether alarms are 
displayed in the Events Log or the Networks Alarms.  Click the 
Setup button to display this box.  Then, check the appropriate boxes 
to indicate your choices, and click OK. 
 

 

 

 
 



 

February 2006 127 

Chapter 8: Communications Setup 
 

• Defining Devices (p128) 
• Defining Port Groups (p133) 
• Defining Ports (p135) 
• Defining a Family (p138) 
• Defining Scanners (p142) 

About Communications 
ScanWin LITE is a graphical interface between you and the hardware.  It allows you to   
• connect DIRECTLY to a single Scanner to (a) configure it; (b) view live values, and (c) collect historical 

data. The SCM Viewer, is included on the ScanWin LITE installation CD for viewing the historical data 
downloaed with ScanWin LITE. For instructions on using SCM Viewer, see the SCM Viewer manual.   

• connect REMOTELY, to different Scanners through a configured communication media (e.g. modem, radio, 
etc.).  You are able to perform all the functions of a direct connection, including analysis and troubleshooting.    
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Defining Devices 
Communication devices that are supported by ScanWin LITE include radios, modems, direct connections, and 
multi-drop line drivers.  

Adding a Device 
If your communications device is not listed in the Device Setup List shown below, you can add it by editing 
the attributes of another device and saving the setup under a new device name. 
To add a new device: 
1. Select Tools > Communications Setup to 

display the Communication Setup dialog 
box shown at right. 

2. Click the Devices tab to display the Devices 
Setup List. 

3. Click the name of the device that has 
attributes that are most similar to those of the 
new device. 
 
 
 
 
 
 
 
 
 
 

4. Click Add to display the Add New Device 
dialog box. 

5. Enter a name for the new device in the Device 
Setup Name field. 

6. Click Carrier Detect if the device is a modem.  
An X appears in the check box. 
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Modify the attributes as required: 
In this field… Enter the… 
Max Comm Rate Maximum baud rate that the modem can handle.  
Transmit Control Type of transmit control: 

• Select none for modems. 
• Select DTR to detect transmit and receive. 
• Select RTS to return transmit and receive.  Use this option for radios. 

Flow Control Type of flow control: 
• Select none when you use ScanWin LITE. 
• Select DTR to detect transmit and receive. 
• Select RTS to return transmit and receive.  Use this option for radios. 

Response Timeout Number of seconds that the host system will wait for a signal back response after an 
initialization string is sent to the modem.  This is usually 10 seconds. 

Initialization String Command sequence that the host sends to the modem at the Scanner to prepare it to 
communicate.  This command reconfigures the modem.  ScanWin LITE waits for an OK 
signal back (usually within 10 seconds).  

Response String Response string from the modem.  The host system must receive this before data 
transmission can begin.  The only response used is OK. 
If the OK is received, ScanWin LITE creates the Dial string using the unique telephone 
number for that Scanner.  
If the OK is not received, ScanWin LITE logs a time out error and the communications 
attempt is stopped. 

Response Timeout Number of seconds that the host system will wait to receive a connection response from 
the modem.  This is usually 90 seconds. 

Redial Limit Maximum number of times that the host will dial if the dialing fails.  If you enter 2, the 
host will dial 3 times. 

Redial Delay Number of seconds that the host will wait before attempting to redial.  This is usually 5 
seconds; the maximum setting is 60 seconds to avoid a time out in ScanWin LITE. 

Dialing String Command sequence used to make the telephone call to the Scanner.  If your 
communication system requires you to dial 9 before the number, include the 9 in the dial 
string, for example: 

$1 ATDT, $#$R does not have the 9. 
$1 ATDT9, $#$R has the 9 inserted. 

No Dial-tone String String you want returned if there is no dial tone.  This is usually NO DIAL TONE. 
Busy String String you want returned if there is a busy signal.  This is usually BUSY. 
No Carrier String String you want returned if the modem dialed but could not maintain a connection within 

the specified time limit.  This is usually NO CARRIER. 

7. Click OK. 
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Common Initialization Settings for Modems 
The following initialization settings apply only to dial-up modems. If the device is not a dial-up modem, 
leave the fields blank. 
This string…  Does this… 
Initialization String AT Precedes all modem commands. 
 SF Indicates what follows are variations from factory settings. 
 SC1 Turns the carrier detect light on the modem on and is useful for analyzing problems 
 SCO Sets the carrier detect light to on at all times 
 DT Indicates a dial tone modem. 
 DP Indicates a pulse or rotary telephone. 
 SD2 Allows the computer to hang up the modem using the DTR setting and a required 

code. 
Response String  OK or nothing. 
 EO Sends a command not to echo commands.  When a command is sent to the modem, it 

can be echoed back so the person can see what was typed.  This can cause ScanWin 
LITE problems so it is important to use this string. 

 V1 Requests verbose result codes to display as lines of text to make the feedback from the 
system user-friendlier for troubleshooting. 

 V0 Requests numeric result codes for troubleshooting. 
 &K0 Turns all flow control off.  This setting does not exist on all modems.  If available, use 

it. 
 &B1 Lists the serial port speed setting of the modem for ATI modems only.  This is the 

speed at which the modem actually connects to another modem. 
 $R Adds an Enter (end of message) code at the end of the initialization string.  This is a 

special code used by ScanWin LITE. 
 &Q0 Compresses data.  Do not use data compression. 

 
Special guidelines for setting up initialization strings include: 

• The host system must never answer automatically. 
• Do not use data compression. 
• Do not use flow control (either software or hardware). 
• Do not echo commands. 
Example:$R$1$CAT&F1EO$R 
Where  
$R = Enter 
$1 = Wait One Second 
$CAT = Clear Buffer 
&F1EO$R = Send Initialization Screen 
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Editing Device Attributes 
You can edit the attributes of your communications device. 
To edit device attributes: 
1. Select Tools > Communications Setup to 

display the Communication Setup dialog 
box. 

2. Click the Devices tab to display the Device 
Setup List. 

3. Click the device name for which you want 
to edit the attributes. 
 
 
 
 
 
 
 
 
 
 
 

4. Click Edit to display the Edit Device 
Setup dialog box. 

5. Modify the attributes as required. 
6. Click OK. 
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Deleting a Device 
If you no longer need a communications device that is listed in the Device Setup List, you can remove it. 
To delete a device: 
1. Select Tools > Communications Setup to 

display the Communication Setup dialog 
box. 

2. Click the Devices tab to display the 
Devices Setup List. 

3. Click the device name that you want to 
remove. 

4. Click Remove.  ScanWin LITE displays a 
dialog box asking you to confirm the 
deletion. 

5. Click Yes to remove the device. 
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Defining Port Groups 
You can define port groups to pool dial out modems together so that any port or modem attached to the same PC 
can call any Scanner.  This rule only applies to modems.  Line drivers, radios, and direct connections must have a 
specific port assigned to a specific Scanner and cannot pool ports together. 

Adding a Port Group 
You can add new port groups in the Port 
Groups page on the Communications Setup 
dialog. 
To add a new port group: 
1. Select Tools > Communications Setup to 

display the Communication Setup dialog 
box. 

2. Click the Port Groups tab to display the 
Port Group List: 
 
 
 
 
 
 
 
 
 
 

3. Click Add to display the Add New Port Group dialog box. 
4. Enter a name for the new port group in the Port Group 

Name field. 
5. Click OK. 
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Removing a Port Group 
You can remove port groups in the Port Groups page on the Communications Setup dialog. 
To delete a device: 
1. Select Tools > Communications Setup to 

display the Communication Setup dialog 
box. 

2. Click the Port Groups tab to display the Port 
Group List. 

3. Click the port group you want to remove. 
4. Click Remove. ScanWin LITE displays a 

dialog box asking you to confirm the deletion. 
5. Click Yes to remove the device. 
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Defining Ports 
After you have defined the port groups, you can configure ports in the Communications Setup dialog box.  On 
the Ports page, you can add a new port, modify an existing port, or remove a port. 

Adding a Port 
If your communications port is not listed in the Ports List, you can add it. 
To add a new port: 
1. Select Tools > Communications Setup to 

display the Communication Setup dialog 
box. 

2. Click the Ports tab to display the Port 
List. 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Click Add to display the Add New Port dialog box: 
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4. Enter the following information as required: 
In this field… Enter the… 
Workstation PC name on which ScanWin LITE is installed.  If more than one ScanWin LITE will be 

operating over the network at the same time, each must have a unique Workstation name.   
Port Number Serial port number (4 maximum) on the PC connected to the communications equipment.  
Port Group Name that identifies a pool of dial-out modems that allow any port or modem in that group 

that is attached to the same PC to call any Scanner. 
Device Setup Devices that are connected to the ports. 

5. Click Port Enabled to activate the port.  An X appears in the check box when the port is active. 
6. Click OK. 

Editing Port Attributes 
You can edit any port attributes in the Edit Port Setup. 
To edit port attributes: 
1. Select Tools > Communications Setup to 

display the Communication Setup dialog 
box. 

2. Click the Ports tab to display the Port 
List. 

3. Click the port name for which you want to 
edit the attributes. 
 
 
 
 
 
 
 
 
 
 
 

4. Click Edit to display the Edit Port dialog box. 
5. Modify the attributes as required. 
6. Click OK. 
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Removing a Port 
If you no longer need a communications port that is listed in the Port List, you can remove it. 
To remove a device: 
1. Select Tools > Communications Setup to 

display the Communication Setup dialog 
box. 

2. Click the Ports tab to display the Ports 
List. 

3. Click the port name that you want to 
remove. 

4. Click Remove. ScanWin LITE displays a 
dialog box asking you to confirm the 
deletion. 

5. Click Yes to remove the port. 
 
 
 
 
 
 
 
 
 
 



ScanWin LITE   

138 February 2006  

Defining a Family 
A family is a group of Scanners that can be broadcast at the same time using a single communications link over a 
broadcast radio system or a multi-drop network.  A single telephone number connected to a single Scanner is also 
considered a family. 

Adding a Family 
You can add a family in the Families page of the Communication Setup dialog. 
To add a new device: 
1. Select Tools > Communications Setup to 

display the Communication Setup dialog 
box. 

2. Click the Families tab to display the 
Family List: 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Click Add to display the Add New 
Family dialog box. 

4. Enter a name for the new family in the 
Family Name field. 
 
 
 
 
Note: Family _DIRECT_ is used for 

direct connection. DO NOT 
DELETE!  See the Connection 
Configuration (page 31) dialog 
at startup. 
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5. Enter the following information as required and then click OK. 
In this field… Enter the… 
Modem Phone Number Telephone number for the Scanner including any special dialing conventions, such 

as 9 for an outside line. 
Modem Initialization String Initialization string used to initialize the modem. 
Port Group Name of the port group so there is no restriction on which port must be used to 

complete the communications link. 
Baud Rate Exact speed that will be used to communicate with the Scanner rather than the 

maximum potential speed of the host modem. 
Stop Bits Stop bits.  This should always be set to 1. 
Parity Parity.  This should always be set to None. 
SYN Character Do not change this unless advised by a NuFlo technician.  SYN Character is the 

hex character at the start of a packet of data. 
ETB Character Do not change this unless advised by a NuFlo technician.  ETB Character is the 

hex character at the end of a packet of data. 
Block Type Do not change this unless advised by a NuFlo technician.  Block Type indicates 

the size of the packet. 
Network Device ID Do not change this unless advised by a NuFlo technician.  Network Device ID sets 

the network and device for transmission. 
Application Device ID Do not change this unless advised by a NuFlo technician.  Application Device ID 

sets the application and device for transmission. 
Inactivity Timeout Number of seconds that ScanWin LITE waits for a response from the Scanner.  

The setting should never be less than 5000 and never greater than 20,000.  This 
number should be increased only if repeater delays or satellite delays require it. 

Retry Limit Number of times that ScanWin LITE should try to connect.  If the retry limit is 
reached, the client application is notified and another reconnection attempt occurs 
after the specified number of seconds.  

Reconnect Number of retries.  If there is no response from the Scanner, ScanWin LITE 
advises all client applications of the failure and automatically makes the indicated 
number of retries. 

Transmit Delay Delay period between receipt of a response from the Scanner and sending the next 
command.  This value is always zero for a modem and greater than zero if you 
have a radio repeater system.  Systems that can only communicate one direction at 
a time cannot switch instantly from receive to transmit mode. 

RR Poll Delay Delay period that indicates how long ScanWin LITE will keep the network open 
and waiting for a response before it communicates again.  If this setting is too fast, 
the Scanner will constantly be polled and likely get busy signals.  An ideal setting 
is usually 500 - 1000 milliseconds. 

RTS On Delay Delay period that indicates how long it takes the radio transmitter to be turned on.  
This setting is only used with radio systems.  Radio systems require a delay after 
the radio is keyed and before data is sent and again after the data is sent. 

RTS Off Delay Delay period that indicates how long it takes the radio transmitter to be turned off.  
This setting is never used for modems, only for radio systems and is typically set 
for 15 milliseconds.  
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Editing a Family 
You can edit the family attributes in the Families page of the Communications Setup dialog. 
To edit family attributes: 
1. Select Tools > Communications Setup to 

display the Communication Setup dialog 
box. 

2. Click the Families tab to display the Family 
List. 

3. Click the family name for which you want to 
edit the attributes. 
 
 
 
 
 
 
 
 
 
 

4. Click Edit to display the Edit Family Setup 
dialog box. 

5. Modify the attributes as required: 
6. Click OK. 
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Deleting a Family 
You can remove a family in the Families page of the Communications Setup dialog. 
To delete a family: 
1. Select Tools > Communications Setup to 

display the Communication Setup dialog 
box. 

2. Click the Families tab to display the Family 
List. 

3. Click the family name that you want to 
remove. 

4. Click Remove. ScanWin LITE displays a 
dialog box asking you to confirm the deletion. 

5. Click Yes to remove the family. 
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Defining Scanners 
ScanWin LITE allows you to assign Scanners to a family by adding a Scanner to the Scanner List in the 
Communications Setup dialog. 

Adding a Scanner 
You can add a Scanner to a family in the Families page of the Communications Setup dialog. 
To add a new Scanner: 
1. Select Tools > Communications Setup to 

display the Communication Setup dialog 
box. 

2. Click the Families tab to display the Scanner 
List: 
 
 
 
 
 
 
 
 
 
 
 
 

3. Click Add at the bottom of the Scanner List to display the 
Add New Scanner dialog box. 

4. Enter a name for the new Scanner in the Node Name field. 
5. Select the family name to which you want to add the 

Scanner from the Family Name drop-down list. 
6. Enter a number for the DLC drop (default=1).  This must 

be the same DLC specified in the Scanner settings.  This 
number is critical if there is more than one Scanner 
assigned to a family as this number defines each Scanner 
uniquely.  

7. Click OK. 
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Editing Scanner Attributes 
You can edit the Scanner attributes in the Families page of the Communications Setup dialog 
To edit Scanner attributes: 
1. Select Tools > Communications Setup to 

display the Communication Setup dialog 
box. 

2. Click the Families tab to display the Scanner 
List. 

3. Click the name of the Scanner for which you 
want to edit the attributes. 
 
 
 
 
 
 
 
 
 
 

4. Click Edit to display the Edit Scanner Setup dialog box. 
5. Modify the attributes as required. 
6. Click OK. 
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Chapter 9: Scanner Theory 
 

• Techniques (p147) 
• Analog Calibration (p153) 

About the Scanner 
The Scanner employs a multi-tasking operating system. Programs are implemented as multiple processes that are 
time-sliced by the process scheduler (which is itself a process).  Among other things, processes may suspend 
themselves (or other processes), invoke other processes, or be invoked by hardware interrupts.  Several processes 
are usually active at any given time.  Each process is prioritized, some, such as the power-fail, are given very high 
priority.  In its internal mechanisms, the Scanner Operating System more closely resembles OS/2 or UNIX rather 
than MS-DOS. 
The Scanner software is modular on several levels.  The main advantage of modular software is enhanced 
reliability and lower development time.  Well-designed modules do not interact with each other in unexpected 
ways, and can be rearranged in a “building block” fashion, or replaced with other modules.  The diagram on the 
following page shows how the various modules and sub-modules relate to each other, to the user, and to the 
Scanner hardware. 
Most of the Scanner software is written in “C,” with some use of assembly language for critical portions, such as 
the operating system kernel and hardware interface. 
Calculations are performed in IEEE-Format Floating-Point, using three levels of numeric precision for different 
purposes.  This is in conformance with the practices recommended by the IEEE standard.  In general, parameter 
data (e.g., user-entered values) are stored in double precision (64-bit) format.  Round-off errors are minimized by 
employing extended precision (80-bit) in the calculations.  Historical data is stored in single precision (32-bit), 
which affords the most compact representation. For further details, consult IEEE Std 754-1985 “IEEE Standard 
for Binary Floating-Point Arithmetic.” 
All data stored in the Scanner is secured with a check sum. Check sums are implemented on all nonvolatile data 
blocks as part of the system memory allocator. A background process periodically checks all data blocks and 
records any errors in the event log. 
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Techniques 

K-Factor Interpolation 
The frequency input calibration or table is made up of several K-factors and the corresponding frequency.  
The software linearly interpolates between points in the table to calculate the K-factor for the input frequency.  
The following graph shows a K-factor vs. frequency plot for a typical turbine meter. 
Note that extrapolation of the first two points (1 and 2) is done to zero frequency; the extrapolation of the last 
two points (5 and 6) is projected towards a higher frequency. 
 

Freq1
Freq2

Live input
frequency

Freq3
Freq4

Freq5

Kfact1

Kfact2

Interpolated
K factor

Kfact3

Kfct4
Kfct5 Kfct6

Freq6

 
 
The following is an example calculation: 
Freq2 = 1000   Kfct2 = 345 
Freq3 = 1234  Kfct3 = 392 
If the input frequency is 1082 Hz, the interpolated K-factor will be 361.47. 
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Automatic Estimation 
The following occurrences cause a flowrun or system to go offline and an estimation to be performed, if the 
estimation routine is enabled (see Est_Enable in flowrun Configuration Rules - page 156 (NGas), page 194 
(IGas), and page 216 (NFlo). 
 
  Orifice Plate Change (Only from Main Menu) 
  Gas Data Change (Only from Main Menu) 
  Calibration (Only from Main Menu) 
  Power Failure (if power failure affects sensors) 
 
Prior to the flowrun or system going offline, the flow computer records the history data (averages and 
accumulation history) from the last hour boundary to the last completed calculation.  The flow computer also 
maintains average history data, based on an operator-entered period (default is 5 minutes).  After the flowrun 
or system comes back online, the flow computer calculates the average history data, based on the same 
operator entered period.  Estimated values for the time the flowrun or system was offline are calculated based 
on the average history data before and after the flowrun or system was offline.  The time stamp for the period 
of estimation is marked with an (E). 
At the next hour boundary, the flow computer records the history data since the estimation was done.  
Records before and after an estimation contain data from a partial hour and are marked by a (P) following the 
time stamp.  Daily histories, which contain estimated values, are marked by an (E) following the time stamp.  
The meter run must be back online for a period greater than the number of minutes on which the estimation is 
based for the estimation to be completed.  Flow estimation cannot be performed until “Z” factors have been 
calculated. 
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Or more simply illustrated:

15

20

25

30

Value

Basis = X min. Estimation Basis = X min.

Flowrun ON OFF ON

Time

Basis default: 5 minutes
Flowrun OFF;  -Plate Change
                        -Gas Composition Change
                        -Power Failure

 
History Report (hourly) 
96-02-28 09:00:00 Accumulations V, E & M, averages DP, P, T, FE, SG, HV. 
96-02-28 09:04:14P Accumulations V, E & M, averages DP, P, T, FE, SG, HV.  (9:00 to 9:04) 

b=2 through b=5. 
96-02-28 10:13:32E Accumulations V, E & M, (see example calculation) Ve + V2.  Averages DP, 

P, T, FE, SG, HV, T2. 
96-02-28 11:00:00P Accumulations V, E & M, averages DP, P, T, FE, SG, HV (10:13:32 to 

11:00:00). 
96-02-28 12:00:00 Accumulations V, E, & M, averages DP, P, T, FE, SG, HV. 
History Report (daily) 
96-02-28 8:00:00E Accumulations V, E & M. 
 
 
 
 
 

Note:  
An E is added to the time to indicate that the values are estimated. 
A P is added to the time to indicate that the values are for a partial hour. 
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Estimation Variables 
User-Entered Variables: 
 

Tb = The number of minutes to base estimation on.  User entered 2≤Tb≤30) as 
Estimation...Basis. T1 and T2 represent before and after outage intervals respectively, 
Tb = T1.  T2 is a longer interval than Tb because an initialization time (a=1) is required to calculate 
Fpv after the flowrun is turned online. 

 
t = Flowrun calculation time in seconds, for volume and energy, using average DP, P, T, FE, SG, 

HV.  User entered as Timing...Calc Delay. 
 

Fixed Constants: 
 
 B = The maximum number of calculation buffers = 7 (Fixed). 
 
Calculated Values: 
 

Tf = The time between the last calculation and the meter run outage (0.5 minute in the preceding 
example). 

 
To = The meter run outage time.  For the example in the preceding diagrams To = 65.5 minutes. 
 
Te = The estimation interval starts on the last complete calculation interval and ends after the meter 

run and flow computer are back online. 
 
 For the example in the diagram Te = 66 minutes (1.1 hours); Te = Tf + To 
 
N = The number of calculations performed in the estimation interval. 

60∗=
t

TN b  

b = The number of calculation buffers in use for interval Tb. 
    if (N<B)  then b=N 
    if (N>B)  then b=B 
n = The number of calculations stored per calculation buffer. 

b
Nn =   (n is truncated to the nearest integer) 

Qj = The flow, energy, or mass rate for each “t” calculation interval (includes supercompressibility 
calculation). 
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Qn = The average flow, energy, or mass rate for n calculations (If n=1, Qn=Qj). 

n

Q
Q

n

j
j

n

∑
== 1  

Q1 = The average flow, energy, or mass rate for N calculations or b calculation buffers before outage. 

b

Q
Q

b

n
n∑

== 1
1  

 In the example in the diagrams, assume the five values of Qn for period T1 are 10, 5, 10, 5, 10.  
Therefore Q1= 8 m3/hr. 

 
Q2 = The average flow, energy, or mass rate for N calculations or b calculation buffers, after outage.  

Q2 is calculated in the same manner as Q1 

b

Qn
Q

b

n
∑

== 1
2  

In the example in the diagram, assume the five values of Qn for period T2 are 10, 15, 10, 15, 10.  
Therefore Q2= 12 m3/hr. 

 
Ve = The estimated volume. 
 

( )ee TQQV
2

21 +
=  

 For the example in the diagram: 
 

311)1.1(
2
128 mVe =

+
=  

 Energy and mass estimates would be calculated using the same method. 
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Flowrun Data Flow 
The “Flowrun Data Flow” diagrams show the overall data flow in the flowrun process.  On the left, each live 
input is read and converted to engineering units.  The internal data flow of this conversion and calibration are 
shown in the “ATOD Conversion and Calibration” diagram.  Once converted, the live inputs are passed on to 
the Flowrun Averaging Routine.  The internal workings of this routine are shown in the “Flowrun Averaging 
(AGA-3)” and “Flowrun Averaging (AGA-7)” diagrams. 
The Scanner employs two averaging techniques for all live inputs - full-time averaging and flow-time 
averaging.  Full-time averaging accepts all live input samples no matter what the current flowing conditions 
are.  Flow-time averaging only accepts a live input sample it the run is flowing. 
Flow-time averaging provides accurate averaging of live data for flowruns (with fluctuating flowing 
conditions) since live samples are only included in the average when flow is present.  For AGA-3 flowruns, 
flow is present if the differential pressure is above the cut-off value.  For AGA-7 flowruns, flow is present if 
new pulses are received before the live inputs are sampled. 
When a calculation is required, the flow-time averages for SP, T, SG, and Hv are used as well as the full-time 
averages for DP (FREQ) and FE.  Every hour, the full time averages maintained for DP (FREQ), FE, SP, T, 
SG (optional), and Hv (optional) are placed in the hourly history buffer.  On a daily basis, the accumulated 
totals for volume and energy are placed in the DAILY HISTORY buffer.  All history data is stored as single-
precision, 4-byte, floating point numbers in the default storage units for the value. 
Frequency measurement is accomplished by using a running average of the pulse accumulations for a known 
interval.  Five frequency count buffers, each containing two seconds of pulses, are maintained by the 
software.  These buffers are read every 2 seconds, with the most current data replacing the oldest buffer.  
When a frequency is required, each buffer is summed and converted to a frequency using the equation: 
 

 
 
Pulse count to engineering value conversion (using the K-factor interpolation) is accomplished anytime the 
flowrun reads from the pulse input pulse buffer.  If no pulses are counted in the calculation delay period, then 
“no flow” (no flow time) is logged.  To benefit from the K-factor interpolation, the user should have a 
thorough knowledge of the pulse frequency.  It is important that the flowrun reads this buffer at regular 
intervals, especially in cases where the pulse frequency varies. 
The Scanner AGA-7 flowrun reads the pulse accumulation buffer and totals it at the same sample rate that it 
reads analog input channels.  The flowrun maintains an internal sum and uses it when required to do an AGA-
7 calculation.  K-factor conversion errors are minimized when the sample rate keeps up with varying 
frequency conditions. 
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Analog Calibration 

Up/Down Calibration 
When analog and RTD inputs are configured for up/down or down/up calibrations, the average of the up and 
down calibration is used to linearize the transmitter and correct for hysteresis. 

 

Volts

10 20 30 40 50 60 70 80 900 100

Upward curve
Downward curve
Averaged curve

1

5

Up / Down Hysteresis Correction Curve. 
Example Points: 

0,20,40,60,80,100,70,50,30,10 

Engineering Units
Following an up / down calibration, the Scanner averages 
the upward and downward curves together based on the 
voltage values (to keep the engineering values the same) 
and stores this single curve for use in the interpolation.

Va = (Vu + Vd) / 2

Vu = actual voltage       
on upward curve.

Vd = interpolated voltage 
on downward curve

 
Example of up/down calibration: 

 
Up-Scale 
VOLTAGE 

Calibration 
Eng. Value 

Down-Scale 
VOLTAGE 

Calibration 
Eng. Value 

1.00 0.00 5.05 100.00 
1.80 20.00 3.75 70.00 
2.60 40.00 3.10 50.00 
3.40 60.00 2.30 30.00 
4.20 80.00 1.40 10.00 

 
After the calibration is performed, both calibration tables are combined into a table of voltage values.  The 
engineering values are obtained by averaging the voltages of the up and down curves to form a new curve. 
 



ScanWin LITE   

154 February 2006  

For the example, the new table is as follows: 
 

Calibration Point 
(IN. WC) 

Up-Scale 
VOLTAGE 

Down-Scale 
VOLTAGE 

Averaged 
VOLTAGE 

0.0 1.00 1.045* 1.0225 
10.0 1.40* 1.40 1.4000 
20.0 1.80 1.843* 1.8215 
30.0 2.20* 2.30 2.2500 
40.0 2.60 2.641* 2.6205 
50.0 3.00* 3.10 3.0500 
60.0 3.40 3.439* 3.4195 
70.0 3.80* 3.75 3.7750 
80.0 4.20 4.237* 4.2185 

100.0 5.00* 5.05 5.0250 

*-These values were interpolated from the other curve 

High Pressure Zero Adjustment 
The calibration routine for differential pressure transmitters prompts the user to zero the differential pressure 
transmitter at “operating” conditions and then at atmospheric conditions to determine the High- Pressure Zero 
Adjustment, Hpz. 
E.g.  For a transmitter input with the following conditions: 

Zero at calibration pressure (atmospheric): 1.000 Vdc 
Zero at operating pressure: 0.998 Vdc 
The “High-Pressure Zero Adjustment” is equal to +0.002 Vdc. 

 



 

February 2006 155 

Chapter 10: NGas 4.X.X Configuration & 
Calculations 

 

• Flowrun Configuration Rules (p156) 
• Flowrun Parameters (p161) 
• NGas 4.X.X Flowrun Variables (p165) 
• NGas Calculations (p170) 

About Flowrun Configuration 
NGas 4.X.X is based on industry standards for gas flow measurement, including AGA-3 and AGA-8 (1994).  The 
program supports several gas compressibility methods, including AGA-8, (primary, GCN and HCN methods), 
Standing-Katz, Redlich-Kwong (with Wichert-Aziz correction for sour gases), and manual entry (single entry or 
matrix interpolation). 
All calculations are performed in SI units, with automatic conversion to other units when it is required.  NGas 
4.X.X uses flow equations in their simplest form and bases all calculations on mass flow.  Volume or energy flow 
is calculated from mass flow, even for turbine meters.  This consistent treatment simplifies the calculations, and 
allows flowruns to be handled the same way regardless of what primary device is used. 
The flowrun configuration is set in the Scanner when the field device is first set up.  Configurations are not 
normally changed but they can be altered in ScanWin LITE.  The configuration specifies what is being calculated 
with which method.  The parameters are the second level of information used to set up a Scanner and include gas 
composition values and physical specifications of the meter.  Many of these parameters can be edited in ScanWin.  
For each flowrun, a configuration record is collected from the Scanner and this configuration controls the 
calculation routines used in ScanWin LITE. 
You can specify up to twelve configuration categories.  Options within each category are specified when the field 
device is configured and you cannot change these options in ScanWin LITE.  
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Flowrun Configuration Rules 
Flowruns created using NGas 2.x and NGas 3.x will have some variations. 
Variable Tag Description Units / Allowed Values 
Run_name Flowrun name A user-assigned name for the flowrun.  This may contain as many as 10 characters. 
Run_Type Flowrun type Gas - is normally used for natural gas, but can also be used for any other industrial 

gas such as hydrogen or ammonia. 
Monitor – Refer to Chapter 13: Monitor Flowrun Configuration for details. 

Method Volume, Mass, 
Energy 
Calculations 

Volume Only, Mass Only, Volume & Mass, Volume & Energy, Mass & Energy, 
and Volume, Mass & Energy establishes what combination of volume, mass and 
energy will be totaled by a gas flowrun. 

Pri_Device Orifice or 
turbine 

Differential Producer is a term for meters that base their measurement on a 
pressure drop that they induce in the pipe.  The most common is the orifice meter.  
Others include pitot tubes and numerous proprietary devices such as inverted venturi 
(V-Cone and Wedge Meter). 
Linear Volume Meter includes all true mass flowmeters that produce a pulsed 
output signal, in which each unscaled electrical pulse represents a discrete volume of 
fluid.  This includes turbine meters, vortex-shedding meters, and positive 
displacement (PD) meters. 
Linear Mass Meter includes all true mass flowmeters that produce a pulsed output 
signal, in which each unscaled electrical pulse represents a discrete mass of fluid.  
Meters of this class are generally based on measurement of coriolis forces.  These 
are usually liquid meters, but some gas coriolis meters are now being manufactured. 

Dev_Type Device type If you are setting up an orifice run, the choices are: 
Orifice meter, Pitot tube, Inverted Venturi, Entered Cd&Y 
If it is a turbine run, the choices are: 
Standard, Level B, Ultrasonic 

Tap_Type Orifice pressure 
tap type 

Flange taps 

Tap_loc Orifice tap 
location 

Upstream or Downstream specifies the position of the static pressure tap with 
respect to the orifice.  If the P and ΔP inputs will come from a Barton DPE™ unit, 
select upstream taps. 

DP_mode Orifice DP 
stack/check 
mode 

The options include Single, Dual Stacked, Triple Stacked or Dual Checking.  DP 
stacking extends the rangeability of differential producer runs by placing two or 
three differential pressure transmitters in parallel.  The transmitters typically have 
full-scale ranges in 10:1 ratios.  When configured this way, the flowrun 
automatically selects whichever transmitter is in range, and uses that signal for the 
flow calculation; out-of-range transmitters are ignored.  The firmware program can 
accommodate DP inputs stacked up to three deep, which provides (in theory), about 
a 30 or 40-to-one flow rate rangeability from a single meter run.  Dual checking 
mode is intended for critical applications.  Two P transmitters are required; the 
primary and secondary must agree, otherwise an alarm is output. 

Dens_srce Density source The normal choice is Calculated. 
Other choices include All User Entered or Analog Densitometer (includes any 
device, which can provide a density input in the form of a 4-20 mA signal 
proportional to the actual density at flowing conditions). 
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Variable Tag Description Units / Allowed Values 
Gas_Data Gas data type This requires that the composition of the gas be fully specified, by entering the mole 

fractions of each of 21 component gases.  Input can be from either manual entry or 
live from an installed gas chromatograph. 
Manual selects the Z matrix method. 
Mole Fractions extends the normal slate of hydrocarbon gases to include additional 
gas components.  Choosing mole fractions limits you to either the Redlich-Kwong 
or Standing-Katz Z-factor methods (NGas3.x & 4.x). 

GCN (Gravity, %CO2, %N2), HCN (Heating Value, %CO2, %N2) and 
GHN (Gravity, Heating Value,  %N2) are associated with a simplified gas 
quality input used by the “AGA-8 Gross” and “SGERG” methods.  They 
specify various combinations of gravity (i.e. Real Gas Relative Density), 
gross volumetric heating value and percentages of inerts, which must be 
added to the calculation.  (Note that NGas 2.x also includes GMCN 
(Gravity, %C1, %CO2, %N2) and GHCN (Gravity, Heating Value, %CO2, 
%N2)). 

For Pc, Tc, Pc is the critical pressure (kPa [a] or other absolute units).  Pc and Tc are 
thermodynamic constants for a given gas.  This option selects a modified Redlich-
Kwong calculation, which is suitable for most pure non-hydrocarbon gases, e.g. pure 
carbon dioxide, pure ammonia, steam or other industrial gases.  The Pc and Tc for 
the gas(es) in question must be calculated and entered into the Scanner. 

Z_method Z method in use Options depend on what is chosen in Gas Data Type (above): 
When Gas Data Type is Manual, Matrix is available. 
When Gas Data Type is Mole Fractions, Standing-Katz, AGA8(92) GCN, 
AGA8(92) GHC, SGERG GHN and AGA8(92) Detailed are options. 
When Gas Data Type is Extended Mole Fractions, Standing-Katz and Redlich-
Kwong are the options. 
When the Gas Data Type is GCN, the only option is AGA8(92) GCN. 
When the Gas Data Type is GHC, the only option is AGA8(92) GHC. 
When the Gas Data Type is GHN, the only option is SGERG GHN. 
When Gas Data Type is Pc, Tc, Redlich-Kwong is the only option. 
Redlich-Kwong is the simplest and fastest equation of state provided in NGas.  The 
version used in NGas includes Wichert-Aziz correction, making it suitable for sour 
natural gas.  Redlich-Kwong is most accurate at relatively low pressures (to about 
3.5 MPa or 500 psi).  It is not recommended for use on custody transfer applications. 
Standing-Katz is another efficient algorithm based on the Standing-Katz graphical 
method.  It includes Wichert-Aziz correction, making it suitable for sour natural gas.  
It is accurate for pressures up to about 17 MPa or 2500 psi. 
The options (collectively referred to as the Gross Methods (AGA8(92) GCN, 
AGA8(92) GHC, and SGERG GHN) require only three parameters to characterize 
the gas.  Knowledge of the gravity, heating value, mole percent carbon dioxide and 
mole percent nitrogen (in various combinations) is all that’s needed, rather than the 
complete list of 21 components. 
The Gross methods can also be selected after choosing “mole fractions” input, in 
which case the gravity, heating value, %CO2 and %N2 are automatically computed 
from the gas analysis.  This allows the Gross methods to be used with live input 
from gas chromatographs. 
The AGA8 Gross methods are recommended for general natural gas measurement.  
They are efficient, well suited to low power applications, and nearly as accurate as 
the AGA-8 Detailed method.  The major restriction is the pressure/temperature 
range and the limits on the gas composition.  The range limits are well suited to 
pipeline-quality natural gas, but may not be suitable for production gas. 
Note that the temperature, pressure and composition limits must be observed 
otherwise serious measurement errors may result.  AGA Report No. 8 contains a 
prominent warning that the gross methods should not be used outside the specified 
limits 
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Variable Tag Description Units / Allowed Values 
The “Gross” methods were originally developed by the European research 
organization G.E.R.G. (Group Europeen de Recherches Gaziers), and subsequently 
adopted by the American Gas Association to become a part of the AGA-8.  The 
Standard GERG virial equation (SGERG) includes additional methods that were not 
adopted by A.G.A.  Two of these have been included in NGas; The SGERG GHN 
and HCN methods are fully consistent with the other “Gross” methods. 
AGA8 (92) Detailed is the most accurate method for finding the compressibility of 
natural gas.  It is also by far the most complex.  The calculation is inherently slow, 
compared to most other methods.  Since it requires the processor to be active for 
several consecutive seconds whenever Z is to be updated, the detailed method is a 
poor choice for low power applications.  For example, in situations where the 
Scanner runs off batteries and solar panels). 
You should reserve this calculation for custody transfer meters where accuracy is of 
paramount importance and an adequate power supply is available. 
The Detailed Method also requires that a large number of intermediate variables be 
retained in memory.  The amount of RAM installed in the Scanner is generally what 
determines the number of flowruns that can use this calculation. 
The Matrix is the method of last resort.  It extends the utility of NGas to cover gases 
whose behavior cannot be predicted by any of the empirical methods described 
above.  To use this method, you must fill the matrix with Z factors, which have been 
determined in advance at various temperatures and pressures.  NGas determines the 
Z-factor by linear interpolation from the matrix. 
The major disadvantage of this method is that any given matrix is valid only for a 
single gas composition; a new matrix must be determined any time the gas 
composition changes significantly. 
The “Single Z” option is useful in situations where you need to input Z directly 
(perhaps in order to verify other calculations). 

Z_size Z matrix size Options are Single, 3x3 Matrix, and 5x5 Matrix.  Note that this Tag appears only 
when the Z method in use is Matrix. 
The Single option is useful in situations where you need to input Z directly (perhaps 
in order to verify other calculations). 

Gr_mode Gravity mode. The options are Calculated, Entered, Live (logged), Calculated and Logged, and 
Entered and Logged.  NGas can calculate the real gas relative density from the 
mole fractions, or the gravity can be entered.  When entered, it must be ensured that 
the gravity is correct and consistent with the mole fractions.  Otherwise, a 
measurement error will result.  This problem does not occur when the gas gravity is 
calculated. 
Live input allows gas gravity to be obtained from any device which can provide it in 
the form of a 4-20 mA signal proportional to the real gas relative density at the 
reference conditions. 
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Variable Tag Description Units / Allowed Values 
Hv_mode Heating value 

mode 
When Gas Data is Mole Fractions, options are  
• Calculated Hvb (Calculated Hm)  
• Entered Hv (Calculated Hm), 
• Live Hv (Logged Hvb and Calculated Hm)  
• Entered Hm (Hv Calculated) 
• Calculated Hvb (Logged Hvb and Calculated Hm) 
• Entered Hvb (Logged Hvb and Calculated Hm)  
• Entered Hm (Logged Hvb and Calculated Hvb).   
NGas can calculate the heating value from the mole fractions or it can be user-
entered.  Live input allows the heating value to be obtained from any device that can 
provide it in the form of a 4-20 mA signal.   
Note that when the heating value is user-entered, it must be correct and consistent 
with the mole fractions, otherwise a measurement error will occur.  This problem 
will not occur when the gas heating value is calculated. 

GC_mode Gas component 
mode 

Options are Entered or From GC. 

GC_logging Gas component 
logging on/off 

The options are User Change Log, Hourly Log, Daily Log, and Hourly and Daily.  
This option determines whether updates in the gas composition will appear in the 
history log for this flowrun, as well as the location of the updates.  Gas component 
logging increases the size of the history log. 

Peak_logging Qb/Press peak 
logging 

The options are Off, Press, Qb, and Press & Qb.  If selected, the maximum or peak 
values will be recorded in the history log for the logging interval. 

Hrly_Hist_size "Hourly" 
History log size 

Daily_Hist_size Daily History 
log size 

This user-entered value determines the total length of the history logs, i.e. how many 
days’ data will be retained in NVRAM.  A log length of 1 to 15 days is appropriate 
for networked Scanners that are downloaded frequently.  35 days is normal for 
Scanners that are manually downloaded on a weekly schedule.  60 days may be the 
prudent choice for units in remote locations.  The default unit is days.  A value of 0 
disables this feature.  
Note that there must be enough free NVRAM to accommodate the log. 

Hist_intvl "Hourly" 
History log 
interval 

This user-entered value determines how frequently data is recorded during the day.  
60 minutes is the default time.  The minimum interval is 5 minutes.  Note that the 
shorter the interval, the greater is the NVRAM memory requirement. 

Direction Flowing 
direction 

These options, Forward, Unspecified, Reverse, and Status In are associated with 
bi-directional meter runs.  When equipped with the appropriate input expansion 
board, the Scanner can use phase discrimination to automatically determine the flow 
direction through a bi-directional turbine meter.  Alternately, a status input may be 
connected to a valve position switch to inform the Scanner of flow direction.  When 
the status input is asserted, a Forward flowrun will totalize while a Reverse 
flowrun (connected to the same status input) will be inhibited. 

Q_Calc Calculation 
delay 

This is the time delay between calculation starts.  It does not include the actual 
calculation time.  The default is 60 seconds.  To get the faster calculation time, set 
this value to a lower number. 

Z_Calc Z factor counter This value (default 5) is a multiple of the calculation delay.  This setting causes the 
compressibility factor to be calculated every fifth flow calculation. 

Avg_Freq Averaging 
delay 

This value is the time delay (in seconds) between averaging starts and does not 
include the actual averaging time.  (Applicable to versions 4.0 and below.) 

Avg_Delay Averaging 
delay 

This value is the time delay (in seconds) between averaging starts and does not 
include the actual averaging time.  (Applicable to versions 4.1 and above.) 
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Variable Tag Description Units / Allowed Values 
Avg_Style Averaging style The options are Flowtime, Fulltime, and 0 Flowtime.  Flowtime only averages 

inputs when there is flow.  If there is no flow for the history logging interval 
(typically 1 hour), Fulltime averages will be logged.  Fulltime is always averaged.  0 
Flowtime inserts zero values in the history log when there is no flow during the 
entire logging period. 

Est_PC Estimate during 
plate changes 

This option enables (green check mark) or disables (red X) the estimation process 
during routine plate change operations. 

Est_Enable Estimation 
on/off 

This option enables automatic estimation to take place during any period that the 
flowrun goes offline.  On is indicated with a green check mark and off with a red 
X. 

Est_Basis Estimation 
basis 

This value represents the time (in minutes), before and after a flowrun stoppage, that 
the values are averaged and used for automatic estimation.  The default is 5 minutes. 

Flow_check Flow check 
limit 

This value (percentage) is used to check the flow rate difference before and after a 
flowrun estimation.  It is used to warn of a significant difference in flow rate in case 
an incorrect plate size is entered during a plate change routine. 

Stn_A Station A 
assignment 

This option enables (green check mark) or disables (red X) the inclusion of the 
flowrun totals to Station A. 

Stn_B Station B 
assignment 

This option enables (green check mark) or disables (red X) the inclusion of the 
flowrun totals to Station B. 
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Flowrun Parameters 

Normalized Analysis 
Normalizing is an operation that forces the gas analysis to add up to 100 percent.  This is necessary to avoid 
mathematical errors in the gas properties calculations.  The method that NGas uses to determine the 
percentage of each component in the gas slate is the same as that used to solve this problem: "You have three 
oranges, seven apples, nine pears, and two lemons.  What is the percentage of each?”  As long as the sum of 
the user-entered gas analyses is exactly 100 percent, the analysis, which appears in ScanWin in flow 
snapshots and in other reports, will be exactly as entered.  Otherwise, the percentage of each component will 
be shifted slightly to reflect its true proportion. 

Base Temperature and Pressure 
Since all fluids expand and contract in response to temperature and pressure, fluid quantities expressed as 
volumes must always have the conditions of temperature and pressure specified.  These are referred to as base 
conditions, symbolized as "Tb" (base temperature) and "Pb" (base pressure).  In natural gas measurement, a 
variety of base conditions is used.  Base conditions for custody transfer are specified by contract between 
buyer and seller.  Some commonly used base conditions are: 
(United States)             60 F, 14.73 psi 
(Canada, UK, Australia)  15 C, 101.325 kPa 
(Most of Europe)            0 C, 101.325 kPa (also known as "normal" conditions) 

Pipe and Throat Diameters, Temperature Coefficients and 
Measurement Reference Temperatures 
Flow measurement by means of differential producers (which includes orifice meters, flow nozzles, venturis, 
averaging pitot tubes, and similar devices) is based on knowledge of the exact diameters of the pipe and the 
meter throat.  Since these measurements change with temperature, it is necessary to adjust for thermal 
expansion in these parts of the meter.  "Dr" is the inside diameter of the meter tube measured at a particular 
temperature "TDref"; similarly, "dr" is the diameter of the throat as measured at the temperature "Tdref".  
Different materials have different expansion characteristics.  NGas includes the temperature coefficients of 
commonly used meter construction materials.  If the meter is made of some other material, its coefficient(s) of 
thermal expansion can be entered numerically. 
If the meter is an orifice meter, both the diameter and the reference temperature should be stamped on the 
orifice plate.  For other types of differential meters, the information should appear on a data plate, or in 
documents provided by the manufacturer. 
When the selected meter is a V-Cone®, "dr" represents the cone diameter.  If the meter is an averaging Pitot 
tube (Annubar® or similar), "dr" represents the diameter of the strut.  For the Taylor Wedge meter, "dr" 
represents the height of the channel below the wedge.  The variable "Dr" (with a capital D) always represents 
the pipe diameter. 
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Discharge Coefficient 
The discharge coefficient of the V-Cone® meter is provided by the manufacturer.  It is typically around 0.84. 

Isentropic Exponent 
The isentropic exponent is a physical property of a gas.  The values to use are: 

Natural gases   k = 1.3 
Air, steam      k = 1.4 

For other industrial gases, consult a standard reference such as the Chemical Engineer's Handbook. 
It is normal practice in flow measurement to use nominal values such as those given above, since the flow 
calculation is insensitive to the value of k (i.e., there is hardly any effect to the result even when k deviates by 
10% or more from its true value). 

Viscosity 
The viscosity of a fluid is defined as its resistance to deformation.  Flow measurement by means of 
differential producers requires knowledge of the viscosity of the fluid. 
When a gas flowrun is configured to use "Gas data = Mole fractions", NGas calculates the gas's viscosity 
from the composition.  If "Gas data" is something other than mole fractions, the viscosity must be entered by 
the user.  The nominal viscosities of some common industrial gases are given below.  Gas flowruns are not 
very sensitive to viscosity, so use of a nominal value provides reasonable accuracy. 

     
Gases Nominal viscosity at 15 C (60 F), centipoise 
air 0.0179 
natural gas 0.0107 
hydrogen 0.0087 
argon 0.0220 
ammonia (gas) 0.0105 
water (vapor) 0.0095 
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Meter Factors 
Normally, differential producers are uncalibrated devices.  Equations for predicting a meter’s discharge 
coefficient were originally derived from a large number of experiments performed on meters of similar type.  
It is usually impractical to calibrate a gas flowmeter that is operating at high pressure.  In those few cases 
where calibration is possible, a means must be provided for adjusting the meter's indicated flow rate to match 
its actual (calibrated) flow rate.  The means provided by NGas is the meter factor table.   
Meter factors are normally close to 1.0.  A meter factor of 1.05 adjusts the flow upward by five percent.  E.g. 
an indicated flow of 12.345 would be corrected to 12.962; if the meter factor were 0.95, the flow of 12.345 
would be corrected downwards to 11.727.   
Each meter factor is associated with a Reynolds Number that is determined during calibration. 
The Reynolds Numbers must be entered into the table in ascending order, with Re1 having the smallest value 
and Re9 having the largest value;  Re1 < Re2 < Re3,  etc. 
When all entries in the meter factor table are zero, no correction is applied to the flow.  If you do not wish to 
use the meter factor table, simply leave it blank. 

Calculated Values 

Flow Extension (Differential Producers) 
The flow extension is recorded in the history logs, and can be used to recalculate flows from the log entries.  

Discharge Coefficient (Differential Producers) 
The discharge coefficient is calculated differently for each type of differential producer, usually as a function 
of Reynolds Number and Beta.  
Typical values: 

Orifice meters      0.6 
Flow nozzles      0.95 to 0.99 

Reynolds Number (Differential Producers) 
The Reynolds Number "Re" is defined as the ratio of inertial forces to viscous forces.  It is a dimensionless, 
and usually rather large, number.  Flow measurement by means of differential producers is made possible by 
the principle of Reynolds Number Similarity.  
Typical values 

Re=4000       high viscosity liquid at low flow rate 
Re=100000 to 1000000   typical for a gas 
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Expansion Factor (Differential Producers, Gas Flow) 
When gas passes through the meter throat its pressure drops and it expands.  This action is reflected in the 
differential pressure measurement.  
The gas expansion factor "Y" is very close to unity under most conditions.  The Y factor correction increases 
as the differential pressure becomes a larger fraction of the static pressure; i.e. Y is most significant in low-
pressure metering. 
Typical values: 

Y = 0.995    (typical pipeline pressure) 
Since liquids are incompressible, the expansion factor for liquid flowruns always equals 1.0   

Compressibility (Gas Flowruns) 
The compressibility of a gas is the amount by which its behavior deviates from the Ideal Gas Law.  It is a 
dimensionless number, symbolized by a "Z", and is the result of a complex calculation based on temperature, 
pressure and quality of the gas.  Note that differential pressure is not involved.  NGas computes two Z factors; 
Zf the compressibility at flowing conditions, and Zb, the compressibility at base conditions.  
Typical values: 

Zb   0.998     (always close to 1.0; usually 0.99 something) 
Zf     0.8 to 1.05   (under typical conditions) 
Zf     0.5 to 1.5    (under extreme conditions) 

Molar Density (Gas Flowruns) 
Molar density is closely related to compressibility.  It is the density of the gas expressed in kilogram-moles 
per cubic meter, or equivalent units.  As with compressibility, two molar densities are computed:  Mdf 
(flowing conditions) and Mdb (base conditions).  
Typical values: 

Mdb    0.04    (typical natural gas) 
Mdf    2.3     (typical natural gas at 700 psi) 
Mdf   19.3     (typical natural gas at extreme pressure) 

Mass Density (All Flowruns) 
Mass density is normally symbolized with the Greek letter “θ”.  It is the density of the fluid in kilograms per 
cubic meter or equivalent units.  
Typical values: 

RHOb  0.7   (typical natural gas) 
RHOf    40.6   (typical natural gas at 700 psi) 
RHOf     340   (natural gas at extreme pressure) 
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NGas 4.X.X Flowrun Variables 
Variable Tag  Description Storage Units Attributes 
Alpha D Pipe Thermal Expansion Coefficient mm/mm°C Param 
Alpha d Throat Thermal Expansion Coefficient mm/mm°C Param 
Beta Diameter Ratio - Calc 
Btot Total Volume (Base Conditions) M3 Total 
Ca1 Annubar Coefficient 1 - Param 
Ca2 Annubar Coefficient 2 - Param 
Cd Discharge Coefficient - Param/Calc 
D Pipe Inside Diameter m Calc 
d Throat Diameter m Calc 
DiffP Current Differential Pressure Pa Calc/Avg 
DPh-l Stacked DP high to low switchpoint Pa Param 
DPh-m Stacked DP high to mid switchpoint Pa Param 
DPhi High Stacked Differential Pressure Pa Live 
DPl-h Stacked DP low to high switchpoint Pa Param 
DPl-m Stacked DP low to mid switchpoint Pa Param 
DPlow Low Stacked Differential Pressure Pa Live 
DPlv Single Live Differential Pressure Pa Live 
DPlast Last read Differential Pressure Pa Calc 
DPm-h Stacked DP mid to high switchpoint Pa Param 
DPm-l Stacked DP mid to low switchpoint Pa Param 
DPmid Mid Stacked Differential Pressure Pa Live 
DPpri Primary Live Differential Pressure Pa Live 
DPsec Secondary Live Differential Pressure Pa Live 
DPkPr Peak Pressure (daily) Pag Calc 
DPkQb Peak Volume Flow Rate (daily) M3/sec Calc 
Dr Uncorrected Pipe Inside Diameter  m Param 
dr Uncorrected Throat Diameter m Param 
Etot Total Energy Joules Total 
Ev Velocity of Approach factor - Calc 
Fextn Flow Extension (=sqrt(DP * RHOf)) - Calc/Avg 
Freq Input frequency Hz Calc/Avg 
Gr Real Gas Relative Density kg/M3 Par/Live/Calc 
Hm Heating value, mass basis Joules/kg Par/Calc 
Hv Heating value, volume basis, ref. conditions Joules/M3 Calc 
Hvb Heating value, volume basis, base conditions Joules/M3 Par/Live/Calc 
HPkPr Peak Pressure (hourly) Pag Calc 
HPkQb Peak Volume Flow Rate (hourly) M3/sec Calc 
k Isentropic Exponent - Param 
Ka Annubar Flow Coefficient - Calc 
Mdb Molar density, base conditions - Calc 
Mdf Molar density, flowing conditions - Calc 
Mdref Molar density, reference conditions - Calc 
MF1 Meter factor 1 - Param 
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Variable Tag  Description Storage Units Attributes 
MF2 Meter factor 2 - Param 
MF3 Meter factor 3 - Param 
MF4 Meter factor 4 - Param 
MF5 Meter factor 5 - Param 
MF6 Meter factor 6 - Param 
MF7 Meter factor 7 - Param 
MF8 Meter factor 8 - Param 
MF9 Meter factor 9 - Param 
MFact Meter factor (interpolated) - Calc 
MFsum Mole Fraction Sum - Calc/Live10 
Mr Molar mass - Calc 
Mtot Total Mass kg Total 
MtotB This Months Total Volume M3 Total 
MTotE This Months Total Energy Joules Total 
MTotM This Months Total Mass kg Total 
Mu Absolute Viscosity kg/Msec Param/Calc 
P1 Matrix pressure point 1 Paa Param 
P2 Matrix pressure point 2 Paa Param 
P3 Matrix pressure point 3 Paa Param 
P4 Matrix pressure point 4 Paa Param 
P5 Matrix pressure point 5 Paa Param 
Patm Local Atmospheric Pressure Paa Param 
Pbase Contract Base Pressure Paa Param 
Pc Pseudocritical Pressure Paa Param/Calc 
Pf Absolute Pressure Paa Calc/Avg 
PfZf Absolute Pressure for Zf Paa Calc 
Press Gauge Pressure Pag Live 
PtotB Previous Months Total Volume M3 Total 
PTotE Previous Months Total Energy Joules Total 
PTotM Previous Months Total Mass kg Total 
Qb Volume Flow Rate M3/sec Calc 
Qe Energy Flow Rate Joules/sec Calc 
Qf Uncorrected Pulse Rate M3/sec Live 
Qfavg Average Uncorrected Pulse Rate M3/sec Calc 
Qftot Uncorrected Pulse Total M3 Total 
Qf1 Ultrasonic Meter factor Qf 1 M3/sec Param 
Qf2 Ultrasonic Meter factor Qf 2 M3/sec Param 
Qf3 Ultrasonic Meter factor Qf 3 M3/sec Param 
Qf4 Ultrasonic Meter factor Qf 4 M3/sec Param 
Qf5 Ultrasonic Meter factor Qf 5 M3/sec Param 
Qf6 Ultrasonic Meter factor Qf 6 M3/sec Param 
Qf7 Ultrasonic Meter factor Qf 7 M3/sec Param 
Qf8 Ultrasonic Meter factor Qf 8 M3/sec Param 

                                                      
10 Live assignment supported only for GC peripheral devices, which assigns all gas components to GC. 
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Variable Tag  Description Storage Units Attributes 
Qf9 Ultrasonic Meter factor Qf 9 M3/sec Param 
Qm Mass Flow Rate kg/sec Calc/Live 
Re1 Meter factor Reynolds Number 1 - Param 
Re2 Meter factor Reynolds Number 2 - Param 
Re3 Meter factor Reynolds Number 3 - Param 
Re4 Meter factor Reynolds Number 4 - Param 
Re5 Meter factor Reynolds Number 5 - Param 
Re6 Meter factor Reynolds Number 6 - Param 
Re7 Meter factor Reynolds Number 7 - Param 
Re8 Meter factor Reynolds Number 8 - Param 
Re9 Meter factor Reynolds Number 9 - Param 
ReD Reynolds Number (D) - Calc 
RHOb Fluid Density at Base Conditions kg/M3 Calc 
RHOf Fluid Density kg/M3 Calc 
RHOrf Fluid Density at Reference Conditions kg/M3 Calc 
SPlast Last read Pressure Pag Calc 
T1 Matrix temperature point 1 K Param 
T2 Matrix temperature point 2 K Param 
T3 Matrix temperature point 3 K Param 
T4 Matrix temperature point 4 K Param 
T5 Matrix temperature point 5 K Param 
Tbase Contract Base Temperature K Param 
Tc Pseudocritical Temperature K Param/Calc 
TDmea Pipe Measurement Temperature K Param 
Tdmea Throat Measurement Temperature K Param 
Temp Live Temperature K Live 
Tf Flowing Temperature K Calc/Avg 
Tlast Last read Temperature K Calc 
TtotB Today’s Total Volume M3 Total 
TTotE Today’s Total Energy Joules Total 
TTotM Today’s Total Mass kg Total 
Tzf Temperature for Zf K Calc 
UMF1 Ultrasonic Meter factor 1 - Param 
UMF2 Ultrasonic Meter factor 2 - Param 
UMF3 Ultrasonic Meter factor 3 - Param 
UMF4 Ultrasonic Meter factor 4 - Param 
UMF5 Ultrasonic Meter factor 5 - Param 
UMF6 Ultrasonic Meter factor 6 - Param 
UMF7 Ultrasonic Meter factor 7 - Param 
UMF8 Ultrasonic Meter factor 8 - Param 
UMF9 Ultrasonic Meter factor 9 - Param 
UMFact Ultrasonic Meter factor (interpolated) - Calc 
xAr Mole Fraction Argon - Param 
xC1 Mole Fraction Methane - Param 
xC2H4 Mole Fraction Ethene - Param 
xC2 Mole Fraction Ethane - Param 
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Variable Tag  Description Storage Units Attributes 
xC3 Mole Fraction Propane - Param 
xC3H6 Mole Fraction Propene - Param 
xC4H8 Mole Fraction Butene - Param 
xC5H10 Mole Fraction Pentene-1 - Param 
xCO Mole Fraction Carbon Monoxide - Param 
xCO2 Mole Fraction Carbon Dioxide - Param 
xH2 Mole Fraction Hydrogen - Param 
xH2O Mole Fraction Water - Param 
xH2S Mole Fraction Hydrogen Sulfide - Param 
xHe Mole Fraction Helium - Param 
xiC4 Mole Fraction Iso-Butane - Param 
xiC5 Mole Fraction Iso-Pentane - Param 
xN2 Mole Fraction Nitrogen - Param 
xnC10 Mole Fraction Normal Decane - Param 
xnC4 Mole Fraction Normal Butane - Param 
xnC5 Mole Fraction Normal Pentane - Param 
xnC6 Mole Fraction Normal Hexane - Param 
xnC7 Mole Fraction Normal Heptane - Param 
xnC8 Mole Fraction Normal Octane - Param 
xnC9 Mole Fraction Normal Nonane - Param 
xO2 Mole Fraction Oxygen - Param 
Y Expansion Factor - Param/Calc 
YtotB Yesterdays Total Volume M3 Total 
YTotE Yesterdays Total Energy Joules Total 
YTotM Yesterdays Total Mass kg Total 
Z11 Z factor @ Pressure1 / Temperature 1 - Param 
Z12 Z factor @ Pressure1 / Temperature 2 - Param 
Z13 Z factor @ Pressure1 / Temperature 3 - Param 
Z14 Z factor @ Pressure1 / Temperature 4 - Param 
Z15 Z factor @ Pressure1 / Temperature 5 - Param 
Z21 Z factor @ Pressure2 / Temperature 1 - Param 
Z22 Z factor @ Pressure2 / Temperature 2 - Param 
Z23 Z factor @ Pressure2 / Temperature 3 - Param 
Z24 Z factor @ Pressure2 / Temperature 4 - Param 
Z25 Z factor @ Pressure2 / Temperature 5 - Param 
Z31 Z factor @ Pressure3 / Temperature 1 - Param 
Z32 Z factor @ Pressure3 / Temperature 2 - Param 
Z33 Z factor @ Pressure3 / Temperature 3 - Param 
Z34 Z factor @ Pressure3 / Temperature 4 - Param 
Z35 Z factor @ Pressure3 / Temperature 5 - Param 
Z41 Z factor @ Pressure4 / Temperature 1 - Param 
Z42 Z factor @ Pressure4 / Temperature 2 - Param 
Z43 Z factor @ Pressure4 / Temperature 3 - Param 
Z44 Z factor @ Pressure4 / Temperature 4 - Param 
Z45 Z factor @ Pressure4 / Temperature 5 - Param 
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Variable Tag  Description Storage Units Attributes 
Z51 Z factor @ Pressure5 / Temperature 1 - Param 
Z52 Z factor @ Pressure5 / Temperature 2 - Param 
Z53 Z factor @ Pressure5 / Temperature 3 - Param 
Z54 Z factor @ Pressure5 / Temperature 4 - Param 
Z55 Z factor @ Pressure5 / Temperature 5 - Param 
Zb Compressibility at Base Conditions - Param/Calc 
Zf Compressibility at Flowing Conditions - Param/Calc 
Zref Compressibility at Ref. Conditions - Param/Calc 
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All calculations in NGas/IGas 4.x.x are performed in SI 
units.

NGas Calculations 

Units of Measurement  
 
 
 

Measurement Units Conversion Other Units 
Pressure Pascal (Pa) =0.001 

=0.0001450377 
=0.000001 

=0.0040186 
=0.000334883 
=0.000296134 

=0.01 
=0.00001 

Kilo Pascal (kPa) 
psi 
Mega Pa (MPa) 
Inch WC (IWC) 
Feet WC (FWC) 
Inch Hg (IHg) 
Millibar (mBar) 
Bar 

Temperature K (Kelvin) =1.8 Rankine (R) 
Length Meter (m) =39.370079 

=100.0 
=1000.0 

=3.28084 
=1.093613 

Inch (in) 
cm 
mm 
feet (ft) 
yard (y) 

Volume Meter cu (m3) =1000.0 
=35.314667 

=1E-3 
=1E-6 

=.035315 
=35.3147 E-6 
=219.969248 
=264.172052 

=6.289811 

liter (L) 
Cu foot (CF) 
Thsd m3 (E3M3) 
Miln m3 (E6M3) 
Thsd ft3 (MCF) 
Miln ft3 (MMCF) 
Imp Gal (ImpG) 
US Gal (USG) 
Barrel (BBL) 

Mass Kilogram (kg) =1000.0 
=2.204623 

gram (g) 
Pound mass (LBm) 

Energy Joule (J) =0.000001 
=0.001 

=0.000947816988 
=1E-9 

=947.816988E-9 
=947.816988E-12 

=2.777778E-7 
=0.00023884932 

Megajoule (MJ) 
KJoule (kJ) 
Btu (BTU) 
GJoule (GJ) 
Thsd Btu (MBTU) 
Miln Btu (MMBTU) 
Kilowatt Hours (kWh) 
Kilocalories (kCal) 

Time Second (s) =1.6543439E-6 
=1.157407E-5 
=2.777778E-4 
=0.01666667 

week (w) 
day (d) 
hour (h) 
min (m) 
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Gas Properties 
Properties of hydrocarbon gases and other components of natural gas: 
Component Symbol Tc °K Pc MPa (a) Mr µ cp Hm MJ/kg 
Nitrogen N2 126.21 3.398 28.0134 0.01735 0 
Cbn dioxide CO2 304.11 7.374 44.010 0.01439 0 
Hyd. sulf. H2S 373.37 8.963 34.08  16.502 
Water H2O 647.1 22.064 18.0153 0.01240 2.4664 
Helium He 5.18889 0.22683 4.0026 0.01927 0 
Methane C1 190.56 4.599 16.043 0.01078 55.575 
Ethane C2 305.41 4.880 30.070 0.00901 51.950 
Propane C3 369.77 4.240 44.097 0.00788 50.368 
n-butane nC4 425.1 3.784 58.123 0.00724 49.546 
isobutane iC4 407.82 3.640 58.123 0.00723 49.388 
n-pentane nC5 469.65 3.365 72.150  49.045 
isopentane iC5 460.35 3.381 72.150  48.949 
n-hexane nC6 506.4 3.030 86.177  48.716 
heptane nC7 539.2 2.740 100.204  48.473 
octane nC8 568.4 2.490 114.231  48.288 
nonane nC9 594.7 2.280 128.258  48.152 
decane nC10 617.7 2.100 142.285  48.037 
Oxygen O2 154.59 5.043 31.9988 0.02006 0 
Cbn. monox. CO 132.9222 3.49909 28.010 0.01439 10.1004 
Hydrogen H2 32.97778 1.29273 2.0159 0.00871 141.94 
Argon Ar 150.8611 4.89804 39.948 0.02201 0 

Properties of assorted industrial gases: 
Component Symbol Tc °K Pc Mpa Viscosity cp 
Ammonia NH3 405.5 11.29 0.00982 
Air  132.45 3.77 0.01827 
Steam  H2O 647.14 22.13 0.01240 
Helium  He 5.189 0.227 0.01927 
Argon Ar 150.86 4.898 0.02201 
Neon Ne 44.45 2.62 0.03111 
Chlorine Cl 417.15 7.71 0.01327 
Fluorine F 118.15 2.53  
Sulphur dioxide SO2 430.35 7.87 0.01242 
Acetylene C2H2 309.15 6.28 0.00935 
Ethylene C2H4 282.85 5.12 0.01008 
Nitric oxide NO 179.15 6.59 0.01876 
Nitrous oxide N2O 309.65 7.27 0.01488 
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Reference Standards 
This section specifies the equations, limitations and assumptions relating to the NGas 3.X and 4.X program. 
Throughout this section, references are made to various published gas measurement standards.  The following 
is a list of the industry gas measurement standards publications: 
 
Manual of Petroleum Measurement Standards 
Chapter 14 - Natural Gas Fluids Measurement 
Section 3 - Concentric, Square-edged Orifice Meters 
Part 1 - General Equations and Uncertainty Guidelines 
Part 3 - Natural Gas Applications 
Part 4 - [implementation] 
American Petroleum Institute, 1990 
Note:  Synonymous with A.G.A. Report No. 3, Parts 1 through 4 
 
"Compressibility Factors of Natural Gas and Other Related Hydrocarbon Gases", American Gas Association 
Transmission Measurement Committee Report No. 8 
Starling, K.E. and Savidge, J.L. eds  
Second printing (version 1.2), July 1994 
AGA Catalog Number XQ9212 
Note:  Synonymous with American Petroleum Institute MPMS Chapter 14.2 
 
Table of Physical Constants of Paraffin Hydrocarbons and Other Components of Natural Gas 
GPA Standard 2145-93 
Gas Producer's Association, Tulsa OK. 
 
Computer calculation of natural gas compressibility factors using the Standing and Katz correlation 
P.M. Dranchuk, R.A. Purvis, and D.B. Robinson 
Institute of Petroleum, Technical Series No. 1, IP 74-008, 1974 
 
Compressibility Factor of Sour Natural Gases 
Edward Wichert and Khalid Aziz 
Canadian Journal of Chemical Engineering, Vol. 49, April 1971 
 
On the Thermodynamics of Solutions 
An Equation of State.  Fugacities of Gaseous Solutions. 
Otto Redlich and J.N.S Kwong 
Oct 25, 1948 
Presented at the Symposium on Thermodynamics and Molecular Structure of Solutions; the 114th meeting of 
the American Chemical Society, Portland, Oregon 
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Standard GERG Virial Equation for Field Use 
Technical monograph GERG TM5 1991 
M. Jeaschke and A.E.Humphreys 
Groupe Européen de Recherches Gaziérs 
Verlag des Vereins Deutscher Ingenieure 
Düseldorf, 1991 
ISBN 3-18-146606-9 
 
Flow Measurement Engineering Handbook 
Richard W. Miller 
McGraw-Hill, 1989    (Second edition) 

Reference Conditions 
The reference conditions for all gas property data are: 
 THref  Heating value reference temperature  288.15 °K/15°C 
 TDref  Mmolar density reference temperature   288.15 °K/15°C 
 TGref  Relative density reference temperature   288.15 °K/15°C 
 PDref  Molar density reference pressure   101.325 kPa 
 PGref  Relative density reference pressure    101.325 kPa 
These values are used internally in the NGas/IGas 4.X software, and do not appear on any of the pages.  
However, the user should ensure that the values entered for the real gas relative density (Gr) and gross 
volumetric heating value (HV) are based on the above reference conditions.  If Gr or HV are based on different 
reference conditions, they should be corrected for best accuracy.  Methods for changing the reference 
conditions are given in AGA Report No 8, appendix C.  (This should not be necessary.  The above reference 
conditions are standard for gas measurement in North America). 
Other reference conditions are: 
 Tbase  Contract base temperature   user-entered  
 Pbase  Contract base pressure    user-entered 
 TrefD  Meter tube reference temperature  user-entered 
 Trefd  Orifice plate reference temperature  user-entered 
 Patm  Average atmospheric pressure   user-entered 
Tbase and Pbase are used only in volumetric measurement.  They are the base temperature and pressure 
specified in the contract between buyer and seller of the gas. 
Metals expand and contract with changes in temperature.  TrefD and Trefd are used by NGas/IGas 4.X.X to 
account for changes in the meter bore and orifice plate.  AGA Report No 3, Part 2 gives the full procedure for 
"miking" the meter and orifice plate.  
Note:  The current AGA-3 standard requires the reference temperature and the bore diameter to be marked 

on the orifice plate. 
Patm is the average barometric pressure at the meter site.   
For a detailed explanation of these and other reference conditions, see AGA Report No 8 (1994), appendix 
C2. 



ScanWin LITE   

174 February 2006  

Rates and Totals Calculations 

Mass Flow 
The final flow calculation used in NGas 4.X.X departs slightly from the standard formulation.  The flow 
extension Fextn (see page 175) is introduced as a separate variable whose value is recorded in the flowrun's 
history log.  The Meter Factor MF is discussed later in this chapter.  The incremental mass is obtained by 
integrating the instantaneous mass flow rate over the time interval of the calculation. 

∫= dtQmm    

or 
fvm ρ=     (if pulse input) 

where 
Qm = mass flow (from diff producer, linear volume meter, or mass meter) 
m  = incremental mass added to Mtot 
dt = time elapsed since the preceding calculation 
v = incremental volume 
ρf = RHOf = mass density at flowing conditions 

Volume Flow 
Volume flow at base conditions: 

b
QmQb
ρ

=  

b
mV
ρ

=  

where 
qm = mass flow (from diff producer, volume pulse meter, or mass meter) 
Qb = volume flow rate at contract base conditions 
V = incremental volume at contract base conditions added to Btot 
ρb = RHOb = mass density at contract base conditions 
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Energy Flow 
HmQmQe =  

HmmE =  
where 

Qm = mass flow (from diff producer, volume pulse meter, or mass meter) 
Qe = energy flow rate 
Hm = mass basis heating value (Gross or Superior heating value)11 
E = incremental energy added to Etot 

Differential Pressure Producers 
All differential pressure producers use the equation  

∫= dtQmm  

Common Equations 
1. Meter tube diameter (D): 

( )[ ]TrTfDrD −+= 21 α  
Where 

Dr  = meter tube diameter at reference temperature Tr 
α2  = AlphaD = coefficient of linear expansion of orifice plate material 
Tf  = temperature of flowing gas 
Tr  = reference temperature 

2. Flow extension (Fextn): 

PfFextn Δ= ρ  

Where 
ρf  = RHOf = mass density at flowing conditions, kg/m3 
ΔP  = DiffP = differential pressure 

3. Meter factor (MF): 

( ) nnn
nn
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x MFMFMFMF +⎥

⎦
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Where 

Re  = Reynolds number 

                                                      
11 Effect of "spectator" water is not taken into consideration. 
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Orifice Meter 
Mass flow rate using an orifice meter (qm): 

MFFextndYEvCdNQm 2
1=  

• 2
41 ⎟

⎠
⎞

⎜
⎝
⎛=

πN  (for MKS units) 

• Discharge coefficient for flange taps (Cd): 

CAFTCFTCd
D

i
4

7.06

)0049.00210.0(
Re

10000511.0)()( ββ
++⎥

⎦

⎤
⎢
⎣

⎡
+=  

TapTermCTCFTC ii += )()(  

1
82 )1(003.02290.00291.05961.0)( MCTCi βββ −+−+=  

DnstrmUpstrmTapTerm +=  

[ ]( )BAeeUpstrm LL 23.011145.00712.00433.0 11 0.65.8 −−+−= −−  

[ ] ( )AMMDnstrm 14.010116.0 1.13.1
22 −−−= β  

4

4

1 β
β
−

=B  

⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
−= 0.0,8.2max

4
1 N

DM  

β−
=

1
2 2

2
L

M  

8.0

Re
19000

⎥
⎦

⎤
⎢
⎣

⎡
=

D

A β
 

35.06

Re
10

⎥
⎦

⎤
⎢
⎣

⎡
=

D

C β
 

Beta ratio: 

D
d

=β  

Orifice bore: 
( )[ ]TrTfdrd −+= 11 α  

where 
 dr  = orifice bore at reference temperature Tr 
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Reynolds Number: 

D
QmN

D μ
2Re =  

where 

 
π
4

2 =N   (for MKS units) 

 μ  = Mu = viscosity 
• Velocity of approach factor (Ev): 

41
1

β−
=Ev  

D
d

=β  

• Expansion factor (Y): 

( ) ⎟
⎠
⎞

⎜
⎝
⎛+−=

k
xY 1435.041.01 β  

(Isentropic exponent (k) is a user-entered value) 

13
1

fPN
Px Δ

=  

where 
0.13 =N  (for MKS units) 

Static pressure, when measured at the upstream tap: 

atmgagef PPP +=  

where gageP  = Press = gauge pressure 

Static pressure, when measured at the downstream tap: 
PPPP atmgagef Δ++=  

where gageP , atmP , and PΔ  are in the same units (kPa) 

• Refer to Common Equation for NGas Calculations (page 175) for flow extension (Fextn) and meter 
factor (MF). 
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Averaging Pitot Tube (Annubar®) 
Mass flow rate using a pitot tube (qm): 

MFFextnYDKNQm 2=  
• Flow coefficient (K): 

( )2
21

2

11

1

β

β

CaCa

CaK
−+

−
=  

where the values of 1Ca  and 2Ca  are dependent on the model being used: 
 Ca1 Ca2 

Model 10 (coefficients need to be checked with Annubar 1.20107 1.38155 
Others (models 15/16, 25/26, 35/36, 45/46) 1.34966 0.8468 

Beta ratio: 

D
d

π
β 4

=  

where  
d = throat diameter (strut width) 
D = internal pipe diameter 
d is dependent on the model: 
Model d (in inches) 
10 0.183 
15/16 0.3576 
25/26 0.8460 
35/36 1.230 
45/46 1.980 

 
• Refer to Common Equation for NGas Calculations (page 175) for pipe diameter (D). 
• Expansion factor (Y): 

( )[ ]
fkP

pY Δ
−−−= 09484.0131424.01 2β  

where 
k = user-entered isentropic exponent 

• Refer to Common Equation for NGas Calculations (page 175) for flow extension (Fextn) and meter 
factor (MF). 
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Inverted Venturi (Vcone) 
Mass flow rate using the Vcone (qm): 

( ) MFFextnDYKEvCdQm 2β=  
• Discharge coefficient (Cd) is a user-entered value; 
• Velocity of approach factor (Ev): 

41
1

β−
=Ev  

D
dD 22 −

=β  

( )[ ]TrTfdrd −+= 31 α  

where 
dr = throat diameter at temperature Tr 
Tr = reference temperature 
Tf = temperature of flowing gas 

• Flow coefficient (K): 2
4
π

=K  (for MKS units) 

• Expansion factor (Y): 

Tube meter equation: [ ]( )
Pfk
PΔ

+−+= 4696.0649.01 βε  

   where if 
    3.1=k  
    65.0=β  
    10=ΔP  
    300=Pf  
    589749801733243.0=ε  

Wafer meter equation: [ ]( )
kPf

PΔ
+−+= 8787.6755.01 βε  

   where if 
    3.1=k  
    45.0=β  
    20=ΔP  
    5000=Pf  
    212239976418079.0=ε  

• Refer to Common Equation for NGas Calculations (page 175) for meter bore (D), flow extension 
(Fextn) and meter factor (MF). 
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Linear Volume Meter 
NGas 4.X.X uses a somewhat unconventional calculation for turbine metering.  Gross volume is converted 
immediately to mass. 
The mass flow is computed (qm): 

fqfQm ρ=  
fvm ρ=  

where 
Qm = mass flow rate 
qf = gross (uncorrected) volumetric flow rate (pulse or analog input) 
m = incremental mass added to Mtot 

fρ  = RHOf = mass density at flowing conditions 
v = incremental volume 

For pulse input: 
The gross volumetric flow is first computed from the frequency and the K-factor: 

K
fqf 3600

=  

MF
K
pv ×=  

where 
qf = gross (uncorrected) volumetric flow rate 
f = frequency (Hertz) 
K = meter K-factor (also see K-factor interpolation) 
p = incremental pulse count (since previous channel scan) 
v = incremental (uncorrected) volume added to Qftot 
MF = user-entered meter factor value (dimensionless) 

For analog input: 
dtqmm ∫=  

 
 
 
 
 
 
 
 
 

Note: The gross volume is determined from the pulse count accumulated in the hardware register.  A separate 
hardware register measures the period used to determine the signal frequency.  This helps ensure that, 
although the Scanner cannot compute a flow rate based on a frequency that is below its minimum threshold, the 
accumulated volume (mass, energy) will always be correct.  An analogy of this process is the speedometer on a 
car.  The speedometer on most cars does not register speeds below 10 or 15 miles per hour.  If the vehicle is 
barely moving, the driver has no way of knowing how fast the car is travelling.  However, the odometer is 
geared directly to the wheel, so the mileage registered will always be correct. 
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Composite Gas Properties 
When the "Mole Fraction Analysis" option is specified, NGas 4.X.X determines various physical gas 
properties by calculation from the user-specified gas composition, and a table of constants stored in ROM.  
The physical constants are obtained primarily from GPA-2145 (SI tables); properties or components not 
covered by the GPA standard are taken from AGA-3 part 3. 
The sum of mole fractions (as entered by the user or input from a gas chromatograph) is forced to equal one 
exactly (normalized).   
Note:  In all equations of this form, the list of gas components begins at N2 and ends at Ar.  The first table in 

the Gas Properties (page 171) section lists the components in standard order, along with the physical 
constants for each component. 

For each component i, the normalized mole fraction x is: 

MFsum
x

x i
i

entered
=  

Pseudocritical temperature: 

∑
=

=
Ar

Ni
iiTcxTc

2

 

Pseudocritical pressure: 

∑
=

=
Ar

Ni
iiPcxPc

2

 

Viscosity: 

∑
=

=
Ar

Ni
iixMu

2

μ  

Mass basis heating value: 

∑

∑

=

== Ar

Ni
ii

Ar

Ni
iii

Mrx

HmMrx
Hm

2

2  

Molar mass (molecular weight): 

∑
=

=
Ar

Ni
iiMrxMr

2

 

Real gas relative density (gas gravity): 

air

refMrMd
Gr

ρ
=  

When gravity is input instead of mole fractions: 

ref

air

Md
Gr

Mr
ρ

=  
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Density of air: 
274 1062.61091.512527.0 bbair TTB −− ×−×+−=  

air
Gref

Gref

air
air

B
P

RT
Mr

+⎟
⎟
⎠

⎞
⎜
⎜
⎝

⎛
=ρ  

where: 
Mrair = 28.96256 

bT   = contract base temperature 

Density of the gas at reference conditions TDref, Pdref 

rrefref MMd=ρ  

When the volumetric basis heating value is required (as input to the AGA-8 Gross GHC method, for 
example), it is calculated from Hm by: 

refHmHV ρ=  

ref

HVHm
ρ

=  

The mass density at reference conditions:  

rrefref MMd=ρ  

where Mdref is the molar density at reference conditions TGref and PGref, calculated via the selected Z-factor 
method.  

Mass density at contract base conditions:  
   ρ b = Mdb Mr  

where Mdb is the molar density at contract base conditions Tbase and Pbase calculated through the 
selected Z-factor method. 

Mass density at flowing conditions:  

rff MMd=ρ  

where Mdf is the molar density at flowing conditions Tf and Pf, calculated via the selected Z-factor 
method. 
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Compressibility 

AGA-8 Detailed Method 
The following variables are computed when the gas composition is updated: 

( )( )2
51

1 1

5
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1

2
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5 12 EEUxxxU ji
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n
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= +==
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where: 
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where: 
( )

2
jiij

ij

GGG
G

+
=

∗

 

For the numerical values of an, bn, cn, kn, un, gn, qn, fn, sn, wn see AGA-8 table 4. 
For the numerical values of  E, K, G, Q, F, S, W see AGA-8 Table 5. 
For the numerical values of Eij, Uij, Kij, G*

ij see AGA-8 Table 6. 
Virial coefficient B is computed whenever the pressure or temperature is updated:  

( ) BE nijji
n

n

i

n

j

u
ijji

u
n KKxxTaB nn ∗

= = =

−∑ ∑∑= 2
318

1 1 1
 

where 

( )2
1

jiijij EEEE ∗=  
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The molar density, Md, is a nonlinear function of pressure.  Thus, numerical methods are used to solve the 
following equation for Md: 

( ) ( )
⎭
⎬
⎫

⎩
⎨
⎧

−−+−+= ∑ ∑
= =

−∗−∗
18

13

58

13
exp1

n n

k
n

bk
nnn

u
n

u
ndd

nnnnn DcDDkcbTTDBMRTMP CC  

Once the molar density is known, the compressibility factor Z is determined from: 

( ) ( )nnnnn k
n

bk
nnn

u

n n
n

u
nd DcDDkcbTTDBMZ CC −−+−+= −

= =

∗−∗∑ ∑ exp1
18

13

58

13
 

Calculation time for the AGA-8 "Detailed" method is governed by the number of non-zero components in the 
gas.  The following formula provides a reasonable estimate of the calculation time:  

)!2(
!

−
××=

m
mukt  

where 
t  = time to recalculate, seconds 
k  = system timing constant (CPU, clock speed, math coprocessor, etc.) 

 k ≈ ## for Scanner 1110/1120  
 k ≈## for Scanner 1110/1120  with math coprocessor 
 k ≈ ## for Scanner 1130 
 k ≈ ## for Scanner 1131  
 k ≈## for Scanner 1131 with math coprocessor 
 k ≈## for Scanner 1140 

m = number of gas components  
u = update constant 

 u ≈ ## for gas composition update 
 u ≈ ## for pressure or temperature updates 
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AGA-8 Gross Methods  
The AGA-8 Gross GCN and GHC methods, and the SGERG GHN methods are based on the following 
equations: 

∑ ∑
− =

=
CH

COi

CH

COj
jiijmix xxBB

2 2

 

∑ ∑ ∑
= = =

=
CH

COi

CH

COj

CH

COk
kjiijkmix xxxCC

2 2 2

 

where: 
Component ID = CO2, N2, CH. 
N2 is the mole fraction of nitrogen. 
CO2 is the mole fraction of carbon dioxide. 
CH is the mole fraction of the (fictitious) "equivalent hydrocarbon". 

2
210 TbTbbBij ++=  

2
210 TcTccCijk ++=  

For the numeric values of b0, b1, and b2, see AGA-8 Table 7: 

HBBHBB CHCHCHCH
2

20 ++=−  
2

210 CHCHCHCHCH HCHCCC ++=−−  

2,1,0,2
210 =++= iTbTbbB iiii  

2,1,0,2
210 =++= iTcTccC iiii  

For the numeric values of  bi0, bi1, bi2, ci0, ci1, and ci2, see AGA-8 Table 8. 
The interaction second virial coefficient terms for N2, CO2 and CH are calculated: 

( )( )( )
2

32010875.172.0 22

2

25 CHCHNN
CHN

BB
TB −−−

−

+
−×+=  

CHCHCOCOCHCO BBB −−− −
222

865.0  

The interaction third virial coefficient terms for N2, CO2 and CH are calculated: 

( )( )3 22
2222

2700013.092.0 CCTC NNNCHCHCHCHCHN −−−−−− −+=  

( )( )3 22
22222

2700013.092.0 CCTC NNNCHCHCHCHNN −−−−−− −+=  

3 22
2222

92.0 CCC COCOCOCHCHCHCHCHCO −−−−−− =  

3 22
22222

92.0 CCC COCOCOCHCHCHCHCOCO −−−−−− =  

3
22222222

10.1 COCOCONNNCHCHCHCHCON CCCC −−−−−−−− =  

Numerical methods are used to solve the following equation for the molar density d: 
( )21 dCdBdRTP mixmix ++=  

And finally, 
21 dCdBZ mixmix ++=  
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Range of Validity of the AGA-8 Methods 
The AGA-8 Detailed method provides the best accuracy when its inputs fall within the Normal Range given 
below.  The method is useable for the limits indicated under the "expanded range" with reduced accuracy (see 
AGA Report No. 8 for details). 
The AGA-8 Gross methods (GCN, GHC) and the SGERG GHN methods should be used only on dry, sweet 
gases having characteristics that fall within the Normal Range given below: 

 
Quantity Normal range Expanded range 
Relative density 0.554 to 0.87 0.07 to 1.52 
Gross heating value 477 to 1150 BTU/cf 0 to 1800 BTU/cf 
Gross heating value 18.7 to 45.1 MJ/m3 0 to 66.6 MJ/m3 
Mole % Methane 45.0 to 100.0 0 to 100.0 
Mole % Nitrogen 0 to 50.5 0 to 100.0 
Mole % Carbon Dioxide 0 to 30.0 0 to 100.0 
Mole % Ethane 0 to 10.0 0 to 100.0 
Mole % Propane 0 to 4.0 0 to 12.0 
Mole % Butanes 0 to 1.0 0 to 6.0 
Mole % Pentanes 0 to 0.3 0 to 4.0 
Mole % Hexanes Plus 0 to 0.2 0 to dew point 
Mole % Helium 0 to 0.2 0 to 3.0 
Mole % Hydrogen 0 to 10.0 0 to 100.0 
Mole % Carbon monoxide 0 to 3.0 0 to 3.0 
Mole % Argon 0 0 to 1.0 
Mole % Oxygen 0 0 to 21.0 
Mole % Water 0 to 0.05 0 to dew point 
Mole % Hydrogen Sulphide 0 to 0.02 0 to 100.0 

 
From AGA Report No. 8 (92), Table 1 
The Detailed Method is valid within the pressure/temperature range indicated by Regions 1 to 4 in the figure 
below (accuracies as indicated). 
The AGA-8 Gross methods (GCN, GHC) and the SGERG GHN methods are valid only within the 
temperature and pressure limits of Region 1.  AGA Report No. clearly warns that the equation was not 
designed for use outside of these limits. 
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From AGA Report No. 8 (92), Figure 1 

Standing-Katz 
Using information from an original paper by Messrs, Standing and Katz describe a graphical method for 
obtaining the Z factors of hydrocarbon mixtures over a broad range of temperature and pressure conditions.  
The Standing-Katz curves have been adapted for computer calculation by various investigators.  One of the 
best is the method developed by Dranchuk, Purvis and Robinson.  The method is based on the Benedict-
Webb-Rubin equation of state, fitted to the Standing-Katz curves.  
NGas/IGas solve "Z" as a function of reduced temperature and pressure, using Newton-Rapheson iteration, as 
follows: 

Tr
Z

ρ
Pr27.0

=  

Molar density is from: 

ZRT
PM d =  

Iteration for pseudoreduced density ρ : 
( )
( )ρ
ρρρ

'1 f
f

ii −=+  

( ) ( ) ( ) GFFEDCBAf −−+++++= 223236 exp1 ρρρρρρρρ  

( ) ( )[ ] ( )222225 exp233236' ρρρρρρρρ FFFEDCBAf −−+++++=  

where: 
A = 0.06423 
B = 0.5353 Tr - 0.6123 

2
5783.00467.13151.0
Tr

TrC −−=  

D = Tr 

2
6845.0
Tr

E =  
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F = 0.6845 
G = 0.27 Pr 

Pc
P

=Pr  

Tc
TTr =  

where: 
P = absolute pressure, pounds per square inch. 
Pc = pseudocritical pressure of the gas mixture, pounds per square inch absolute. 
T = absolute temperature, °Rankine 
Tc = pseudocritical temperature of the gas mixture, °Rankine 

The Wichert-Aziz correction to the Standing-Katz calculation is automatically applied whenever the 
percentage of H2S + CO2 is greater than 0% and less than 80%. 

( ) ( ){ } { }4
22

6.1
22

9.0
22 15120 SxHSxHSxHxCOSxHxCOCwa −++−+=  

CwaTcTc −='  
( )

( )CwaSxHSxHTc
CwaTcPcPc

22 1
'

−+
−

=  

where: 
xCO2 = %CO2/100 
xH2S = %H2S/100 
Cwa = Wichert-Aziz correction factor 
Tc  = critical temperature, °R 
Pc  = critical pressure, PSIA 
Tc'  = corrected critical temperature, °R 
Pc'  = corrected critical pressure, PSIA 

If %CO2 and %H2S are both equal to zero, then: 
Cwa = 0 
Tc'  = Tc 
Pc'  = Pc 

Range of validity:  0 = (%CO2 + %H2S) < 80 
The Standing-Katz method has a broad range of validity for hydrocarbon gas mixtures.  The limits are: 

1.05 = Tr < 3.0  
0 < Pr < 30 
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Under some conditions, the range of validity of the calculation could be exceeded.  If there is any doubt, the 
user should confirm that the Standing Katz method will produce valid results for the anticipated operating 
conditions.  This confirmation can be performed as follows: 
• Determine Pc and Tc from an analysis of the gas (the easiest way to do this is to key the data into the 

Scanner and let it perform the calculation).  Use an analysis that shows the highest percentage of heavy 
components.  

• From T and Tc, calculate Tr for the min, and max. anticipated operating temperature. 
• From P and Pc, calculate Pr for the min. and max. operating pressure. 
• Verify that Tr and Pr are within the ranges noted above.  If they are not, the Standing Katz method should 

not be used. 

Redlich-Kwong & Wichert-Aziz 
The "standard" Redlich-Kwong algorithm was intended for use on hydrocarbon gases.  It is relatively simple 
and quite accurate in comparison to other much more complex methods.  It is readily modified for improved 
accuracy.  One such modification is the Wichert-Aziz correction, which extends the utility of the Redlich-
Kwong method to cover sour hydrocarbon gases.   
The equation of state is solved for the compressibility factor by Newton-Rapheson iteration: 

h
h

B
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h
Z

+
×−

−
=

11
1 2

 

where: 

5.22
2

TR
aA =  

RT
bB =  

Z
BPh =  

The Redlich-Kwong mixing rule is: 

∑ ∑
= =
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iim byb
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jiij aaa =  

where: 

Pc
RTca

25.24278.0
=  

Pc
RTcb 0867.0

=  

where: 
 R = universal gas constant = 0.08207 K*atm 
 Tc = critical temperature of the i'th component (°R) 

Pc = critical pressure of the i'th component (psia) 
The Wichert-Aziz correction adjusts the pseudocritical temperature and pressure: 

( ) ( )( ) ( )2
22

2
2222 5.727 SxHSxHSxHxCOSxHxCO −++−+=ε  
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ε−=∗
cici TT  

ci
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cici T
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∗

∗ =  

When 0 < P < 2500 psia, temperature is adjusted as follows: 

⎟
⎠
⎞

⎜
⎝
⎛ −+=∗ 2000001.0

400
5.3 PPTT  

Molar density is computed from: 

ZRT
PM d =  

where:  
P = pressure, pounds per square inch absolute 
Pc = pseudocritical pressure of the gas mixture, pounds per square inch absolute 
T = temperature, °Rankine 
Tc = pseudocritical temperature of the gas mixture, °Rankine 

Redlich Kwong (Modified) 
The modified Redlich-Kwong algorithm works well for most pure gases (e.g. pure nitrogen, carbon dioxide, 
hydrogen, etc.) over normal ranges of temperature and pressure.  Inclusion of Redlich-Kwong extends the 
utility of NGas/IGas 4.X.X to non-hydrocarbon gases.   
The equation of state is solved for the compressibility factor by Newton-Rapheson iteration.  
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where: 

Tr
A Pr0867.0

=  

3

934.4
Tr

B =  

Pc
P

=Pr  

Tc
TTr =  

Molar density is computed from: 

ZRT
PM d =  

where: 
P = pressure, pounds per square inch absolute 
Pc = pseudocritical pressure of the gas mixture, pounds per square inch absolute 



 Chapter 10: NGas 4.X.X Configuration & Calculations 

February 2006 191 

T = temperature, °Rankine 
Tc = pseudocritical temperature of the gas mixture, °Rankine 

Matrix 
The matrix provides a "window" into the compressibility graph of the particular gas: 

 

 Pressure

 C
om

pr
es

si
bi

lit
y

 Matrix

 (Z-factor isotherms)

 
 

The Scanner interpolates the compressibility from the user-entered matrix using the live temperature and 
pressure.  
The pressure and temperature points need not be evenly distributed.  The interpolation formula will work 
correctly both inside and outside the bounds of the matrix; it can interpolate and extrapolate the 
compressibility factor.  NGas and IGas 4.X.X can handle an “n x n” matrix, where n is user-selectable: 1, 3 or 
5.  When n=1, the resulting 1x1 "matrix" means simply that a single user-entered constant is used for Z at all 
times, regardless of temperature and pressure.  This is a useful option in situations where the user purposely 
does not want to calculate the compressibility in real time, or wishes to use the computer on non-critical low-
pressure flowruns, where accuracy is not important enough to justify complex methods (or even temperature 
and pressure transmitters). 
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Note:  This is merely a brief description; a full calibration procedure would depend on the specific equipment used, 
and would require close attention to many details not covered here.

Meter Factor 
Meter factors have been a standard part of liquid metering for many years but their application to natural gas 
orifice metering is rather new.  It is described in AGA-3, section 1.9 ("In-Situ Calibration").  The NGas/IGas 
4.X.X orifice calculation includes a meter factor, "MF," to accommodate this requirement.  NGas/IGas 4.X.X 
accepts up to nine meter factors, which are tabulated against the Reynolds Number; the final meter factor is 
found by linear interpolation. 
The meter factor is optional.  If the user does not wish to activate it, simply leave everything in the meter 
factor table at the original values; this forces the interpolation to output a meter factor of 1. 
The interpolation formula is: 
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Graphically:  

 

Ren Ren+1
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Rex

MFx

   
The general method for determining meter factors through "In-Situ Calibration" is summarized below (see 
also AGA-3 part 1, section 1.9).  

 
 
 

 
The main requirement is a master meter (such as a turbine meter, or a sonic flow nozzle) that has been 
characterized at a flow laboratory.  Place the master meter in series with the orifice meter, so that the normal 
flow profile through the orifice meter is not disturbed.  Record the flow rates indicated by both meters by 
varying the flow to obtain several different Reynolds Numbers.  The flow must remain steady during each 
calibration run.  Several runs should be taken at each Reynolds Number and the results averaged.  
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Chapter 11: IGas 4.X.X Configuration & 
Calculations 

 

• Flowrun Configuration Setup Options (p194) 
• Flowrun Parameters (p197) 
• IGas 4.X.X Flowrun Variables (p198) 
• IGas Flowrun Calculations (p203) 

About Flowrun Configuration 
IGas is a firmware package for Scanner 1130, 1140, and 1131 flow computers.  It conforms to ISO and related 
flow measurement standards that were current as of 1999, for measurement of natural gas and other industrial 
gases by means of a variety of flow elements.  IGas provides mass flow, volume and energy measurement.  It 
includes a curve of Reynolds Number vs. Meter Factor, which accommodates calibrated primary flow elements, 
and a similar curve of gross volumetric flowrate vs. K factor, which may be used with turbine meters or 
equivalent devices calibrated at multiple flowrates.  The firmware is configured using a personal computer (PC) 
with ScanWin software. 
IGas supports a variety of primary elements including orifice meters, ISO nozzles, Long Radius nozzles, classical 
Venturi meters, turbine and other linear pulse-output volumetric devices, and coriolis meters.  Secondary devices 
include pressure, temperature, and differential pressure analog transmitters, RTDs, analog or frequency-type 
densitometers, and gas chromatographs. 
The flowrun configuration is set in the Scanner when the field device is first set up.  Configurations normally do 
not change, but can be altered in ScanWin LITE. The configuration specifies what is being calculated and the 
method by which the calculation will be performed.  The parameters are the second level of information used to 
set up a Scanner and include flowrun parameters and physical specifications of the meter.  Many of these 
parameters can be edited in ScanWin.  You can specify up to 12 configuration categories.  Options within each 
category are specified when the field device is configured and you cannot change these options in ScanWin LITE.  
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Flowrun Configuration Setup Options 
 
Variable Tag Description Units / Allowed Values 
Run_name 
Run_Type 
Method 
Pri_Device 

Refer to the NGas Flowrun Configuration Rules (page 156) for details about setting these options. 

Dev_Type Device type If you are setting up a Differential Producer run, the choices are: 
Orifice (ISO-98), ISA 1932 nozzle, Venturi, Long radius nozzle, Venturi nozzle 
and Orifice (ISO-91) 
If you are setting up a turbine or mass pulse run, the choices are: 
Standard, Level B and Ultrasonic 

Tap_Type Orifice pressure 
tap type 

Flange taps, Corner taps and D and D/2 taps are the options. 

Tap_loc 
DP_mode 
Dens_srce 

Refer to the NGas Flowrun Configuration Rules (page 156) for details about setting these options. 

Gas_Data Gas data type Mole Fractions requires that the composition of the gas be fully specified, by 
entering the mole fractions of each of 21 component gases.  Input can be from either 
manual entry or live from an installed gas chromatograph. 
Manual selects the Z matrix method. 
Extended Mole Fractions extends the normal slate of hydrocarbon gases to include 
additional gas components.  Choosing mole fractions limits you to either the Redlich-
Kwong or Standing-Katz Z-factor methods. 

GCN (Gravity, %CO2, %N2), HCN (Heating Value, %CO2, %N2), GHC 
(Gravity, heating value, %CO2) and GHN (Gravity, Heating Value,  %N2) 
are associated with a simplified gas quality input used by the “SGERG” 
method.  They specify various combinations of gravity (i.e. Real Gas 
Relative Density), gross volumetric heating value and percentages of inerts, 
which must be added to the calculation.   

For Pc,Tc, Pc is the critical pressure (kPa [a] or other absolute units).  Pc and Tc are 
thermodynamic constants for a given gas.  This option selects a modified Redlich-
Kwong calculation, which is suitable for most pure non-hydrocarbon gases, e.g. pure 
carbon dioxide, pure ammonia, steam or other industrial gases.  The Pc and Tc for the 
gas(es) in question must be calculated and entered into the Scanner. 

Z_method Z method in use Options depend on what is chosen in Gas Data (above): 
When Gas Data is Manual, Matrix is available. 
When Gas Data is Mole Fractions, Standing-Katz, Redlich-Kwong 1, SGERG-88 
GCN, SGERG-88 GHC, SGERG GHN and AGA-8 92 DC are options. 
When Gas Data is Extended Mole Fractions, Standing-Katz and Redlich-Kwong (S) 
are the options. 
When the Gas Data is GCN, the only option is SGERG-88 GCN. 
When the Gas Data is GHC, the only option is SGERG-88 GHC. 
When the Gas Data is GHN, the only option is SGERG-88 GHN. 
When Gas Data is Pc, Tc, Redlich-Kwong (M) is the only option. 
Redlich-Kwong is the simplest and fastest equation of state provided in IGas.  The 
version used includes Wichert-Aziz correction, making it suitable for sour natural 
gas.  Redlich-Kwong is most accurate at relatively low pressures (to about 3.5 MPa or 
500 psi).  It is not recommended for use on custody transfer applications. 
Standing-Katz is another efficient algorithm based on the Standing-Katz graphical 
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Variable Tag Description Units / Allowed Values 
method.  It includes Wichert-Aziz correction, making it suitable for sour natural gas.  
It is accurate for pressures up to about 17 MPa or 2500 psi. 
The options, collectively referred to as the SGERG-88 method (SGERG-88 GCN, 
SGERG-88 GHC, and SGERG GHN) require only three parameters to characterize 
the gas.  Knowledge of the gravity, heating value, mole percent carbon dioxide and 
mole percent nitrogen (in various combinations) is all that’s needed, rather than the 
complete list of 21 components. 
The SGERG-88 method can also be selected after choosing “mole fractions” input, in 
which case the gravity, heating value, %CO2 and %N2 are automatically computed 
from the gas analysis.  This allows the SGERG-88 method to be used with live input 
from gas chromatographs. 
The SGERG-88 method is recommended for general natural gas measurement.  It is 
efficient, well-suited to low-power applications, and nearly as accurate as the AGA8-
92 DC method.  The major restriction is the pressure/temperature range and the limits 
on the gas composition.  The range limits are well suited to pipeline-quality natural 
gas, but they may not be suitable for production gas. 
Note that the temperature, pressure and composition limits must be observed 
otherwise serious measurement errors may result.  ISO 1221302 contains a prominent 
warning that the SGERG-88 methods should not be used outside the specified limits. 
AGA8 (92) DC is the most accurate method for finding the compression factor of 
natural gas.  It is also by far the most complex.  The calculation is inherently slow 
compared to most other methods.  Since it requires the processor to be active for 
several consecutive seconds whenever Z is to be updated, the detailed method is a 
poor choice for low-power applications (e.g., in situations where the Scanner runs off 
batteries and solar panels). 
You should reserve this calculation for custody transfer meters where accuracy is of 
paramount importance and an adequate power supply is available. 
The Detailed Method also requires that a large number of intermediate variables be 
retained in memory.  The amount of RAM installed in the Scanner is generally what 
determines the number of flowruns that can use this calculation. 
The Matrix is the method of last resort.  It extends the utility of IGas to cover gases 
whose behavior cannot be predicted by any of the empirical methods described 
above.  To use this method, you must fill the matrix with Z factors, which have been 
determined in advance at various temperatures and pressures.  IGas determines the Z-
factor by linear interpolation from the matrix. 
The major disadvantage of this method is that any given matrix is valid only for a 
single gas composition; a new matrix must be determined any time the gas 
composition changes significantly. 
The “Single Z” option is useful in situations where you need to input Z directly 
(perhaps in order to verify other calculations). 

Z_size 
Gr_mode 
Hv_mode 
GC_mode 
GC_logging 
Peak_logging 
HrlyHist_size 
DailyHist_size 
Hist_intvl 
Direction 
Q_Calc 
Z_Calc 

Refer to the NGas Flowrun Configuration Rules (page 156) for details about setting these options. 

Avg_Freq Refer to the NGas Flowrun Configuration Rules (page 156) for details about setting these options. 
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Variable Tag Description Units / Allowed Values 
Avg_Delay 
Avg_Style 
Est_PC 
Est_Enable 
Est_Basis 
Flow_check 
Ref_Cond Reference 

Conditions 
The options are (see values below) 

• USA  
• France, Japan 
• Canada, UK, Australia 
• Europe 

Stn_A 
Stn_B 

Refer to the NGas Flowrun Configuration Rules (page 156) for details about setting these options. 

 
Reference Condition values are: 
 HvCF RdCF Thref 

(°C) 
Tdref/Tgref 
(°C) 

Pdref/Pgref 
kPa 

USA 1.0539 1.0002 15.5 15.5 101.559 
France, Japan 0.9974 1.0 0 0 101.325 
Canada, UK, Australia 1.0543 1.0002 15 15 101.325 
Europe 1.0 1.0 25 0 101.325 

 
NOTE: 
When the Configuration Lock Switch is ON,  
1. The following parameters may be modified: 

• Heating value 
• Density 
• Gas composition 
• Flowrun status (stopped, running) 
• Gas component reference string 
• Time and date 
• Accessories 

2. The following components are LOCKED and cannot be modified: 
• System 
• Flowrun setup, including: 

• Pulse output from a total 
• Flowrun configuration values and status values 
• Flowrun parameters 

• Hardware for flowrun input and calibration 
• Station totals 
• Superboot switch 
• The ability to assign flowrun items to outputs and alarms and set alarm levels 
• Communications 
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Flowrun Parameters 
Refer to the NGas Flowrun Parameters (page 161) section for details about the following items: 
(a) Normalized Analysis,  (b) Base Temperature and Pressure,  (c) Pipe and Throat Diameters, Temperature 
Coefficients and Measurement Reference Temperatures, (d) Isentropic Exponent, (e) Viscosity and (f) Meter 
Factors. 

Discharge Coefficient 
For classical venturi meters, the discharge coefficient is user-entered.  Values recommended by ISO-5167 are: 

machined inlet       0.995 
rough-cast inlet     0.984 
welded steel         0.985 

Calculated Values 

For more information about the following parameters, refer to the NGas Calculated Values (page 163): 
(a) Flow Extension (differential producers), (b) Discharge Coefficient (differential producers), (c) 
Reynolds Number (differential producers) and (d) Expansion Factor (differential producers, gas flow). 

Compression Factor (Gas Flowruns) 
The compression factor of a gas is the amount by which its behavior deviates from the Ideal Gas Law.  It is a 
dimensionless number, symbolized "Z", which is the result of a complex calculation based on temperature, 
pressure, and quality of the gas (note that differential pressure does not enter it).  IGas computes three Z 
factors: Zf, the compression factor at flowing conditions; Zb, the compression factor at base conditions and 
Zn, the compression factor at normal conditions.  Typical values: 

Zb, Zn    0.998      (always close to 1.0; usually 0.99…) 
Zf     0.8 to 1.05   (under typical conditions) 
Zf     0.5 to 1.5    (under extreme conditions) 

Molar Density (Gas Flowruns) 
Molar density is closely related to compression factor.  It is the density of the gas expressed in kilogram-
moles per cubic meter, or equivalent units.  As with compression factor, three molar densities are computed:  
Mdf (flowing conditions, Mdb (base conditions) and Mdn (normal conditions).  Typical values are: 

Mdn, Mdb   0.04     (typical natural gas) 
Mdf    2.3      (typical natural gas at 700 psi) 
Mdf   19.3      (typical natural gas at extreme pressure) 

Mass Density (All Flowruns) 
Mass density is normally symbolized with the Greek letter “θ”.  It is the density of the fluid in kilograms per 
cubic meter (or equivalent units).  Typical values are: 

RHOb, RHOn     0.7    (typical natural gas) 
RHOf     40.6    (typical natural gas at 700 psi) 
RHOf      340    (natural gas at extreme pressure) 
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IGas 4.X.X Flowrun Variables  
Variable Tag  Description Storage Units Attributes 
AlphaD Pipe Thermal Expansion Coefficient mm/mm°C Param 
Alphad Throat Thermal Expansion Coefficient mm/mm°C Param 
Beta Diameter Ratio - Calc 
Btot Total Volume (Base Conditions) M3 Total 
C Discharge Coefficient - Param/Calc 
D Pipe Inside Diameter m Calc 
d Throat Diameter m Calc 
dp Current Differential Pressure Pa Calc/Avg 
DPh-l Stacked DP high to low switchpoint Pa Param 
DPh-m Stacked DP high to mid switchpoint Pa Param 
DPhi High Stacked Differential Pressure Pa Live 
DPl-h Stacked DP low to high switchpoint Pa Param 
DPl-m Stacked DP low to mid switchpoint Pa Param 
DPlow Low Stacked Differential Pressure Pa Live 
DPlv Single Live Differential Pressure Pa Live 
DPlast Last read Differential Pressure Pa Calc 
DPm-h Stacked DP mid to high switchpoint Pa Param 
DPm-l Stacked DP mid to low switchpoint Pa Param 
DPmid Mid Stacked Differential Pressure Pa Live 
DPpri Primary Live Differential Pressure Pa Live 
DPsec Secondary Live Differential Pressure Pa Live 
DPkPr Peak Pressure (daily) Pag Calc 
DPkQb Peak Volume Flow Rate (daily) M3/sec Calc 
Dr Uncorrected Pipe Inside Diameter  m Param 
dr Uncorrected Throat Diameter m Param 
Etot Total Energy Joules Total 
Ev Velocity of Approach factor - Calc 
Fextn Flow Extension (=sqrt(DP * RHOf)) - Calc/Avg 
Freq Input frequency Hz Calc/Avg 
rd Relative Density at ref. Conditions kg/M3 Par/Live/Calc 
rdn Relative Density at normal conditions kg/M3 Calc 
Hmh Mass calorific value at ref. Conditions J/kg Par/Calc 
Hs Gross calorific value at normal conditions J/M3 Calc 
HN25 Molar calorific value at 25 C J / mol Calc 
HNh Molar calorific value at ref. Conditions J / mol Calc 
HV Gross calorific value at ref. Conditions Joules/M3 Par/Live/Calc 
HvCF Heating value reference correction - Param 
HPkPr Peak Pressure (hourly) Pag Calc 
HPkQb Peak Volume Flow Rate (hourly) M3/sec Calc 
k Isentropic Exponent - Param 
Mdb Molar density, base conditions - Calc 
Mdf Molar density, flowing conditions - Calc 
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Variable Tag  Description Storage Units Attributes 
Mdg Molar density, gravity ref. conditions - Calc 
Mdh Molar density, HV ref. conditions - Calc 
Mdn Molar density, normal conditions - Calc 
MF1 Meter factor at Re1 - Param 
MF2 Meter factor at Re2 - Param 
MF3 Meter factor at Re3 - Param 
MF4 Meter factor at Re4 - Param 
MF5 Meter factor at Re5 - Param 
MF6 Meter factor at Re6 - Param 
MF7 Meter factor at Re7 - Param 
MF8 Meter factor at Re8 - Param 
MF9 Meter factor at Re9 - Param 
MFact Meter factor (interpolated) - Calc 
MFsum Mole Fraction Sum - Calc/Live12 
Mr Molar mass - Calc 
Mtot Total Mass kg Total 
MtotB This Months Total Volume M3 Total 
MTotE This Months Total Energy Joules Total 
MTotM This Months Total Mass kg Total 
MtotN This Months Total Normal Volume M3 Total 
Mu Absolute Viscosity kg/Msec Param/Calc 
Ntot Total Volume (Normal Conditions) M3 Total 
P1 Matrix pressure point 1 Paa Param 
P2 Matrix pressure point 2 Paa Param 
P3 Matrix pressure point 3 Paa Param 
P4 Matrix pressure point 4 Paa Param 
P5 Matrix pressure point 5 Paa Param 
pa Local Atmospheric Pressure Paa Param 
pb Contract Base Pressure Paa Param 
Pc Pseudocritical Pressure Paa Param/Calc 
PDref Pressure Density Reference Paa Param 
PGref Pressure Gravity Reference Paa Param 
p Absolute Pressure Paa Calc/Avg 
PfZf Absolute Pressure for Zf Paa Calc 
pg Gauge Pressure Pag Live 
pglast Last read Pressure Pag Calc 
PtotB Previous Months Total Volume M3 Total 
PTotE Previous Months Total Energy Joules Total 
PTotM Previous Months Total Mass kg Total 
PtotN Previous Months Normal Total Volume M3 Total 
Qb Volume Flow Rate M3/sec Calc 
Qe Energy Flow Rate Joules/sec Calc 
Qf Uncorrected Pulse Rate M3/sec Live 
Qfavg Average Uncorrected Pulse Rate M3/sec Calc 

                                                      
12 Live assignment supported only for GC peripheral devices, which assigns all gas components to GC. 
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Variable Tag  Description Storage Units Attributes 
Qftot Uncorrected Pulse Total M3 Total 
Qf1 Ultrasonic Meter Factor Qf 1 M3/sec Param 
Qf2 Ultrasonic Meter Factor Qf 2 M3/sec Param 
Qf3 Ultrasonic Meter Factor Qf 3 M3/sec Param 
Qf4 Ultrasonic Meter Factor Qf 4 M3/sec Param 
Qf5 Ultrasonic Meter Factor Qf 5 M3/sec Param 
Qf6 Ultrasonic Meter Factor Qf 6 M3/sec Param 
Qf7 Ultrasonic Meter Factor Qf 7 M3/sec Param 
Qf8 Ultrasonic Meter Factor Qf 8 M3/sec Param 
Qf9 Ultrasonic Meter Factor Qf 9 M3/sec Param 
Qm Mass Flow Rate kg/sec Calc/Live 
Qn Normal Volume Flow Rate M3/sec Calc 
rdCF Heating value reference correction - Param 
Re1 Reynolds Number 1 - Param 
Re2 Reynolds Number 2 - Param 
Re3 Reynolds Number 3 - Param 
Re4 Reynolds Number 4 - Param 
Re5 Reynolds Number 5 - Param 
Re6 Reynolds Number 6 - Param 
Re7 Reynolds Number 7 - Param 
Re8 Reynolds Number 8 - Param 
Re9 Reynolds Number 9 - Param 
ReD Reynolds Number (D) - Calc 
RHOb Fluid Density at Base Conditions kg/M3 Calc 
RHOf Fluid Density kg/M3 Calc/Live 
RHOn Fluid Density at Normal Conditions kg/M3 Calc 
T1 Matrix temperature point 1 K Param 
T2 Matrix temperature point 2 K Param 
T3 Matrix temperature point 3 K Param 
T4 Matrix temperature point 4 K Param 
T5 Matrix temperature point 5 K Param 
tb Contract Base Temperature  K Param 
Tc Pseudocritical Temperature K Param/Calc 
TDmea Pipe Measurement Temperature K Param 
Tdmea Throat Measurement Temperature K Param 
Temp Live Temperature K Live 
t Flowing Temperature K Calc/Avg 
tlast Last read Temperature K Calc 
TDref Temperature Density Reference K Param 
TGref Temperature Gravity Reference K Param 
THref Temperature Heating Value Reference K Param 
TtotB Today’s Total Volume M3 Total 
TTotE Today’s Total Energy Joules Total 
TTotM Today’s Total Mass kg Total 
TtotN Today’s Total Normal Volume M3 Total 



 Chapter 11: IGas 4.X.X Configuration & Calculations 

February 2006 201 

Variable Tag  Description Storage Units Attributes 
Tzf Temperature for Zf  K Calc 
UMF1 Ultrasonic Meter Factor 1 - Param 
UMF2 Ultrasonic Meter Factor 2 - Param 
UMF3 Ultrasonic Meter Factor 3 - Param 
UMF4 Ultrasonic Meter Factor 4 - Param 
UMF5 Ultrasonic Meter Factor 5 - Param 
UMF6 Ultrasonic Meter Factor 6 - Param 
UMF7 Ultrasonic Meter Factor 7 - Param 
UMF8 Ultrasonic Meter Factor 8 - Param 
UMF9 Ultrasonic Meter Factor 9 - Param 
UMFact Ultrasonic Meter Factor (interpolated) - Calc 
XAr Mole Fraction Argon - Param 
xC1 Mole Fraction Methane - Param 
xC2H4 Mole Fraction Ethene - Param 
xC2 Mole Fraction Ethane - Param 
xC3 Mole Fraction Propane - Param 
xC3H6 Mole Fraction Propene - Param 
xC4H8 Mole Fraction Butene - Param 
xC5H10 Mole Fraction Pentene-1 - Param 
XCO Mole Fraction Carbon Monoxide - Param 
xCO2 Mole Fraction Carbon Dioxide - Param 
xH2 Mole Fraction Hydrogen - Param 
xH2O Mole Fraction Water - Param 
xH2S Mole Fraction Hydrogen Sulfide - Param 
XHe Mole Fraction Helium - Param 
xiC4 Mole Fraction Iso-Butane - Param 
xiC5 Mole Fraction Iso-Pentane - Param 
xN2 Mole Fraction Nitrogen - Param 
xnC10 Mole Fraction Normal Decane - Param 
xnC4 Mole Fraction Normal Butane - Param 
xnC5 Mole Fraction Normal Pentane - Param 
xnC6 Mole Fraction Normal Hexane - Param 
xnC7 Mole Fraction Normal Heptane - Param 
xnC8 Mole Fraction Normal Octane - Param 
xnC9 Mole Fraction Normal Nonane - Param 
xO2 Mole Fraction Oxygen - Param 
Eps Expansibility Factor - Param/Calc 
YtotB Yesterdays Total Volume M3 Total 
YtotE Yesterdays Total Energy Joules Total 
YtotM Yesterdays Total Mass kg Total 
YtotN Yesterdays Total Normal Volume M3 Total 
Z11 Z factor @ Pressure1 / Temperature 1 - Param 
Z12 Z factor @ Pressure1 / Temperature 2 - Param 
Z13 Z factor @ Pressure1 / Temperature 3 - Param 
Z14 Z factor @ Pressure1 / Temperature 4 - Param 
Z15 Z factor @ Pressure1 / Temperature 5 - Param 
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Variable Tag  Description Storage Units Attributes 
Z21 Z factor @ Pressure2 / Temperature 1 - Param 
Z22 Z factor @ Pressure2 / Temperature 2 - Param 
Z23 Z factor @ Pressure2 / Temperature 3 - Param 
Z24 Z factor @ Pressure2 / Temperature 4 - Param 
Z25 Z factor @ Pressure2 / Temperature 5 - Param 
Z31 Z factor @ Pressure3 / Temperature 1 - Param 
Z32 Z factor @ Pressure3 / Temperature 2 - Param 
Z33 Z factor @ Pressure3 / Temperature 3 - Param 
Z34 Z factor @ Pressure3 / Temperature 4 - Param 
Z35 Z factor @ Pressure3 / Temperature 5 - Param 
Z41 Z factor @ Pressure4 / Temperature 1 - Param 
Z42 Z factor @ Pressure4 / Temperature 2 - Param 
Z43 Z factor @ Pressure4 / Temperature 3 - Param 
Z44 Z factor @ Pressure4 / Temperature 4 - Param 
Z45 Z factor @ Pressure4 / Temperature 5 - Param 
Z51 Z factor @ Pressure5 / Temperature 1 - Param 
Z52 Z factor @ Pressure5 / Temperature 2 - Param 
Z53 Z factor @ Pressure5 / Temperature 3 - Param 
Z54 Z factor @ Pressure5 / Temperature 4 - Param 
Z55 Z factor @ Pressure5 / Temperature 5 - Param 
Zb Compressibility at Base Conditions - Param/Calc 
Zf Compressibility at Flowing Conditions - Param/Calc 
Zn Compressibility at Normal Conditions - Param/Calc 
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IGas Calculations 

Units of Measurement 
All calculations in IGas 4 are performed in pure MKS units.  Refer to the NGas Units of Measurement (page 
170) for information about this topic. 

Gas Properties 
Refer to the NGas Gas Properties (page 171) for information about the properties of hydrocarbon gases, 
other components of natural gas and assorted industrial gases. 

Reference Standards 
ISO 5167-1 (1992-12-15) 
"Measurement of fluid flow by means of pressure differential devices" 
Part 1: Orifice plates, nozzles, and Venturi tubes inserted in circular cross-section conduits running full" 
International Organization for Standardization, 1992 
Including amendment 1 (1998-04-01) for the R-G orifice equation. 
 
W. Wagner & A. Kruse; "Properties of Water and Steam - The Industrial Standard IAPWS-IF97 for the 
Thermodynamic Properties and Supplementary Equations for Other Properties"; Springer-Verlag 1998; ISBN 
3-540-64339-7 
 
"Natural Gas - Calculation of compression factor" 
ISO 12213-1 : Introduction and guidelines 
ISO 12213-2 : Calculation using molar composition analysis 
ISO 12213-3 : Calculation using physical properties 
International Organization for Standardization, 1997 
 
M. Jaeschke & A.E. Humphreys: "Standard GERG Virial Equation for Field Use" 
GERG Technical monograph TM5, 1991 
Groupe Europeen de Recherches Gaziers (GERG) 
Verlag des Vereins Deutcher Ingenieure, DŸsseldorf, 1991; ISBN 3-18-146606-9 
 
R. W. Miller; "Flow Measurement Engineering Handbook" (3rd edition); McGraw Hill 1996; ISBN 0-07-
042366-0 
 
A.G.A. "Manual for the Determination of Supercompressibility Factors for Natural Gas"; PAR Research 
Project NX-19; American Gas Association 1962 
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Reference Conditions 
Refer to the NGas Reference Conditions (page 173) for details. 

Composite Gas Properties 
When the "Mole Fraction Analysis" option is specified, IGas 4.X.X determines various physical gas 
properties by calculation from the user-specified gas composition, and a table of constants stored in ROM.  
The physical constants are obtained primarily from GPA-2145 (SI tables); properties or components not 
covered by the GPA standard are taken from AGA-3 part 3. 
The sum of the mole fractions (as entered by the user or input from a gas chromatograph), must equal one 
exactly (normalized).  
 
Note: In all equations of this form, the list of gas components begins at N2 and ends at Ar.  The first table in 

the NGas Gas Properties (page 171) section lists the components in standard order, along with the 
physical constants for each component. 

 
For each component i, the normalized mole fraction x is: 
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Real gas relative density (gas gravity): 

air

refMrMd
Gr

ρ
=

 
When gravity is input instead of mole fractions: 

ref

air
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ρ

=  

Density of air: 
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Where: 
Mrair = 28.96256 
Tb  = contract base temperature 

Density of the gas at reference conditions TDref, Pdref 

rrefref MMd=ρ  

The mass density at reference conditions:  

rrefref MMd=ρ  

Where refMd  is the molar density at reference conditions TGref and PGref, calculated via the selected Z-
factor method.  

Mass density at contract base conditions:  

rbb MMd=ρ  

Where Mdb is the molar density at contract base conditions Tbase and Pbase calculated through the 
selected Z-factor method. 

Mass density at flowing conditions:  

rff MMd=ρ  

Where Mdf is the molar density at flowing conditions Tf and Pf, calculated via the selected Z-factor 
method. 
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Orifice Metering 
Discharge coefficient for flange taps: 
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In the case where D>71.12 mm (2.8 in), the following term should be added to the above equation: 
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where 
Dd /=β  is the diameter ratio; 

dRe  is the Reynolds number related to D; 
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DIL /11 =  is the quotient of the distance of the upstream tapping from the upstream face of the plate 
and the pipe diameter. 
 DIL /'' 22 =  is the quotient of the distance of the downstream tapping from the downstream face of 
the plate, and the pipe diameter.  (L’2 denotes the reference of the downstream spacing from the downstream 
face, while L2 would denote the reference of the downstream spacing from the upstream face). 
The values of L1 and L’2 to be used in this equation, when the spacings are in accordance with the 
requirements of 8.2.1.2, 8.2.1.3 or 8.2.2, are as follows: 
for corner tappings: 

0'21 == LL  
for D and D/2 tappings: 

11 =L  

47.0'2 =L  
for flange tappings: 

D
LL 4.25'21 ==  

where D is expressed in millimeters. 
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Venturi Nozzle: 
5.4196.09858.0 β−=C  

Orifice bore, meter bore, beta ratio: 
( )[ ]rf TTDrD −+= 21 α  

( )[ ]rf TTdrd −+= 11 α  

D
d

=β  

where 
dr = orifice bore at reference temperature Tr 
Dr = meter tube diameter at reference temperature Tr 
α1 = coefficient of linear expansion of meter tube material 
α2 = coefficient of linear expansion of orifice plate material 

Expansion Factor (orifice): 
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k
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where  

P
dPPTau −

=  

Static pressure, when measured at the upstream tap: 

atmgagef PPP +=  
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Static pressure, when measured at the downstream tap: 
PPPP atmgagef Δ++=  

Where Pgage, Patm, and ΔP are in the same units  
Reynolds Number: 

D
qm

πμ
*4Re =  

Velocity of Approach factor: 

41
1

β−
=vE  

Mass Flow 
The final orifice flow calculation used in IGas 4.X.X departs slightly from the standard formulation.  The 
flow extension Fext is introduced as a separate variable whose value is recorded in the flowrun's history log.  
The Meter Factor MF is later discussed.  The incremental mass is obtained by integrating the instantaneous 
mass flow rate over the time interval of the calculation. 

MFFextdEpsECNq vm
2

1=  

∫= dtqm m  
Where: 

PFext f Δ= ρ
 

ρf = RHOf = mass density at flowing conditions, kg/m3 
ΔP = differential pressure 
m = incremental mass 
dt = time elapsed since the preceding calculation 

Linear Volume Meter 
Refer to the NGas Linear Volume Meter (page 180) section for details. 

Volume Flow 
Refer to the NGas Volume Flow (page 174) section for details. 

Energy Flow 
Refer to the NGas Volume Flow (page 175) section for details 
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Compressibility 

AGA8-92 DC Equation 
The following variables are computed when the gas composition is updated: 
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For the numerical values of an, bn, cn, kn, un, gn, qn, fn, sn, and wn, see AGA-8 Table 4. 
For the numerical values of E, K, G, Q, F, S, and W, see AGA-8 Table 5. 
For the numerical values of Eij, Uij, Kij, and G*ij, see AGA-8 Table 6. 

Virial coefficient B is computed whenever the pressure or temperature is updated:  
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The molar density Md is a nonlinear function of pressure.  Therefore, numerical methods are used to solve the 
following equation for Md: 
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Once the molar density is known, the compressibility factor Z is determined from 
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13  
Calculation time for the AGA8-92 DC method is governed by the number of non-zero components in the gas.  
The following formula provides a reasonable estimate of the calculation time:  

)!2(
!

−
××=

m
mukt  

where 
t = time to recalculate, seconds 
k = system timing constant (CPU, clock speed, math coprocessor, etc.) 

k ≈ ## for Scanner 1110/1120  
k ≈## for Scanner 1110/1120 with math coprocessor 
k ≈ ## for Scanner 1130 
k ≈ ## for Scanner 1131  
k ≈## for Scanner 1131 with math coprocessor 
k ≈## for Scanner 1140 

m = number of gas components  
u = update constant 

u ≈ ## for gas composition update 
u ≈ ## for pressure or temperature updates 

SGERG-88 Equation  
The AGA-8 Gross GCN and GHC methods, and the SGERG GHN methods are based on the following 
equations: 

∑ ∑
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Where: 
Component ID = CO2, N2, CH. 
N2 is the mole fraction of nitrogen. 
CO2 is the mole fraction of carbon dioxide. 
CH is the mole fraction of the (fictitious) "equivalent hydrocarbon". 

2
210 TbTbbBij ++=  

2
210 TcTccCijk ++=  

For the numeric values of b0, b1, and b2, see AGA-8 Table 7: 

HBBHBB CHCHCHCH
2

20 ++=−  
2

210 CHCHCHCHCH HCHCCC ++=−−  

2,1,0,2
210 =++= iTbTbbB iiii  

2,1,0,2
210 =++= iTcTccC iiii  

For the numeric values of bi0, bi1, bi2, ci0, ci1, and ci2, see AGA-8 Table 8. 
The interaction second virial coefficient terms for N2, CO2 and CH are calculated: 

( )( )( )
2

32010875.172.0 22

2

25 CHCHNN
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BB
TB −−−

−

+
−×+=  

CHCHCOCOCHCO BBB −−− −
222

865.0  

The interaction third virial coefficient terms for N2, CO2 and CH are calculated: 

( )( )3 22
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( )( )3 22
22222
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3 22
2222

92.0 CCC COCOCOCHCHCHCHCHCO −−−−−− =  

3 22
22222

92.0 CCC COCOCOCHCHCHCHCOCO −−−−−− =  

3
22222222

10.1 COCOCONNNCHCHCHCHCON CCCC −−−−−−−− =  

Numerical methods are used to solve the following equation for the molar density d: 
( )21 dCdBdRTP mixmix ++=  

And finally,  
21 dCdBZ mixmix ++=  
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Range of Validity of the SGERG-88 Methods 
The SGERG-88 method provides the best accuracy when its inputs fall within the Normal Range given 
below.  The method is useable for the limits indicated under "expanded range", with reduced accuracy (see 
ISO 12213-2 for details). 
The SGERG-88 methods should be used only on dry, sweet gases having characteristics that fall within the 
Normal Range given below: 
 
Quantity Normal range Expanded range 
Relative density 0.554 to 0.87 0.07 to 1.52 
Gross heating value 477 to 1150 BTU/cf 0 to 1800 BTU/cf 
Gross heating value 18.7 to 45.1 MJ/m3 0 to 66.6 MJ/m3 
Mole % Methane 45.0 to 100.0 0 to 100.0 
Mole % Nitrogen 0 to 50.5 0 to 100.0 
Mole % Carbon Dioxide 0 to 30.0 0 to 100.0 
Mole % Ethane 0 to 10.0 0 to 100.0 
Mole % Propane 0 to 4.0 0 to 12.0 
Mole % Butanes 0 to 1.0 0 to 6.0 
Mole % Pentanes 0 to 0.3 0 to 4.0 
Mole % Hexanes Plus 0 to 0.2 0 to dew point 
Mole % Helium 0 to 0.2 0 to 3.0 
Mole % Hydrogen 0 to 10.0 0 to 100.0 
Mole % Carbon monoxide 0 to 3.0 0 to 3.0 
Mole % Argon 0 0 to 1.0 
Mole % Oxygen 0 0 to 21.0 
Mole % Water 0 to 0.05 0 to dew point 
Mole % Hydrogen Sulphide 0 to 0.02 0 to 100.0 

 
From ISO 12213-2, Table 1 
The Detailed Method is valid within the pressure/temperature range indicated by Regions 1 to 4 in the figure 
below (accuracies as indicated). 
The SGERG-88 methods (GCN, GHC) and the SGERG GHN methods are valid only within the temperature 
and pressure limits of Region 1.  ISO 12213-2 clearly warns that the equation was not designed for use 
outside of these limits. 
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From AGA Report No. 8 (92), Figure 1 

 

Standing-Katz 
Refer to the NGas Standing-Katz (page 187) section for details. 

Redlich-Kwong & Wichert-Aziz 
Refer to the NGas Redlich-Kwong & Wichert-Aziz (page 189) section for details. 

Redlich Kwong (Modified) 
Refer to the NGas Redlich Kwong (Modified) (page 190) section for details. 

Matrix 
Refer to the NGas Matrix (page 191) section for details. 

Meter Factor 
Refer to the NGas Meter Factor (page 192) section for details. 
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Chapter 12: NFlo 4.X.X Configuration & 
Calculations 

 

• Liquid Flowrun Configuration Rules (p216) 
• Flowrun Parameters (p219) 
• NFlo 4.X.X Flowrun Variables (p223) 
• Flowrun Calculations (p229) 
• References (p238) 

About Flowrun Configuration 
The flowrun configuration is set in the Scanner when the field device is first set up.  Configurations are not 
normally changed but can be altered in ScanWin LITE.  The configuration specifies what is being calculated with 
which method.  The parameters are the second level of information used to set up a Scanner and include flowrun 
parameters and physical specifications of the meter.  Most of these parameters can be edited in ScanWin LITE.  
NFlo is a combined gas and liquid measurement program for the Barton Scanner 1100 series flow computers.  It 
is based on the gas flow measurement standards current as of 1994, primarily the "new" AGA-3 and AGA-8.  
Liquid properties calculations are based on the API Manual of Petroleum Measurement Standards (MPMS) 
chapters 11.2.1, 11.2.2, 11.2.3 and API 2540.  NFlo supports a variety of primary elements including orifice 
meters, turbines and other linear pulse-output volumetric devices, coriolis meters, averaging pitot tubes, and 
inverted venturis.  Secondary devices include pressure, temperature, and differential pressure analog transmitters, 
RTDs, analog or frequency-type densitometers, and gas chromatographs.  
All calculations are performed in SI units, with automatic conversion of other units performed by the Unit 
Manager as required.  NFlo bases all calculations on mass flow; volume and energy flow are always calculated 
from mass flow. Even turbine metering is handled this way. This consistent treatment simplifies the calculations, 
and allows flowruns to be handled the same way regardless of what primary device is used.  
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Liquid Flowrun Configuration Rules 
 
 
 
 
Variable Tag Description Options / Allowed Values 
Run_name Flowrun name A user-assigned name for the flowrun.  This may contain as many as 10 characters. 
Run_Type Flowrun type Gas – Refer to Chapter 10: NGAS 4.X.X Configuration & Calculations for 

details. 
Monitor – Refer to Chapter 13: MONITOR Flowrun Configuration for details.  
Liquid - is used for any hydrocarbon liquid, from crude oil to liquefied natural gas.  
NFlo also includes algorithms that handle almost any other industrial liquid. 

Method Volume, Mass, 
Energy 
Calculations 

Volume Only, Mass Only, and Volume & Mass establishes what combination of 
volume, mass and energy will be totaled by a liquid flowrun. 

Pri_Device Orifice or 
turbine 

Differential Producer is a term for meters whose measurement is based on a 
pressure drop that they induce in the pipe.  The most common is the orifice meter.  
Others include pitot tubes and proprietary devices such as inverted venturi (V-cone 
and Wedge meter). 
Linear Volume Meter includes all true mass flowmeters that produce a pulsed 
output signal, in which each unscaled electrical pulse represents a discrete volume 
of fluid.  This includes turbine meters, vortex-shedding meters, and positive 
displacement (PD) meters. 
Linear Mass Meter includes all true mass flowmeters that produce a pulsed output 
signal, in which each unscaled electrical pulse represents a discrete mass of fluid.  
Meters of this class are generally based on measurement of coriolis forces.  These 
are usually liquid meters, but may include gas coriolis meters. 

Dev_Type Device type If you are setting up an orifice run, the choices are: 
Orifice meter, Pitot tube (Annubar®), Inverted Venturi (V-Cone®), Wedge 
Meter and Entered Cd. 
If you are setting up a turbine run, the choices are: 
Standard, Level B (future)  

Tap_Type Orifice pressure 
tap type 

Flange taps 

Tap_loc Orifice tap 
location 

Upstream or Downstream specifies the position of the static pressure tap with 
respect to the orifice.  If the P and ΔP inputs will come from a Barton DPE™ unit, 
select upstream taps. 

DP_mode Orifice DP 
stack/check 
mode 

The options include Single, Dual Stacked, Triple Stacked or Dual Checking.  DP 
stacking extends the rangeability of differential produce runs by placing two or 
three differential pressure transmitters in parallel.  The transmitters typically have 
full-scale ranges in 10:1 ratios.  When configured this way, the flowrun 
automatically selects whichever transmitter is in range, and uses that signal for the 
flow calculation; out-of-range transmitters are ignored.  The firmware program can 
accommodate DP inputs stacked up to three deep, which provides (in theory), about 
a 30:1 or 40:1 flow rate rangeability from a single meter run.  Dual checking mode 
is intended for critical applications.  Two DP transmitters are required; the primary 
and secondary must agree, otherwise an alarm is output. 

HrlyHist_size Hourly History 
log size 

This user-entered value determines the total length of the history logs, i.e. how 
many days’ data will be retained in NVRAM.  A log length of 1 to 15 days is 

Refer to Chapter 10: NGas 4.X.X Configuration & Calculations for creating Gas flowruns; for installing Monitor 
flowruns, refer to Chapter 13: Monitor Flowrun Configuration.  The following table is specific to a Liquid flowrun. 
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Variable Tag Description Options / Allowed Values 
DailyHist_size Daily History 

log size 
appropriate for networked Scanners, which will be downloaded frequently. A 35-
day log is normal for Scanners that will be manually downloaded on a weekly 
schedule, and 60 days may be the prudent choice for units in remote locations.  The 
default unit is days.  A value of 0 disables this feature.  
Note that there must be enough free NVRAM to accommodate the log. 

Peak_logging Qb/Press peak 
logging 

The options are Off, Press, Qb, and Press & Qb.  If selected, the maximum or 
peak values will be recorded in history log for the logging interval. 

Dens_srce Density source The normal choice is Calculated. 
Other choices include Pulse Densitometer, All User Entered or Analog 
Densitometer (includes any device that can provide a density input in the form of a 
4-20 mA signal proportional to the actual density at flowing conditions). 

Base_Temp Base 
Temperature 

15°C or 60°F – Current API standards allow for only two base temperatures 
(unlike gas measurement where a great variety of base conditions is used). 

Liquid_prop Liquid 
Properties 

The options are Relative Density or Abs. Density & Temp.  A liquid flowrun 
needs to know the relative density of the fluid at base conditions.  This can either 
be entered directly, or the computer can calculate it from the absolute density 
(normally expressed in kg/m3) and the temperature at which that density was 
measured.  The latter option is useful if the density must be measured on-site using 
a glass hydrometer; NFlo includes a correction for the thermal expansion of glass 
hydrometers. 

Liquid_type Liquid Type The options are Normal Hydrocarbon, LPG/LNG and Other Liquid. 
Choose Normal Hydrocarbon or LPG/LNG, based on the table at the end of this 
section.13 
Select Other Liquid for anything that does not fall into the normal hydrocarbon or 
LPG category.  Only temperature correction can be applied to “Other Liquid”.  To 
perform the correction, NFlo needs to be given the density of the liquid at three or 
more temperatures (up to 10).  This information can usually be obtained from 
standard engineering references. 

Flow_Dirn Flowing 
Direction 

Options are Forward, Unspecified, Reverse and Status Input. 
These options are associated with bi-directional meter runs.  When equipped with 
the appropriate input expansion board, the Scanner can use phase discrimination to 
automatically determine the flow direction through a bi-directional turbine meter.  
Alternatively, a status input may be connected to a valve position switch to inform 
the Scanner of flow direction.  When the status input is asserted, a “Forward” 
flowrun will totalize while a “Reverse” flowrun (connected to the same status 
input) will be inhibited. 

                                                      
13 Appropriate choices for different petroleum products 
 
Product    Flowrun Configuration    Liquid Parameter 
     Choice     Choice 
Crude Oil    Normal Hydrocarbons   Crude/JP4 
Lubricating Oil    Normal Hydrocarbons   Lube Oils 
Jet fuel, Kerosene & Solvents  Normal Hydrocarbons   Jet Fuel/Kerosene 
Diesel, Heating & Fuel Oils  Normal Hydrocarbons   FUEL Oils/Diesel 
Gasolines and Napthenes  Normal Hydrocarbons   Gasoline/Naptha 
Condensate (> 638 kg/M3)  Normal Hydrocarbons   Crude/JP4 
LPG/LNG    LPG/LNG    ---- 
NGL/Condensate(<637 kg/M3)  LPG/LNG    ---- 
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Variable Tag Description Options / Allowed Values 
Hist_intvl Hourly History 

log interval 
This user-entered value determines how frequently data is recorded during the day.  
60 minutes is the default time.  The minimum interval is 5 minutes.  Note that the 
shorter the interval, the greater the NVRAM memory requirement. 

Wedge_FC Wedge Flow 
Coefficient 

* This line appears only if the Device Type is chosen as a Wedge Meter. *         
The coefficient can be Calculated or Entered. 

Avg_Delay Averaging 
delay 

This value is the time delay (in seconds) between averaging starts and does not 
include the actual averaging time.  (Applicable to versions 4.1 and above.) 

PT_correct Pressure & 
Temperature 
correction 

* This line appears only if the Density Source is a Pulse Densitometer. * 
Options are Barton equation, Solartron equation and None. 
Densitometer inputs are normally corrected for the small shift that is due to the 
effects of temperature and pressure upon the mechanism of the densitometer.  
Select either the Barton or Solartron equation as appropriate.  These correction 
equations require several coefficients, which can be found on the densitometer's 
calibration sheet.  The third option "None" allows you to bypass the P/T correction 
and use only the three basic densitometer coefficients (normally called A0, A1, and 
A2).  

Interp_pts Number of 
interpolation 
points (Other 
Liquids) 

* This line appears only if the Liquid Type is “Other Liquid”. * 
NFlo creates a table of densities and temperatures in the flowrun.  The size of the 
table is determined by the number of points chosen (3 to 10) 

Avg_Style Averaging style The options are Flowtime, Fulltime and 0 Flowtime.  Flowtime only averages 
inputs when there is flow.  If there is no flow for the history logging interval 
(typically 1 hour), Fulltime averages will be logged.  Fulltime is always averaged.  
0 Flowtime inserts zero values in the history log when there is no flow during the 
entire logging period. 

Est_PC Estimate during 
plate changes 

This option enables (green check mark) or disables (red X) the estimation process 
during routine plate change operations.  

Est_Enable Estimation 
on/off 

This option enables automatic estimation to take place during any period that the 
flowrun goes offline.  On is indicated with a green check mark and off with a red 
X. 

Est_Basis Estimation 
basis 

This value represents the time (in minutes), before and after a flowrun stoppage, 
that the values are averaged and used for automatic estimation.  The default is 5 
minutes. 

Par_enable Partial Records 
Enabled 

This option allows partial records to be recorded.  On is indicated with a green 
check mark and off with a red X. 

Flow_check Flow check 
limit 

This value (percentage) is used to check the flowrate difference before and after a 
flowrun estimation.  It is used to warn of a significant difference in flow rate in 
case an incorrect plate size is entered during a plate change routine. 

DP_check DP check limit * This selection appears only if an orifice run’s DP stack/check mode has been 
selected as Dual Checking. * 
This value is used to set the percentage difference allowed between two DP inputs 
in a DP checking configuration.  If measurement devices are more than the 
percentage entered, a DP check alarms appears on the Alarms page and in the 
Event log.  The Dpcheck limit is used to check all dual DP checking flowruns. 
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 Flowrun Parameters 

Pipe and Throat Diameters, Temperature Coefficients and 
Measurement Reference Temperatures 
Flow measurement by means of differential producers (which includes orifice meters, flow nozzles, venturis, 
averaging pitot tubes, and similar devices), is based on knowledge of the exact diameters of the pipe and the 
meter throat.  Since these measurements change with temperature, it is necessary to adjust for thermal 
expansion in these parts of the meter.  "Dr" is the inside diameter of the meter tube measured at a particular 
temperature "TDref"; similarly, "dr" is the diameter of the throat as measured at the temperature "Tdref".  
Different materials have different expansion characteristics.  NFlo includes the temperature coefficients of 
commonly used meter construction materials.  If the meter is made of some other material, its coefficient(s) of 
thermal expansion can be entered numerically. 
If the meter is an orifice meter, both the diameter and the reference temperature should be stamped on the 
orifice plate.  For other types of differential meters, the information should appear on a data plate, or in 
documents provided by the manufacturer. 
When the selected meter is a V-Cone®, "dr" represents the cone diameter.  If the meter is an averaging Pitot 
tube (Annubar® or similar), "dr" represents the diameter of the strut.  For the Taylor Wedge meter, "dr" 
represents the height of the channel below the wedge.  The variable "Dr" (with a capital D) always represents 
the pipe diameter. 

Discharge Coefficient 
The discharge coefficient of the V-Cone® meter is provided by the manufacturer.  It is typically 0.84. 
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Properties of Hydrocarbon Liquids 
The viscosity of a fluid is defined as its resistance to deformation.  Flow measurement by means of 
differential producers requires knowledge of the fluid's viscosity. 
 
Nominal Viscosity of Hydrocarbon Liquids at 15°C (60°F), centipoise: 14 

Liquid Relative Density Viscosity Vapor Pressure 
Crude oil 0.611 - 1.076 See table below 0 
Gasoline 0.72 0.4  
Jet fuel 0.8 2.0 - 4.0  
Fuel oil    
Lube oil    
LPG/LNG    
     Methane 0.3  28371.0 
     Ethane 0.374 0.056 3343.7 
     Propane 0.508 0.117 729.5 
     Butanes 0.584 0.181 182.4 
     Pentanes 0.631 0.233 72.95 
     Hexane 0.664 0.325 20.26 
     Heptane 0.688 0.325 5.87 
     Octane 0.707 0.586 1.87 
Water 1.0 - 1.25 (brine) 1.0  

 
Approximate Viscosities of Crude Oils: 

Pennsylvania Crude Oils California Crude Oils 
Relative Density Viscosity Relative Density Viscosity 

0.842 15.0 0.917 50.0 
0.834 12.0 0.904 20.0 
0.829 6.2 0.891 8.60 
0.810 3.5 0.874 4.90 
0.797 2.4 0.860 3.00 
0.785 1.7 0.844 1.96 
0.773 1.2 0.818 1.40 
0.760 0.84 0.805 1.01 
0.746 0.68 0.782 0.80 
0.728 0.54 0.761 0.64 

 

                                                      
14 Data Book on Hydrocarbons, J. B. Maxwell, 1977 
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Meter Factors 
Normally, Differential Producers are uncalibrated devices.  Equations for predicting a meter’s discharge 
coefficient were originally derived from a large number of experiments performed on meters of similar type.  
It is usually impractical to calibrate a gas flowmeter that is operating at high pressure.  In those few cases 
where calibration is possible, a means must be provided for adjusting the meter's indicated flowrate to match 
its actual (calibrated) flow rate.  The means provided by NFlo is the meter factor table.   
Meter factors are normally close to 1.0.  A meter factor of 1.05 adjusts the flow upward by five percent.  E.g., 
an indicated flow of 12.345 would be corrected to 12.962; if the meter factor were 0.95, the flow of 12.345 
would be corrected downwards to 11.727.   
Each meter factor is associated with a Reynolds Number that is determined during calibration. 
The Reynolds Numbers must be entered into the table in ascending order, with Re1 having the smallest value 
and Re9 having the largest value: Re1 < Re2 < Re3, etc. 
When all entries in the meter factor table are zero, no correction is applied to the flow.  If you do not wish to 
use the meter factor table, simply leave it blank. 

Calculated Values 

Flow Extension (Differential Producers) 
The flow extension is recorded in the history logs, and can be used to recalculate flows from the log entries.  

Discharge Coefficient (Differential Producers) 
The discharge coefficient is calculated differently for each type of differential producer, usually as a function 
of Reynolds Number and Beta.  
Typical values: 

Orifice meters      0.6 
Flow nozzles      0.95 to 0.99 

Reynolds Number (Differential Producers) 
The Reynolds Number "Re" is defined as the ratio of inertial forces to viscous forces.  It is a dimensionless, 
and usually rather large, number.  Flow measurement by means of differential producers is made possible by 
the principle of Reynolds Number Similarity.  
Typical values 

Re=4000       high viscosity liquid at low flow rate 
Re=100000 to 1000000   typical for a gas 
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Expansion Factor (Differential Producers, Liquid Flow) 
When a liquid passes through the meter throat, its pressure drops and it expands.  This action is reflected in 
the differential pressure measurement.  
The liquid expansion factor "Y" is very close to unity under most conditions.  The Y factor correction 
increases as the differential pressure becomes a larger fraction of the static pressure; i.e., Y is most significant 
in low-pressure metering. 
Since liquids are incompressible, the expansion factor for liquid flowruns always equals 1.0   

Mass Density (All Flowruns) 
Mass density is normally symbolized with the Greek letter “ρ”.  It is the density of the fluid in kilograms per 
cubic meter (or equivalent units).  

RHOb -   Density at base conditions 
RHOf -   Density at flowing conditions (flowing temperature and pressure) 

Typical RHOf values: 
800 – 900 kg/m3    (typical hydrocarbons) 
500 – 600 kg/m3   (LPG/LNG) 
1000 kg/m3     (water) 
1100 kg/m3    (brine) 
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NFlo 4.X.X Flowrun Variables 
Variable Tag  Description Storage Units Attributes 
AlphaD Pipe thermal expansion coefficient mm/mm°C Param 
Alphad Throat thermal expansion coefficient mm/mm°C Param 
Beta Diameter ratio - Calc 
BSW Base Solids and Water % Live 
Btot Total Volume (Base Conditions) M3 Total 
Ca1 Annubar Coefficient 1 - Param 
Ca2 Annubar Coefficient 2 - Param 
Cd Discharge Coefficient - Param/Calc 
Cpl Liquid Press. Correction - Calc 
Ctl Liquid Temp. Correction - Calc 
D Pipe Inside Diameter m Calc 
d Throat Diameter m Calc 
DiffP Current Differential Pressure Pa Calc/Avg 
Dm Live liquid density kg/M3 Live 
DPh-l Stacked DP high to low switchpoint Pa Param 
DPh-m Stacked DP high to mid switchpoint Pa Param 
DPhi High Stacked Differential Pressure Pa Live 
DPl-h Stacked DP low to high switchpoint Pa Param 
DPl-m Stacked DP low to mid switchpoint Pa Param 
DPlow Low Stacked Differential Pressure Pa Live 
DPlv Single Live Differential Pressure Pa Live 
DPlast Last read Differential Pressure Pa Calc 
DPm-h Stacked DP mid to high switchpoint Pa Param 
DPm-l Stacked DP mid to low switchpoint Pa Param 
DPmid Mid Stacked Differential Pressure Pa Live 
DPpri Primary Live Differential Pressure Pa Live 
DPsec Secondary Live Differential Pressure Pa Live 
DPkPr Peak Pressure (daily) Pag Calc 
DPkQb Peak Volume Flow Rate (daily) M3/sec Calc 
Dp Pres above Equil Pa Calc 
Dr Uncorrected Pipe Inside Diameter m Param 
dr Uncorrected Throat Diameter m Param/Calc 
Etot Total Energy Joules Total 
Ev Velocity of Approach factor - Calc 
F Liquid Compressibility - Calc 
Fextn Flow Extension (=sqrt(DP * RHOf)) - Calc/Avg 
Freq Average frequency Hz Calc/Avg 
Gb Relative Density (liquid) - Param 
Gr Real Gas Relative Density kg/M3 Par/Live/Calc 
H/D Wedge meter height/diameter ratio - Param 
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Variable Tag  Description Storage Units Attributes 
HProd Hydrocarbon Type15 - Param 
Hm Heating value, mass basis Joules/kg Live/Calc 
Hv Heating value, volume basis, ref. conditions Joules/M3 Calc 
Hvb Heating value, volume basis Joules/M3 Par/Live/Calc 
Hyd Hydrometer used15 - Param 
HPkPr Peak Pressure (hourly) Pag Calc 
HPkQb Peak Volume Flow Rate (hourly) M3/sec Calc 
k Isentropic Exponent - Param 
K0 API 2540 K0 Coefficient - Calc 
K1 API 2540 K1 Coefficient - Calc 
K18 Density Temp Calib Coeff - Param 
K19 Density Temp Calib Coeff - Param 
K20A Density Pres Calib Coeff - Param 
K20B Density Pres Calib Coeff - Param 
K21A Density Pres Calib Coeff - Param 
K21B Density Pres Calib Coeff - Param 
Ka Annubar Flow Coefficient - Calc 
Kd2 Wedge meter flow coefficient - Param 
Mdb Molar density, base conditions - Calc 
Mdf Molar density, flowing conditions - Calc 
Mdref Molar density, reference conditions - Calc 
MF1 Meter factor 1 - Param 
MF2 Meter factor 2 - Param 
MF3 Meter factor 3 - Param 
MF4 Meter factor 4 - Param 
MF5 Meter factor 5 - Param 
MF6 Meter factor 6 - Param 
MF7 Meter factor 7 - Param 
MF8 Meter factor 8 - Param 
MF9 Meter factor 9 - Param 
MFact Meter factor (interpolated) - Calc 
MFsum Mole Fraction Sum - Calc/Live16 
Mr Molar mass - Calc 
Mtot Total Mass kg Total 
MtotB This Months Total Volume M3 Total 

                                                      
15  
Variable Tag Description Allowed Values 
HProd Hydrocarbon product type 0=Crude Oils/JP4, 

1=Jet Fuel/Kerosene 
2=Gasoline/Naphthenes,  
3=Lube Oils, 
4=Diesel/Fuel Oil 

Hyd Hydrometer used 0=Not used, 1=Used 
 
16 Live assignment supported only for GC peripheral devices, which assigns all gas components to GC. 
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Variable Tag  Description Storage Units Attributes 
MTotE This Months Total Energy Joules Total 
MTotM This Months Total Mass kg Total 
Mu Absolute Viscosity kg/Msec Param/Calc 
P1 Matrix pressure point 1 Paa Param 
P2 Matrix pressure point 2 Paa Param 
P3 Matrix pressure point 3 Paa Param 
P4 Matrix pressure point 4 Paa Param 
P5 Matrix pressure point 5 Paa Param 
Patm Local Atmospheric Pressure Paa Param 
Pbase Contract Base Pressure Paa Param 
Pc Pseudocritical Pressure Paa Param/Calc 
Pe Equil Vapour Pressure Paa Param 
Pdns Live Densitometer Pressure Pag Live 
Pf Absolute Pressure Paa Calc 
Pfzf Absolute Pressure for Zf Paa Calc 
Press Gauge Pressure Pag Live 
PtotB Previous Months Total Volume M3 Total 
PTotE Previous Months Total Energy Joules Total 
PTotM Previous Months Total Mass kg Total 
Qb Volume Flow Rate M3/sec Calc 
Qbnet Total Volume (after BS&W) M3 Total 
Qe Energy Flow Rate Joules/sec Calc 
Qf Uncorrected Pulse Rate M3/sec Live 
Qfavg Average Uncorrected Pulse Rate M3 Calc 
Qftot Uncorrected Pulse Total M3 Total 
Qf1 Ultrasonic Meter factor Qf 1 M3/sec Param 
Qf2 Ultrasonic Meter factor Qf 2 M3/sec Param 
Qf3 Ultrasonic Meter factor Qf 3 M3/sec Param 
Qf4 Ultrasonic Meter factor Qf 4 M3/sec Param 
Qf5 Ultrasonic Meter factor Qf 5 M3/sec Param 
Qf6 Ultrasonic Meter factor Qf 6 M3/sec Param 
Qf7 Ultrasonic Meter factor Qf 7 M3/sec Param 
Qf8 Ultrasonic Meter factor Qf 8 M3/sec Param 
Qf9 Ultrasonic Meter factor Qf 9 M3/sec Param 
Qm Mass Flow Rate kg/sec Calc/Live 
Re1 Meter factor Reynolds Number 1 - Param 
Re2 Meter factor Reynolds Number 2 - Param 
Re3 Meter factor Reynolds Number 3 - Param 
Re4 Meter factor Reynolds Number 4 - Param 
Re5 Meter factor Reynolds Number 5 - Param 
Re6 Meter factor Reynolds Number 6 - Param 
Re7 Meter factor Reynolds Number 7 - Param 
Re8 Meter factor Reynolds Number 8 - Param 
Re9 Meter factor Reynolds Number 9 - Param 
ReD Reynolds Number (D) - Calc 
RHOb Fluid Density at Base Conditions kg/M3 Calc 
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Variable Tag  Description Storage Units Attributes 
RHOf Fluid Density kg/M3 Calc/Live 
RHOrf Fluid Density at Reference Conditions kg/M3 Calc 
RHOr Liquid Density at Reference Conditions kg/M3 Param 
RHOt Temp Corrected Density kg/M3 Calc 
RHO1 Density 1 kg/M3 Param 
RHO2 Density 2 kg/M3 Param 
RHO3 Density 3 kg/M3 Param 
RHO4 Density 4 kg/M3 Param 
RHO5 Density 5 kg/M3 Param 
RHO6 Density 6 kg/M3 Param 
RHO7 Density 7 kg/M3 Param 
RHO8 Density 8 kg/M3 Param 
RHO9 Density 9 kg/M3 Param 
RHO10 Density 10 kg/M3 Param 
SPlast Last read Pressure Pag Calc 
Tl1 Temperature 1 K Param 
Tl2 Temperature 2 K Param 
Tl3 Temperature 3 K Param 
Tl4 Temperature 4 K Param 
Tl5 Temperature 5 K Param 
Tl6 Temperature 6 K Param 
Tl7 Temperature 7 K Param 
Tl8 Temperature 8 K Param 
Tl9 Temperature 9 K Param 
Tl10 Temperature 10 K Param 
Tdns Live Densitometer Temp K Live 
Tr Reference Temp K Param 
T1 Matrix temperature point 1 K Param 
T2 Matrix temperature point 2 K Param 
T3 Matrix temperature point 3 K Param 
T4 Matrix temperature point 4 K Param 
T5 Matrix temperature point 5 K Param 
Tbase Contract Base Temperature K Param 
Tc Pseudocritical Temperature K Param/Calc 
TDmea Pipe Measurement Temperature K Param 
Tdmea Throat Measurement Temperature K Param 
Temp Live Temperature K Live 
Tf Flowing Temperature K Calc/Avg 
Tlast Last read Temperature K Calc 
TtotB Today’s Total Volume M3 Total 
TTotE Today’s Total Energy Joules Total 
TTotM Today’s Total Mass kg Total 
Tzf Temperature for Zf K Calc 
UMF1 Ultrasonic Meter factor 1 - Param 
UMF2 Ultrasonic Meter factor 2 - Param 
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Variable Tag  Description Storage Units Attributes 
UMF3 Ultrasonic Meter factor 3 - Param 
UMF4 Ultrasonic Meter factor 4 - Param 
UMF5 Ultrasonic Meter factor 5 - Param 
UMF6 Ultrasonic Meter factor 6 - Param 
UMF7 Ultrasonic Meter factor 7 - Param 
UMF8 Ultrasonic Meter factor 8 - Param 
UMF9 Ultrasonic Meter factor 9 - Param 
UMFact Ultrasonic Meter factor (interpolated) - Calc 
Vtype V-Cone Install Type17 - Param 
xAr Mole Fraction Argon - Param 
xC1 Mole Fraction Methane - Param 
xC2H4 Mole Fraction Ethene - Param 
xC2 Mole Fraction Ethane - Param 
xC3 Mole Fraction Propane - Param 
xC3H6 Mole Fraction Propene - Param 
xC4H8 Mole Fraction Butene - Param 
xC5H10 Mole Fraction Pentene-1 - Param 
xCO Mole Fraction Carbon Monoxide - Param 
xCO2 Mole Fraction Carbon Dioxide - Param 
xH2 Mole Fraction Hydrogen - Param 
xH2O Mole Fraction Water - Param 
xH2S Mole Fraction Hydrogen Sulfide - Param 
XHe Mole Fraction Helium - Param 
XiC4 Mole Fraction Iso-Butane - Param 
XiC5 Mole Fraction Iso-Pentane - Param 
xN2 Mole Fraction Nitrogen - Param 
XnC10 Mole Fraction Normal Decane - Param 
XnC4 Mole Fraction Normal Butane - Param 
XnC5 Mole Fraction Normal Pentane - Param 
XnC6 Mole Fraction Normal Hexane - Param 
XnC7 Mole Fraction Normal Heptane - Param 
XnC8 Mole Fraction Normal Octane - Param 
XnC9 Mole Fraction Normal Nonane - Param 
xO2 Mole Fraction Oxygen - Param 
Y Expansion Factor - Param/Calc 
YtotB Yesterday’s Total Volume M3 Total 
YTotE Yesterday’s Total Energy Joules Total 
YTotM Yesterday’s Total Mass kg Total 
Z11 Z factor @ Pressure1 / Temperature 1 - Param 

                                                      
17  

Variable Tag Description Allowed Values 
Vtype V-Cone Install Type 0=wafer 

1=tube/spool 

 



ScanWin LITE   

228 February 2006  

Variable Tag  Description Storage Units Attributes 
Z12 Z factor @ Pressure1 / Temperature 2 - Param 
Z13 Z factor @ Pressure1 / Temperature 3 - Param 
Z14 Z factor @ Pressure1 / Temperature 4 - Param 
Z15 Z factor @ Pressure1 / Temperature 5 - Param 
Z21 Z factor @ Pressure2 / Temperature 1 - Param 
Z22 Z factor @ Pressure2 / Temperature 2 - Param 
Z23 Z factor @ Pressure2 / Temperature 3 - Param 
Z24 Z factor @ Pressure2 / Temperature 4 - Param 
Z25 Z factor @ Pressure2 / Temperature 5 - Param 
Z31 Z factor @ Pressure3 / Temperature 1 - Param 
Z32 Z factor @ Pressure3 / Temperature 2 - Param 
Z33 Z factor @ Pressure3 / Temperature 3 - Param 
Z34 Z factor @ Pressure3 / Temperature 4 - Param 
Z35 Z factor @ Pressure3 / Temperature 5 - Param 
Z41 Z factor @ Pressure4 / Temperature 1 - Param 
Z42 Z factor @ Pressure4 / Temperature 2 - Param 
Z43 Z factor @ Pressure4 / Temperature 3 - Param 
Z44 Z factor @ Pressure4 / Temperature 4 - Param 
Z45 Z factor @ Pressure4 / Temperature 5 - Param 
Z51 Z factor @ Pressure5 / Temperature 1 - Param 
Z52 Z factor @ Pressure5 / Temperature 2 - Param 
Z53 Z factor @ Pressure5 / Temperature 3 - Param 
Z54 Z factor @ Pressure5 / Temperature 4 - Param 
Z55 Z factor @ Pressure5 / Temperature 5 - Param 
Zb Compressibility at Base Conditions - Param/Calc 
Zf Compressibility at Flowing Conditions - Param/Calc 
Zref Compressibility at Ref. Conditions - Param/Calc 
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Flowrun Calculations 
The equations used in NFlo are given here for information only.  The flow measurement standards listed in the 
References (page 238) section are the final authority on all calculations.  
Due to the extreme complexity of many of the computations performed by NFlo (particularly the AGA-8 
methods) manual calculation is often impractical.  Software suitable for validating NFlo's output is available 
commercially as well as from the American Petroleum Institute or the American Gas Association.  

Units of Measurement 
All calculations in NFlo 4.X are performed in SI units.  Refer to the NGas Units of Measurement (page 170) 
section for information about this topic. 

Symbols 
The following symbols are used in the calculations: 

Symbol Tag Description Storage Units 
Y Y Expansion factor  – 
Pf  Flowing pressure Pa 
qm Qm Mass flow rate Kg/s 
Qe Qe Energy flow rate at contract base T P MJ/s 
Qv  Volume flow rate at contract base T P M3/s 
qv  Volume flow rate at flowing T P M3/s 
Cpl Cpl Correction for Pressure on liquid – 
Ctl Ctl Correction for Temperature on Liquid – 
∆P DP Pressure above equil. vapor press (Pf - Pe) Pa 
F F Liquid compressibility factor – 
Gb Gb Liquid relative density – 
ρf RHOf mass density at flowing T P Kg/M3 
ρb RHOb mass density at contract base T P Kg/M3 
Cd(FT) Cd discharge coefficient, flange taps - 
ReD Re Pipe Reynolds Number – 
B Beta Beta ratio – 
Dr Dr Meter tube ID @ reference T m 
D D Meter tube ID @ flowing T m 
a2 AlphaD Coefficient of thermal expansion, pipe mm/mm°C 
N1  units constant : π/4 * √2 = 1.110720735  
N2  units constant : 4/π = 1.27324  
N3  units constant : 1.0  
N4  units constant : 0.0254  
dr dr Orifice ID @ reference T m 
d d Orifice ID at flowing T m 
a1 Alphad Coefficient of thermal expansion, orifice mm/mm°C 
Tf Tf Flowing temperature K 
Pf Pf Flowing absolute pressure Paa 
∆P DiffP Differential pressure Pa 
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Standard T P is 288.15 °K, 101.325 kPa 
Standard units are the units in which the calculation is performed.  Conversions to/from user-specified units 
are handled automatically by the Unit Manager. 

Orifice Metering 
Discharge coefficient for flange taps 

[ ] ( ) CACC
Did

47.0

Re
10 0049.00210.0000511.0)FT()FT(

6

ββ +++=  

( ) ( ) TapTermCTCFTC ii +=  

( ) ( ) 1
82 1003.02290.00291.05961.0 MCTCi βββ −+−+=  

DnstrmUpstrmTapTerm +=  

[ ]( )BAUpstrm LL 23.01e1145.0e0712.00433.0 11 0.65.8 −−+−= −−  

[ ] ( )AMMDnstrm 14.010116.0 1.13.1
22 −−−= β  

4

4

1 β
β
−

=B  

⎟⎟
⎠

⎞
⎜⎜
⎝

⎛
−= 0.0,8.2max

4
1 N

DM  

β−
=

1
2 2

2
L

M  

8.0

Re
000,19

⎥
⎦

⎤
⎢
⎣

⎡
=

D

A β
 

35.06

Re
10

⎥
⎦

⎤
⎢
⎣

⎡
=

D

C β
 

Orifice bore, meter bore, beta ratio 
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where 
dr = orifice bore at reference temperature Tr 
Dr = meter tube diameter at reference temperature Tr 
α1 = coefficient of linear expansion of meter tube material 
α2 = coefficient of linear expansion of orifice plate material 
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Expansion Factor  

( )
k
x

Y 1435.041.01 β+−=  

13
1

fPN
Px Δ

=  (N3 = 1 for liquids) 

Static pressure, when measured at the upstream tap 

atmgagef PPP +=  

Static pressure, when measured at the downstream tap 
PPPP atmgagef Δ++=  

where Pgage, Patm, and ∆P are in the same units  
Reynolds Number 

D
qN m

D μ
2Re =   

where N2 = π/4 
Velocity of Approach factor 
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Mass Flow  
The final orifice flow calculation used in NFlo departs from the standard formulation in two ways.  
• The flow extension Fext is introduced as a separate variable whose value is recorded in the flowrun's 

history log.  
• A Meter Factor MF is introduced.  This is discussed in this document starting on page 221.  
The incremental mass is obtained by integrating the instantaneous mass flow rate over the time interval of the 
calculation.  The integration time base is provided by the Scanner's real-time clock. 

FextMFYdECNq vdm
2

1=  

where N1 = π/4 * √2 = 1.110720735 

∫= dtqm m  

Where 

PFext f Δ= ρ  

Where: 
ρf = RHOf = mass density at flowing conditions, kg/m3 
∆P = differential pressure 
m = incremental mass 
dt = time elapsed since the preceding calculation 
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Volume Pulse Meter 
NFlo uses a somewhat unconventional (though perfectly valid) calculation for turbine metering.  Gross 
volume is converted immediately to mass using flowing density. The gross volumetric flow is first computed 
from the frequency and K-factor: 

K
fqv 3600

=  

K
pv =  

Where: 
qv = instantaneous gross volumetric flow rate 
f = frequency (Hertz) 
K = meter K-factor (see also #### K-factor interpolation) 
p = incremental pulse count (since previous channel scan) 
v = incremental volume 

The mass flow is computed: 
fqvqm ρ=  

fvm ρ=  
Where: 

qm = mass flow rate 
qv = gross volumetric flow rate 
m = incremental mass 
ρf = mass density at flowing conditions 

 
 

 
Note:  The gross volume is determined from the pulse count accumulated in a hardware register.  A separate 

hardware register performs period measurement used to determine the signal frequency.  Although the 
Scanner cannot compute a flow rate based on a frequency that is below its minimum threshold, the 
accumulated volume (mass, energy) will always be correct.  An analogy of this process is the speedometer on 
a car.  The speedometer on most cars does not register speeds below 10 or 15 miles per hour.  If the vehicle is 
barely creeping along, the driver has no way of knowing how fast it is moving.  However, the odometer is 
geared directly to the wheel, so the mileage registered will always be correct. 
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Volume Flow 
Volume flow at base conditions 

b
qmQb
ρ

=  

b
mQbtot
ρ

=  

Where: 
qm = mass flow (from diff producer, volume pulse meter, or mass meter) 
Qb = volume flow rate at contract base conditions 
Qbtot = incremental volume at contract base conditions 
ρb = mass density at contract base conditions 

 
Information about which liquid totals include BSW (Base Solids and Water) 
 

1. % BSW is applied to corrected totals in the following manner. 
Qbnet = (1- (BSW/100)) 

 
2. The following volume totals include BSW adjustment: 

Tag Description 
Qbnet Total Volume (after BS&W) 
MtotB This Months Total Volume 
PtotB Previous Months Total Volume 
TtotB Today’s Total Volume 
YtotB Yesterdays Total Volume 

Hourly and Daily history logs Total Volume also include BSW 
Station volume totals that are summed using the above totals also include BSW. 

 
3. The following corrected volumes and rates do not include BSW: 

Tag Description 
Btot Total Volume (Base Condition) 
Qb Volume Flow Rate 
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Meter Factors (NFlo) 
Meter factors have been a standard part of liquid metering for many years but their application to natural gas 
orifice metering is rather new, and is described in AGA-3, section 1.9 ("In-Situ Calibration").  NFlo 
calculations for differential producers include a meter factor term "MF" to accommodate this requirement.  
NFlo accepts up to nine meter factors that are tabulated against Reynolds Number; the final meter factor is 
found by linear interpolation. 
The meter factor is optional.  If you don't wish to activate it, simply leave everything in the meter factor table 
at the original values; this forces the interpolation to output a meter factor of one. 
The interpolation formula is: 
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Graphically:  
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The general method for determining meter factors via in-situ calibration is summarized below (see also AGA-
3 part 1, section 1.9).  Note that this is merely a brief description; a full calibration procedure would depend 
on the specific equipment used, and would require close attention to many details not covered here.  
The main requirement is a master meter (such as a turbine meter, or a sonic flow nozzle) that has been 
characterized at a flow laboratory.  Place the master meter in series with the orifice meter, such that the 
normal flow profile through the orifice meter is not disturbed.  Record the flow rates indicated by both meters 
by varying the flow to obtain several different Reynolds Numbers.  The flow must remain steady during each 
calibration run; several runs should be taken at each Reynolds Number and the results averaged.  
Use the following formulas to determine the various calibration points. 
The Reynolds Number at the test meter: 

D
qmNRe μ

2=  
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The meter factor for this Reynolds Number: 

fqv
qm

qm
qm

MF pp

ρ
==  

where 
qmp= mass flow rate through the master meter 
qm = mass flow rate registered by the orifice meter under test 
qv = volume flowrate indicated  by the orifice meter under test 
ρf = mass density of the fluid at the test meter, under flowing conditions 
µ = fluid viscosity at the flowing conditions of the test meter 
D = meter tube diameter (test meter) 
N2 = units constant  

= 22,735.5 for qm in LBm/sec; µ in centipoise; D in inches 
= 127,324 for qm in kg/sec; µ in centipoise; D in millimeters 

 
Repeat to obtain up to nine Re vs. MF points and tabulate the results.  A typical table might appear like the 
one below: 
 

Point No. Re MF 
1 500,000 0.9903 
2 1,000,000 0.9921 
3 1,500,000 0.9937 
4 2,000,000 0.9984 
5 2,500,000 1.0003 
6 3,000,000 0.9992 
7 3,500,000 0.9977 
8 4,000,000 0.9919 
9 4,500,000 0.9889 

 
Note:  The Reynolds Numbers must be entered into the Scanner's "MF" table in ascending order.  Meter 

factor #1 will be used at all Reynolds Numbers below Re#1; Meter Factor #9 will be used at all 
Reynolds Numbers above Re#9.  
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Liquid Properties 
Ctl for "normal" hydrocarbons - API 2540 table 53A, 53B, 54A, 54B 

Cpltf ρρ =  

Ctlbt ρρ =  

( )( )( )TTCtl Δ××+Δ×−= αα 8.01exp  

bb

KK
ρρ

α 10
2 +=  

Where 
 

Product K0 K1 
Crude oil 613.9723 0 
Gasoline 346.4228 0.4388 
Jet fuel 594.5418 0 
Fuel oil 186.9696 0.4862 
Lube oil 259.2769 0.3411 

 

FP
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1
1

 

em PPP −=Δ  

Ctl for LPGs and LNGs are obtained via table lookup from API 2540 volume XII, Table 34 "Reduction of 
Volume to 60°F against Specific Gravity 60/60°F for Liquefied Petroleum Gases".  The table is too large to 
reproduce here; see the API standard. 
F for "normal" hydrocarbons  (638 < rho < 1074 kg/m3) - MPMS 11.2.1M 
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⎛ ×
++×+= 22exp

bb

TDCTBAF
ρρ

 

Compressibility factor F for light hydrocarbons, LPGs, LNGs (350 < rho < 637 kg/m3)  

( )BPA
F

×Δ+
=

1
 

43
7

23
65

63
4

42
3

22
2

2
1

510 GTCGTCCGTCGTCGTCTCA rrrrrr ++++++=× −  

GCTCGTCGTC rrr 11109
2

8 ++++  
2

1514
2

13
2

12
510 GCGCGTCTCB rr +++=× −  

 
For the values of the constants C1 ... C13 see MPMS 11.2.2M 
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Solartron Densitometer 
2

210 TKTKK ++=ρ  

( )( ) ( )0.200.201 1918 −+−+= dnsdnst TKTKρρ  

( )( ) ( )0.10.11 2120 −+−+= dnsdnsttp PKPKρρ  

( )0.1202020 −+= dnsBA PKKK  

( )0.1212121 −+= dnsBA PKKK  

Uncorrected Densitometer 
2

210 TATAAf ++=ρ  

where A0, A1 and A2 are calibration constants for the densitometer and T is the densitometer period in 
msec. 
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Chapter 13: Monitor Flowrun Configuration 
• Flowrun Variables (p240) 

About Monitor Flowruns 
The Monitor Flowrun is a special type of flowrun that performs no calculations whatever.  Its purpose is to make 
simple inputs of any type “visible” to networks, combiners, data loggers and other accessories.  In other words, it 
gives the user a simple volume pulse accumulator (Volume Flow Rate, Total Volume, Today’s Total Volume, and 
Yesterday’s Total Volume) plus three auxiliary inputs (Input 1, Input 2, and Input 3).  Note that these three “Inpt” 
averaging values are special in that they can be used to log any type of analog-style input (Analog In, DPE, RTD, 
etc.).  When assigning their live input assignment to the Scanner’s analog inputs, the user must set the hardware 
category of the analog input BEFORE assigning the “Inpt” value.  The monitor input will use this pre-defined 
category to set up the category and units of the “Inpt” values.   
All inputs are logged in the history log and can be configured for various lengths and logging intervals.   
Also, note that Monitor flowruns may NOT be used with station parameters. 

Monitor Flowrun Configuration Rules 
Variable Tag Description Options / Allowed Values 
Run_name Flowrun name A user-assigned name for the flowrun.  This may contain as many as 10 characters. 
Run_Type Flowrun type Gas – Refer to Chapter 10: NGAS 4.X.X Configuration & Calculations or 

Chapter 11: IGAS 4.X.X Configuration & Calculations for details. 
Monitor – is a special type of flowrun that performs no calculations.   
Liquid – Refer to Chapter 12: NFLO 4.X.X Configuration & Calculations for 
details. 

Unit_Cfg Unit 
Configuration 
string 

This may contain up to 15 characters. 

Items_to_log History log 
items 

The options are  
• Totals 
• Inputs 
• Totals, Inputs 
• Battery 
• Totals, Battery 
• Inputs, Battery 
• Totals, Inputs, Battery 

HrlyHist_size "Hourly" 
History log size 

Daily_Hist_size "Daily" History 
log size 

This user-entered value determines the total length of the history logs, i.e. how many 
days’ data will be retained in NVRAM.  A log length of 1 to 15 days is appropriate 
for networked Scanners, which will be downloaded frequently.  A 35-day log is 
normal for Scanners that will be manually downloaded on a weekly schedule and 60 
days may be the prudent choice for units in remote locations.  The default unit is 
days.  A value of 0 disables this feature.  
Note that there must be enough free NVRAM to accommodate the log. 

Hist_intvl "Hourly" 
History log 
interval 

This user-entered value determines how frequently data is recorded during the day.  
60 minutes is the default time.  The minimum interval is 5 minutes.  Note that the 
shorter the interval, the greater the NVRAM memory requirement. 
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Variable Tag Description Options / Allowed Values 
Q_Calc Calculation 

delay 
This is the time delay between calculation starts.  It does not include the actual 
calculation time.  The default is 60 seconds.  To get a faster calculation time, set this 
value to a lower number. 

Avg_Delay Averaging 
delay 

This value is the time delay (in seconds) between averaging starts and does not 
include the actual averaging time. 

Avg_Style Averaging style The options are Flowtime, Fulltime and 0 Flowtime.  Flowtime only averages 
inputs when there is flow.  Fulltime is always averaged.  0 Flowtime inserts zero 
values in the history log when there is no flow during the entire logging period. 

Est_Enable Estimation 
on/off 

This option enables automatic estimation to take place during any period that the 
flowrun goes offline.  On is indicated with a green check mark and off with a red 
X. 

Est_Basis Estimation 
basis 

This value represents the time (in minutes), before and after a flowrun stoppage, that 
the values are averaged and used for automatic estimation.  The default is 5 minutes. 

Par_enable Partial Records 
Enabled 

This option allows partial records to be recorded.  On is indicated with a green 
check mark and off with a red X. 

Monitor Flowrun Variables 
Variable Tag  Description Storage Units Attributes 
Inpt1 Input 1 * Live 
Inpt2 Input 2 * Live 
Inpt3 Input 3 * Live 
Qb Volume Flow Rate M3/sec Live 
Qbtot Total Volume M3 Total 
TtotB Today’s Total Volume M3 Total 
YtotB Yesterdays Total Volume M3 Total 

*  Storage units are determined by the category of the hardware input assigned. 
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Index 

—A— 
accessing 

ScanWin, 15 
accessory 

local display, 110 
Add 

New Device window, 128 
AGA-8 Detailed Method calculations, 183, 209 
alarm outputs, assigning, 99 
alarms, 85 
analog calibration, 153 
analog DP input, calibrating, 58, 65 
analog inputs 

assigning, 91 
calibration, 59 

analog output 
assigning, 96 
calibration, 102 
verification, 104 

analog pressure transmitter, calibrating, 59 
assigning 

alarm outputs, 99 
analog inputs, 91 
analog outputs, 96 
fixed inputs, 95 
inputs, 90–95 
local display outputs, 96 
multifunctional resources, 121 
outputs, 90 
outputs to accessories, 99 
pulse inputs, 93 
pulse outputs, 98 
RTD inputs, 94 
status outputs, 100 

audience of user guide, 14 

—B— 
Barton DPE cells, calibrating, 58, 71 
BSW, 233 

—C— 
calculated values, viewing in flowrun tab, 89 
calculation 

NFlo 4.X.X symbols, 229 
techniques, 147 

calculations 
AGA-8 Detailed Method, 183, 209 
AGA-8 Gross Methods, 185 
IGas 4.X.X, 203–14 
IGas 4.X.X mass flow, 208 
IGas 4.X.X orifice metering, 206 
IGas 4.X.X volume pulse meter, 208 
IGas volume and energy flow, 208 
matrix, 191, 213 
meter factor, 192, 213 
NGas 4.X.X, 155 
NGas 4.X.X volume and energy flow, 174 
range of validity of AGA-8 Methods, 186 
range of validity of SGERG-88 Methods, 212 
Redlich-Kwong & Wichert-Aziz, 189, 213 
Redlich-Kwong (Modified), 190, 213 
SGERG-88 Equation, 210 
Standing-Katz, 187, 213 

calibration 
analog, 153 
analog DP input, 58, 65 
analog input, 59 
analog output, 102 
analog pressure transmitter, 59 
Barton DPE cells, 58, 71 
common procedures, 62 
devices, 58–77 
DPE differential pressure, 74 
DPE static pressure cell, 71 
end to end, 66 
linear pulse input, 76 
multi-point report, 78 
notes, 61 
report file extension, 58 
RTD temperature input, 58, 69 
sample report, 78 
up/down, 153 

certification Time/Date, 109 
changing 

gas composition, 54–57 
plates, 45–53 
status output parameters, 101 

clock setting, 112 
colors as used in ScanWin, 36 
communication ports, 135–37 
communications 
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adding a port group, 133 
adding devices, 128 
adding scanners, 142 
defining devices, 127–33 
defining port groups, 133–34 
defining scanners, 142–43 
deleting devices, 132 
editing device attributes, 131 
editing scanner attributes, 143 
modem settings, 130 
removing a port group, 134 
setup, 127 

components supported, 10 
composition, changing gas, 54–57 
compressibility, AGA-8 Detailed Method, 183, 209 
configuration 

changing gas composition, 54 
changing plates, 52 
connection, 31 
files created saving scanner, 82 
flowrun, 30, 45 
NGas 4.X.X, 155 
restoring scanner, 83 
saving scanner, 81 

configuration page, flowrun tab, 89 
connection, configuration, 29, 31 
conventions 

fields, 35 
keyboard, 13 
mouse, 13 
used in user guide, 14 

custom data collection, 43 

—D— 
data collection 

custom, 43 
history logs, 42 

data logger 
file extension, 43 

database installation, 20 
densitometer , NFlo 4.X.X, 237 
Device Setup List window, 128, 131, 132 
devices 

adding, 128 
calibrating, 58–77 
defining for communication, 127–33 
deleting, 132 
editing attributes, 131 

diagnostics, 115, 118 

DPE differential pressure, calibration, 74 
DPE static pressure cell 

calibrating, 71 
shift calibration method, 73 

—E— 
edit 

Device Setup window, 131 
estimation 

automatic, 148 
variables, 150 

exiting ScanWin, 40 

—F— 
families, scanner, 138–41 
field conventions, 35 
fields 

summary of, 35 
file extensions 

calibration report, 58 
data logger, 43 
flowrun configuration, 46 
gas composition, 55 
scanner configuration, 82 

firmware versions, 10 
fixed inputs, assigning, 95 
flowrun 

alarms, 125 
assigning inputs, 90–95 
assigning outputs, 95–102 
data flow diagrams, 152 
IGas 4.X.X parameters, 197 
IGas 4.X.X variables, 198–202 
monitor, 239 
NFlo 4.X.X calculations, 229–37 
NFlo 4.X.X cnfiguration, 215–18 
NFlo 4.X.X parameters, 219–22 
NGas 4.X X parameters, 161–64 
NGas 4.X.X calculations, 170 
NGas 4.X.X variables, 165 
opening, 85 
viewing calculated values, 89 
viewing flowrun configuration, 89 
viewing gas composition, 88 
viewing live inputs, 87 
viewing parameters, 88 
viewing rates and totals, 86 

flowrun changing gas compostion, 54 
flowrun configuration, 30, 45 
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changing plates, 52 
file extension, 46 
parameters, 161–64 
viewing, 89 

flowrun parameters, viewing, 88 
flowrun tab 

Calculated Values page, 89 
Configuration page, 89 
Gas Composition page, 88 
live I/O page, 90 
live inputs page, 87 
Parameters page, 88 
Rates/Totals page, 86 

—G— 
gas composition 

changing, 54–57 
changing heating value (Hvb), 56 
changing specific gravity (Gr), 56 
file extension, 55 
viewing, 88 

Gas Composition page, flowrun tab, 88 

—H— 
high pressure zero adjustment, 154 
history logs, data collection, 42 
history report, theory, 149 

—I— 
IGas 4.X.X 

base temperature and pressure, 197 
calculations, 203–14 
composite gas properties, 204 
compression factor, 197 
discharge coefficient, 197 
energy flow calculations, 208 
expansion factor, 197 
flow extension, 197 
flowrun configuration, 193–96 
flowrun parameters, 197 
flowrun setup options, 196 
flowrun variables, 198–202 
gas properties, 203 
isentropic exponent, 197 
mass flow calculations, 208 
matrix, 213 
meter factor, 213 
meter factors, 197 
molar density, 197 

normalized analysis, 197 
orifice metering calculations, 206 
Redlich-Kwong & Wichert-Aziz calculations, 213 
Redlich-Kwong (Modified) calculations, 213 
reference condition values, 196 
reference conditions, 204 
reference standards, 203 
Reynolds number, 197 
SGERG-88 Equation calculations, 210 
Standing-Katz calculations, 213 
units of measurement, 203 
viscosity, 197 
volume flow calculations, 208 
volume pulse meter calculations, 208 

initialization settings for modems, 130 
inputs 

assigning, 90–95 
installation 

choosing units preference, 21 
hardware requirements, 17 
software, 17 
system requirements, 17 

introduction 
using the keyboard, 13 
using the mouse, 13 

—K— 
K factor interpolation, 147 
keyboard, using, 13 

—L— 
leaving ScanWin, 40 
linear pulse input, calibrating, 76 
liquid properties, NFlo 4.X.X, 236 
live I/O page, flowrun tab, 90 
live inputs page, flowrun tab, 87 
live inputs, viewing, 87 
local display outputs, assigning, 96 
local display, changing settings, 110 
login management, 113 

—M— 
main menu 

accessing Routine Processes, 41 
bar, 34 
Options items, 37 

manager login, 113 
matrix, NGas 4.X.X, 191 
memory 
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status, 118 
usage, 118 

meter factor, NGas 4.X.X, 192 
modems,initialization settings of, 130 
monitor flowrun, configuration, 239 
mouse, using, 13 
multifunctional resource types, 121 

—N— 
NFlo 4.X.X 

BSW, 233 
calculation symbols, 229 
densitometer, 237 
discharge coefficient, 219, 221 
expansion factor, 222 
flow extension, 221 
flowrun calculations, 229–37 
flowrun configuration, 215–18 
liquid properties, 236 
liquid types, 217 
mass density, 222 
mass flow, 231 
meter factors, 221, 234 
orifice metering, 230 
parameters, 219–22 
pipe and throat diameters, 219 
reference temperature, 219 
references, 238 
Reynolds number, 221 
temperature coefficients, 219 
viscosity, 220 
volume flow, 233 
volume pulse meter, 232 

NGas 4.X.X 
AGA-8 Gross Method calculations, 185 
base temperature and pressure, 161 
calculations, 155 
composite gas properties, 181 
compressibility, 164, 183 
configuration, 155 
configuration rules, 156–60 
discharge coefficient, 162, 163 
energy flow calculations, 174 
expansion factor, 164 
flow extension, 163 
flowrun calculations, 170 
flowrun variables, 165 
gas properties, 171 
isentropic exponent, 162 

matrix, 191 
measurement units, 170 
meter factor, 192 
meter factors, 163 
molar density, 164 
normalized analysis, 161 
parameters, 161–64 
pipe and throat diameters, 161 
properties of industrial gases, 171 
Redlich-Kwong & Wichert-Aziz calculations, 189 
Redlich-Kwong (Modified) calculations, 190 
reference conditions, 173 
reference standards, 172 
Reynolds number, 163 
Standing-Katz calculations, 187 
temperature coefficients, 161 
viscosity, 162 
volume flow calculations, 174 

node information, 105 

—O— 
opening a flowrun, 85 
outputs 

assigning, 95–102 
outputs to accessories, assigning, 99 

—P— 
Parameters page, flowrun tab, 88 
password changes by manager, 113 
petroleum products,liquid type choices, 217 
plates, changing, 45–53 
Port Group List window, 133, 134 
Port List window, 135–37 
ports, defining, 135–37 
pulse inputs, assigning, 93 
pulse outputs, assigning, 98 

—R— 
range of validity of AGA-8 Methods, 186 
range of validity of SGERG-88 Methods, 212 
rates, viewing, 86 
Rates/Totals page, flowrun tab, 86 
reference standards 

NFlo 4.X.X, 238 
NGas 4.X.X, 172 

registering 
ScanWin, 31 

report types 
Calibration Report, 78 
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resource types, multifunctional, 121 
routine processes 

accessing, 41 
calibrating devices, 58–77 
changing gas composition, 54–57 
changing plates, 45–53 
data collection of history logs, 42 

Routine tab, 54 
RTD inputs, assigning, 94 
RTD temperature input 

calibration, 58, 69 
shift calibration method, 70 

—S— 
scanner 

adding, 142 
defining, 142–43 
editing attributes, 143 
memory usage, 118 
operating system, 145 
restoring configuration, 83 
saving configuration, 81 
theory, 145 

scanner families, 138–41 
Scanner List window, 142, 143 
ScanWin 

about, 9 
accessing, 15 
colors used in, 36 
components supported, 10 
default units, 27 
exiting, 40 
field conventions, 35 
getting started, 29 
installation, 17 
navigating, 34 
registering, 31 
settings, 38 
starting, 32 
startup procedure, 29 
symbols used, 35 
versions, 9 

setting clock, 112 
setting up 

flowrun, 45 
settings 

local display, 110 
setup 

communications, 127 
status input, 122 

software 
installation, 17 
scanner, 145 
versions, 10 

starting 
after superboot, 33 
ScanWin, 32 

startup procedure, 29 
status input setup, 122 
status output 

assigning, 100 
changing parameter, 101 

status, memory, 118 
superboot, 33 
symbols used in ScanWin, 35 
system 

alarms, 125 
exceptions, 115 
login management, 113 
node information, 105 
viewing settings, 125 
viewing time, 112 

system requirements, 17 

—T— 
tabs 

Flowrun Calculated Values, 89 
Flowrun Configuration page, 89 
Flowrun History Gas Composition, 88 
flowrun live inputs, 87, 90 
Flowrun Parameters, 88 
Flowrun Rates/Totals, 86 

theory, scanner, 145 
totals 

viewing, 86 

—U— 
units 

default, 27 
NGas 4.X.X measurement, 170 
preference, 21 

up/down calibration, 153 
user guide 

about, 14 
audience, 14 
chapter overviews, 15 
conventions used, 14 

using 
the keyboard, 13 
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the mouse, 13 

—V— 
values 

changing heating value (Hvb), 56 
changing specific gravity (Gr), 56 

verification 
analog output, 104 
notes, 61 

version numbering, 9 
versions of firmware, 10 
viewing 

calculated values, 89 
flowrun configuration, 89 
flowrun live inputs, 87 
flowrun parameters, 88 
flowrun rates and totals, 86 
gas composition, 88 
node information, 105 
system settings, 125 

system time, 112 
viscosity 

IGas 4.X.X, 197 
NFlo 4.X.X, 220 
NGas 4.X.X, 162 

—W— 
window 

Add New Device, 128 
Device Setup List, 128, 131, 132 
Edit Device Setup, 131 
Family List, 138–41 
linear pulse inputs, 76 
Port Group List, 133, 134 
Port List, 135–37 
Scanner List, 142, 143 

—Z— 
zero adjustment, high pressure, 154 

 



 

 

WARRANTY - LIMITATION OF LIABILITY:  Seller warrants only title to the products, software, supplies 
and materials and that, except as to software, the same are free from defects in workmanship and 
materials for a period of one (1) year from the date of delivery.  Seller does not warranty that software is 
free from error or that software will run in an uninterrupted fashion.  Seller provides all software "as is".  
THERE ARE NO WARRANTIES, EXPRESS OR IMPLIED, OF MERCHANTABILITY, FITNESS OR 
OTHERWISE WHICH EXTEND BEYOND THOSE STATED IN THE IMMEDIATELY PRECEDING 
SENTENCE.  Seller's liability and Buyer's exclusive remedy in any case of action (whether in contract, 
tort, breach of warranty or otherwise) arising out of the sale or use of any products, software, supplies, or 
materials is expressly limited to the replacement of such products, software, supplies, or materials on 
their return to Seller or, at Seller's option, to the allowance to the customer of credit for the cost of such 
items.  In no event shall Seller be liable for special, incidental, indirect, punitive or consequential 
damages.  Seller does not warrant in any way products, software, supplies and materials not 
manufactured by Seller, and such will be sold only with the warranties that are given by the manufacturer 
thereof.  Seller will pass only through to its purchaser of such items the warranty granted to it by the 
manufacturer. 
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